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Preface

Welcome to the JD Edwards EnterpriseOne Tools Foundation Guide. 

Note: This guide has been updated for JD Edwards EnterpriseOne 
Tools Release 9.1 Update 5. For details on documentation updates, 
refer to the JD Edwards EnterpriseOne Tools Net Change Guide.

Audience
This guide is intended to teach users about all functionality of the EnterpriseOne 
interface.

This guide assumes you have a working knowledge of the following:

• The principles and customary practices of your business area.

• Computer desktop application usage and terminology.

Documentation Accessibility
For information about Oracle's commitment to accessibility, visit the Oracle 
Accessibility Program website at 
http://www.oracle.com/pls/topic/lookup?ctx=acc&id=docacc.

Access to Oracle Support
Oracle customers that have purchased support have access to electronic support 
through My Oracle Support. For information, visit 
http://www.oracle.com/pls/topic/lookup?ctx=acc&id=info or visit 
http://www.oracle.com/pls/topic/lookup?ctx=acc&id=trs if you are hearing 
impaired.

Related Documents
You can access related documents from the JD Edwards EnterpriseOne Release 
Documentation Overview pages on My Oracle Support. Access the main 
documentation overview page by searching for the document ID, which is 876932.1, or 
by using this link:

https://support.oracle.com/CSP/main/article?cmd=show&type=NOT&id=876932.1

To navigate to this page from the My Oracle Support home page, click the Knowledge 
tab, and then click the Tools and Training menu, JD Edwards EnterpriseOne, Welcome 
Center, Release Information Overview.

https://support.oracle.com/CSP/main/article?cmd=show&type=NOT&id=876932.1 
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This guide contains references to server configuration settings that JD Edwards 
EnterpriseOne stores in configuration files (such as jde.ini, jas.ini, jdbj.ini, 
jdelog.properties, and so on). Beginning with the JD Edwards EnterpriseOne Tools 
Release 8.97, it is highly recommended that you only access and manage these settings 
for the supported server types using the Server Manager program. See the Server 
Manager Guide.

Conventions
The following text conventions are used in this document:

Convention Explanation

Bold Indicates field values.

Italics Indicates emphasis and JD Edwards EnterpriseOne or other 
book-length publication titles.

Monospace Indicates a JD Edwards EnterpriseOne program, other code example, or 
URL.

Indicates a link to a recording of the described feature. These 
recordings are in MP4 format so ensure that you have an appropriate 
player installed. Access to these recordings requires a valid Oracle 
account.
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1Introduction to JD Edwards EnterpriseOne 
Foundation

This chapter contains the following topics:

■ Section 1.1, "JD Edwards EnterpriseOne Foundation Overview"

■ Section 1.2, "JD Edwards EnterpriseOne Foundation Implementation"

1.1 JD Edwards EnterpriseOne Foundation Overview
JD Edwards EnterpriseOne software provides a flexible, configurable solution in the 
face of constantly changing technology and enterprise practices. JD Edwards 
EnterpriseOne software is the first network-centric software that separates business 
rules from the underlying technology. As new technologies emerge, JD Edwards 
EnterpriseOne software enables you to easily add them to the framework of your 
enterprise. 

1.2 JD Edwards EnterpriseOne Foundation Implementation
This section provides an overview of what you need implemented to complete 
foundation tasks.

In the planning phase of your implementation, take advantage of all of Oracle's 
sources of information regarding JD Edwards software, including the installation 
guides and troubleshooting information. 

You should be familiar with navigating the system and adding, updating, and deleting 
information by using JD Edwards menus, and pages, forms, or windows. You should 
also be comfortable using the World Wide Web and the Microsoft Windows graphical 
user interface.
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2Understanding JD Edwards EnterpriseOne 
Software

This chapter contains the following topics:

■ Section 2.1, "JD Edwards EnterpriseOne Access"

■ Section 2.2, "JD Edwards EnterpriseOne Software Features"

■ Section 2.3, "JD Edwards EnterpriseOne System Integration"

■ Section 2.4, "JD Edwards EnterpriseOne Foundation"

2.1 JD Edwards EnterpriseOne Access
JD Edwards EnterpriseOne supports web client users through the EnterpriseOne 
Menu. The HTML-based EnterpriseOne Menu provides the ability to navigate 
EnterpriseOne Menus and launch an HTML version of JD Edwards EnterpriseOne. 
The EnterpriseOne Menu is used primarily by end users to conduct end user tasks.

Oracle supports JD Edwards EnterpriseOne web client on the following tablets, 
enabling users in the field to react quickly and efficiently to time-sensitive business 
tasks:

■ Apple iPad. You can access EnterpriseOne through the Safari Web browser. See the 
JD Edwards EnterpriseOne for iPad Quick Start Guide for more information. 

■ Android-based tablets. Starting with EnterpriseOne Tools release 9.1.4, you can 
access EnterpriseOne through the Google Chrome Web browser. See the JD 
Edwards EnterpriseOne for Android Tablets Quick Start Guide for more information.

2.2 JD Edwards EnterpriseOne Software Features
JD Edwards EnterpriseOne software offers the following features:

■ Multiplatform computing: JD Edwards EnterpriseOne software has the ability to 
run on different platforms. This versatility allows for easy maintenance of 
information across a network.

■ Integrated supply chain: JD Edwards EnterpriseOne software provides the ability 
to use the internet and an intranet to enable you to communicate and share 
information with your employees, customers, and suppliers.

■ Interoperability: JD Edwards EnterpriseOne software lets you leverage your 
existing investments in hardware, databases, and software, and integrate them 
with legacy and third-party products.
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■ Adaptability: JD Edwards EnterpriseOne software adapts easily to different 
languages, currencies, reporting provisions, and technology standards.

■ Usability: JD Edwards EnterpriseOne software lets you point and click, drag and 
drop, and use fill-in-the-blank forms to easily complete your tasks.

Through the Oracle WebCenter and JD Edwards Collaborative Portal, users access JD 
Edwards EnterpriseOne applications using links in the Portal's menus.

The following browsers are supported by JD Edwards EnterpriseOne:

■ Safari on Mac OS

■ Mozilla on Linux

■ Internet Explorer on Windows

2.3 JD Edwards EnterpriseOne System Integration
JD Edwards EnterpriseOne software combines enterprise applications with an 
integrated toolset to tailor those applications to the needs of your business.

JD Edwards EnterpriseOne refers to each group of its software products as an 
application suite. The application suites support manufacturing, financials, 
distribution or logistics, and human resource operations for multisite and 
multinational organizations. Your business needs determine what application suites 
are installed for your enterprise system. For complex business situations, you might 
use several application suites to achieve a comprehensive solution.

Each application suite is made up of systems. For example, the Financial Suite contains 
systems such as Enhanced Accounts Receivable (system 03B), Accounts Payable 
(system 04), General Accounting (system 09), Fixed Assets (system 12), and others. 
Each system consists of applications, forms, reports, and database tables that are 
designed to handle specific business needs.

Because the functions and features of all the systems are similar and integrated, you 
are not necessarily aware of moving from one system to another when working with 
various applications. 

This guide often refers to Address Book, system 01, to illustrate the foundational 
concepts of JD Edwards software. Address Book, an online version of a traditional 
card file, is a database of names, addresses, and phone numbers that:

■ Provides easy access to all addresses for searching and reporting purposes.

■ Reduces the need for duplication of records.

■ Provides security through Business Unit assignment or Search Type authorization.

■ Interfaces with other JD Edwards software systems.

Because it is fundamental to business solutions, Address Book provides a realistic 
subject for learning the foundational concepts of JD Edwards EnterpriseOne software.

2.4 JD Edwards EnterpriseOne Foundation
This guide introduces you to the integrated environment of JD Edwards 
EnterpriseOne. Through overviews, procedures, and examples, Foundation describes 
the operations and functions that are common to all applications. Foundation 
comprises the following topics:



Topic Description

JD Edwards EnterpriseOne Access Learn about the different applications that can 
be used as an entry point for accessing JD 
Edwards EnterpriseOne tools and 
applications.

Application User Interface Learn about the operating environment, 
including menus, forms, and the grid.

Records Learn how to locate, add, and work with 
database records, add objects, and format and 
move around on a record-entry form.

Messages and Queues Learn to use Work Center to send and work 
with messages from JD Edwards 
EnterpriseOne users and recipients outside of 
the JD Edwards EnterpriseOne software 
environment.

Media Object Attachments Learn how to attach objects (text, images, OLE 
objects, and JD Edwards EnterpriseOne 
shortcuts) to rows and forms.

MailMerge Workbench Learn about merging JD Edwards 
EnterpriseOne system records with 
third-party word processing documents for 
automatic creation of form letters by using 
certain application workflows.

Interactive Versions for Applications Learn to modify the behavior of applications 
through changes to processing options and 
interactive version detail.

Batch Versions for Reports Learn how to create, modify, and print your 
own report versions.

Processing Options Learn key functionality, types, and how to 
access and use processing options.

JD Edwards EnterpriseOne Foundation
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3Using the JD Edwards EnterpriseOne Web 
Application User Interface

This chapter contains the following topics:

■ Section 3.1, "Understanding Web Application Form Types"

■ Section 3.2, "Accessing JD Edwards EnterpriseOne Web Client"

■ Section 3.3, "Navigating in JD Edwards EnterpriseOne"

■ Section 3.4, "Working with Favorites"

■ Section 3.5, "Accessing Carousel Container"

■ Section 3.6, "Using the Grid"

■ Section 3.7, "Working with Records"

■ Section 3.8, "Working with Toolbar Options"

■ Section 3.9, "Using Parameterized URL"

■ Section 3.10, "Working with Interface Features"

■ Section 3.11, "Working with Send Email and Meeting Invite Options (Release 9.1 
Update 5)"

3.1 Understanding Web Application Form Types
EnterpriseOne applications use a variety of form types. The characteristics of each 
form type remain the same, regardless of the application in which you access the form.

3.1.1 Find/Browse Form
The Find/Browse form provides the entry point to most applications. It contains an 
optional query-by-example (QBE) line enabling you to search using any field in the 
grid. Most Find/Browse forms include the Query control, which enables you to define 
additional search criteria when searching for records. The standard title for a 
Find/Browse form begins with “Work With” followed by information that is specific 
to the business task. You cannot add or change existing records on a Find/Browse 
form.

Find/Browse forms enable you to:

■ Search, view, and select multiple records in a grid

■ Exit to another form to add, change, or view a record
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3.1.2 Search/Select Form
Use the Search/Select form to locate a value for a field. The grid displays values that 
are stored in a database table. When you select a value from the grid and click the 
Select button, that value is automatically placed in the field. For example, when you 
need to enter a user defined code (UDC) into a field, the search button appears, 
enabling you to access a Search/Select form that displays a list of UDCs. You can select 
an item from the list and place it in the appropriate field. Search/Select forms include 
the Query control unless the form appears in a pop-up window. The Query control 
enables you to define additional search criteria when searching for records. You cannot 
edit the information that appears on this form.

3.1.3 Header Detail and Headerless Detail Forms
The Header Detail and Headerless Detail forms include a detail area, the OK button, 
and the Cancel button. You can change multiple records using these forms. The 
Header Detail form includes information from two different business views to provide 
more depth on the information that appears on the form. The Headerless Detail form 
provides information from only one table. Data that is common to all the records in the 
grid appears at the top of the form.

Header Detail and Headerless Detail forms enable you to:

■ Display multiple records

■ View records

■ Add records

■ Change records

■ Delete records

3.1.4 Fix/Inspect Form
The Fix/Inspect form does not include a detail area. If you selected a record on the 
previous form, the Fix/Inspect form displays data for that record. If you are adding a 
record, the Fix/Inspect form is empty, except for any default values.

Fix/Inspect forms enable you to:

■ View a single record

■ Add a record

■ Change a record

3.1.5 Parent/Child Form
The Parent/Child form presents parent/child relationships in an application on one 
form. The left portion of the form presents a list of items. The right portion of the form 
displays information that relates to the selected item in the left portion of the form. 
The Parent/Child form supports the ability to drag and drop items from one area to 
another. This form includes Select and Close buttons.

You can resize the display areas according to your personal preferences.

3.1.6 Message Form
The message form contains information about processing that occurs when you work 
with JD Edwards EnterpriseOne software. For example, when you delete a record, a 
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Confirm Delete message appears to ask if you are sure that you want to delete the 
object. The message might also include information about an event that occurs while 
you work with the system.

3.1.6.1 Message Form as Hover Form
The message form may also contain the context-based information, which is displayed 
when you click the hover indicator in the hover supported JD Edwards EnterpriseOne 
controls. 

This hover form appears around the control.

The hover form may contain context-based information about the Address Book 
Number, Item Number and so on. Also, the hover from may contain card information 
about the Address Book Number.

The hover form closes when you move the mouse cursor away from the control or grid 
cell. You can also use the Close button on the hover form.

Note: The hover form does not appear on the empty control or space 
and error form controls and grid cells. 

You see an orange “dot” indicator at the top left corner of the control, if the hover form 
is associated with the control. Hovering on the orange “dot” will change it into a 
checkable indicator. Click on the indicator to display the hover form. 

Tutorial: Click here to view a recording of this 
feature.This tutorial shows the pre-9.1.5 user interface.

The hover form may contain a tab called Collaborate. SeeSection 3.11.3, "Accessing 
Send Email and Meeting Invite options from Data Dictionary items" 

You can enable or disable the hover form using the Preferences window from the 
Personalization drop-down menu at the user level. Select or deselect the Enable Hover 
Forms option in the Preferences window.

Also, your system administrator can enable or disable the hover form at the system 
level in the JAS.ini file or in Server Manager.

See “Understanding Hover Forms” in the JD Edwards EnterpriseOne Tools System 
Administration Guide.

The hover form association is supported on form level controls and also on the grid. 
For example, Edit Control, Check Box, Combo Box, Associated Text Images, Radio 
Buttons, Text Block, and Grid Cell all support the hover form.

3.1.7 Power Forms
Power forms are web-only application forms that enable you to view multiple, 
interrelated views of data, grids, and tab pages on one form and to pass logic between 
them. The tab pages can have their own business views (BVs), and these BVs can 
communicate with each other and can update based on data selection and changes 
that occur in other BVs on the form. Most Power Browse forms include the Query 
control, which enables you to define additional search criteria when searching for 
records.
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3.2 Accessing JD Edwards EnterpriseOne Web Client
This section provides an overview of accessing the JD Edwards EnterpriseOne web 
client and discusses how to:

■ Access the JD Edwards EnterpriseOne Web Client through the JD Edwards 
Collaborative Portal.

■ Accessing the JD Edwards EnterpriseOne Web Client through the Oracle Web 
Center Portal.

■ Access the JD Edwards EnterpriseOne Web Client Directly.

3.2.1 Understanding JD Edwards EnterpriseOne Web Client Access
Accessing JD Edwards EnterpriseOne applications on the web is similar to accessing 
files and applications on a company network. Typically, either when you start your 
computer or when you want to access company network directories, you must sign in 
to identify yourself to the system as an employee who has the right to access company 
resources. After you sign in, you can access files and applications on the network. 
Similarly, you must sign into the web client, the gateway through which you access JD 
Edwards EnterpriseOne, before you can launch JD Edwards EnterpriseOne 
applications.

To sign in to the JD Edwards EnterpriseOne web client, your computer must have 
access to your company's intranet, you must have a web browser installed on your 
computer, and your system administrator must create an account for you. When your 
system administrator sets up your account, he or she creates a user ID and assigns you 
a password.

Usually, you must enter your ID and password when you launch the JD Edwards 
EnterpriseOne web client. However, your system administrator can configure your 
computer in such a way so that you appear to bypass the sign-in process. For security 
reasons, however, most system administrators want you to sign in manually. When 
you sign in to the JD Edwards EnterpriseOne web client, EnterpriseOne Menu 
appears. EnterpriseOne Menu enables you to access JD Edwards EnterpriseOne 
applications, reports, and other features.

3.2.2 Accessing the JD Edwards EnterpriseOne Web Client through the JD Edwards 
Collaborative Portal

When you sign in to the Collaborative Portal, the portal can pass your sign-in 
information to JD Edwards EnterpriseOne. Therefore, all you must do is bring up a 
workspace containing the EnterpriseOne Menu portlet. The EnterpriseOne Menu 
portlet enables you to access JD Edwards EnterpriseOne applications, reports, and 
other features.

3.2.3 Accessing the JD Edwards EnterpriseOne Web Client through the Oracle 
WebCenter Portal

When you sign in to the Oracle WebCenter Portal, the portal can pass your sign-in 
information to JD Edwards EnterpriseOne. To access specific JD Edwards 
EnterpriseOne applications, reports, or features, your system administrator must 
provide you with specific menu options. Choose a menu option to launch a specific JD 
Edwards EnterpriseOne object. 
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3.2.4 Accessing the JD Edwards EnterpriseOne Web Client Directly
Use these steps to sign into the JD Edwards EnterpriseOne web client if you do not use 
a portal.

To sign in to the JD Edwards EnterpriseOne web client directly:

1. Launch your web browser and navigate to your company's JD Edwards 
EnterpriseOne Web sign-in.

Depending on how your system administrator has configured your system, the 
web sign-in might appear when you launch your browser, you might need to click 
a button or a link, or you might need to navigate to a particular page. Your ability 
to access the JD Edwards EnterpriseOne web client directly might have been 
disabled. If you do not know how to find the JD Edwards EnterpriseOne web 
sign-in, contact your system administrator.

2. Complete the following fields:

– User ID

– Password

3. If your system administrator indicates that you must sign in to a particular 
environment, click Details and complete the Environment field.

4. If you have multiple roles and wish to sign in as one of them, click the Details 
button and complete the Role field.

Note: The default value is *ALL, which signs you in as a member of 
all of your roles. Select the *ALL role if you are not sure which role to 
use. 

5. If you want your computer to remember your settings for the future, select 
Remember my sign in information.

Note: Do not use this option if other people have access to your 
computer.

6. Click Sign In.

The EnterpriseOne Menu appears.

3.3 Navigating in JD Edwards EnterpriseOne
This section provides an overview of the EnterpriseOne Menu, and discusses how to:

■ Access the JD Edwards EnterpriseOne Home Page.

■ Navigate in the Navigator menu.

■ Use the Fast Path.

■ Access your Favorites menu.

■ Add a Task to your Favorites task view

■ Access the carousel container.
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3.3.1 Understanding JD Edwards EnterpriseOne Home Page
When you log into the JD Edwards EnterpriseOne application, you see the 
EnterpriseOne home page. 

EnterpriseOne Page displays the Navigator drop-down menu in the top menu bar. 

See Chapter 3.3.2, "Understanding EnterpriseOne Navigation" 

(Release 9.1 Update 5) The EnterpriseOne Home Page may also contain EnterpriseOne 
Pages that have been assigned to your user ID or your user role. EnterpriseOne Pages 
display as tabs located across the top of the interface. If you are not assigned any 
EnterpriseOne Pages, a default page is displayed when you log into JD Edwards 
EnterpriseOne. 

Some EnterpriseOne Pages might contain interactive content, links to external URLs, 
links to EnterpriseOne applications, and so forth. 

For example, some EnterpriseOne Pages might display interactive information about 
Financial Budgeting and Planning, Capital Asset Management, HCM Recruitment 
Management, Manufacturing Work Orders, Order to Cash, Procure to Pay, Projects, 
Work Orders based on the role of the user.

Other EnterpriseOne Pages, called Embedded Pages, automatically launch an 
application when you click the tab. Applications launched from these EnterpriseOne 
Pages do not contain a Close button. Instead, you navigate away from the application 
by clicking other EnterpriseOne Pages located at the top of the screen. When you 
navigate away from an Embedded EnterpriseOne Page, EnterpriseOne saves any 
information you have already entered, so when you return, your information remains 
as you left it. 

The following example shows the EnterpriseOne Page with tabs and overflow arrows. 
Click the arrow on the tabs, at the right-hand corner of the page to maximize or 
minimize the tabs.

Figure 3–1 EnterpriseOne Page

You cannot change the existing EnterpriseOne page or create a new one. When more 
than one EnterpriseOne page is published to a user/role, then you can access the 
pages using the tabs on the home page.

The system administrator can create new pages.
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See “System Administrator and Designer Tasks for EnterpriseOne Pages” in JD 
Edwards EnterpriseOne Tools System Administration Guide

Drag and drop the tabs if you want to rearrange the published pages as shown in the 
following example.

Figure 3–2 Tabs

JD Edwards EnterpriseOne saves the tab position of the EnterpriseOne pages. Next 
time you log into the JD Edwards EnterpriseOne application, the tabs appear 
depending on the setting during your last session. 

The system administrator can change the existing EnterpriseOne page through the 
User Generated Content administration application.

3.3.2 Understanding EnterpriseOne Navigation
The Navigator menu is the web-based application you run to access JD Edwards 
EnterpriseOne applications.

3.3.2.1 Menu
The top portion of the JD Edwards EnterpriseOne Menu bar displays a drop-down 
menu that you can use to navigate to the specific application or report that you want 
to launch. The drop-down menu can contain objects other than applications; for this 
reason, all objects in the drop-down menu are called tasks. Applications, reports, and 
shortcuts in the drop-down menu are all tasks. 

Principal sets of tasks are called task views. Your system administrator configures your 
task view list. This contains the initial contents of the drop-down menu. 

System administrators use JD Edwards Solution Explorer and JD Edwards 
EnterpriseOne ERP security applications to manage user accounts and to configure 
EnterpriseOne Menu.

The following example shows the JD Edwards EnterpriseOne drop-down menu.
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Figure 3–3 JD Edwards EnterpriseOne Drop-down menu

When you click on the menu, the sub-menu appears.

The Navigator menu displays visual cues to help you identify the type of task. 

Each task will have a context menu. Right-click the task to view the context menu.

3.3.2.2 Breadcrumbs (Release 9.1 Update 2)
Breadcrumbs enable you to keep track of the menus you have used to navigate to your 
current application. When clicked, each breadcrumb displays the associated menu and 
its submenus at the location of the breadcrumb. If you use breadcrumbs to navigate in 
EnterpriseOne, the breadcrumb string changes to reflect the new navigational path 
you have chosen. Breadcrumbs do not appear if you use Fast Path or EnterpriseOne 
Pages to launch an application. 

The breadcrumb history is saved by default whenever you open any application using 
the Navigator drop-down menu.

To view or hide the breadcrumbs, click the Personalization menu, then the Preferences 
menu, and then select or deselect the Show Menu Breadcrumbs check box. Click Save 
and Close button to save your changes.

(9.1 Update 5) Click the drop-down menu icon located near the breadcrumbs to view 
the history and to access the application as required.

 The breadcrumbs history is arranged in a chronological order. The path that you last 
accessed is listed first.

You can view and access the breadcrumbs history even after you log out and log in to 
the JD Edwards EnterpriseOne application.

The breadcrumbs history can be deleted by clicking the Personalization menu, then the 
preferences menu. Click on the Clear button in front of the Clear Breadcrumbs history 
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option to delete the history of bread crumbs. Click Save and Close to save your 
changes. 

If you clicked the Clear button but do not want to delete the breadcrumbs history, click 
the Undo button before you click the Save and Close button.

If you are a system administrator, the Server Manager interface for runtime and metric 
parameters provides details on the usage of each setting applicable to that parameter. 
Access this setting by clicking the “i” (Information) icon for a desired parameter. 
Breadcrumbs are enabled if both the Show Menu Breadcrumbs option on the 
Preferences menu (located on the Personalization menu), and the Enable Menu 
Breadcrumbs in the JAS.ini file are enabled.

The JAS.ini settings are in the Web Runtime section OWWEB.

Setting name = Enable Menu Breadcrumbs

The number of breadcrumbs that can be stored in the history can be defined in the 
JAS.ini file under the section OWWEB. The range for maxRecentBreadcumbs value 
should be set between 1 and 10.

If maxRecentBreadcrumbs property is not defined in JAS.ini, the system sets the 
maximum number of breadcrumbs history as 10. 

If you are a system administrator, log in to the SM console and select the appropriate 
JAS server from the management dashboard. Navigate to the Configuration section of 
the selected JAS server and select Advanced option from the View drop-down menu. 
Click on the Web Runtime link in the configuration section. In the Web Runtime 
section, you can see a parameter called 'Maximum number of Recent Breadcrumbs'. 
The default value of this parameter is 10. You can change the value of this parameter 
from 1 to 10.

3.3.2.3 Open Application List
The Navigator menu enables you to choose whether the system launches applications 
in a new window, or launches them in the same window, replacing the current 
application located there. Click the task in order to launch the task in the current 
window. 

To launch a task in a new window, right-click the task and click "Open in New 
Window" from the context menu.

Each open application is listed in the Open Application drop-down menu. This 
enables you to navigate between open applications.

Also, the open applications appear as carousel tiles in the Open Applications tab of the 
carousel container. 

See Chapter 3.5, "Accessing Carousel Container"

3.3.2.4 Recent Reports
The Recent Reports drop-down menu displays the recently opened reports. 

The Navigator menu displays visual cues to help you identify the status of the reports. 
For example, as shown in the following table, reports with the Done status have a 
green color check icon beside them and reports with the Error status have a red color 
error icon beside them. 



Table 3–1  

Tile Status

Waiting (W)

In Queue (S)

Processing (P)

Done (D)

Error (E)
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3.3.2.5 Fast Path
Fast Path is a field that enables you to access a specific task (that is, a folder, 
application, or report) directly. You use commands in Fast Path to move quickly 
among menus and applications.

To access the Fast Path field, click on the Navigator drop-down menu.

 To use the Fast Path field, enter a Fast Path code and click the button to the right of the 
field. Depending on how your system administrator configured your account, you 
might not be able to see Fast Path. 

You can also use the Fast Path field to access menus. Task views are composed of 
menus and individual tasks. Menus have no special format in EnterpriseOne Menu; 
they simply provide application developers with a convenient method of grouping 
applications. When you access a menu, you actually access a specific place in a task 
view.

To access a menu, enter its menu ID. For example, enter G0 to access the Foundation 
Systems menu. 

When you enter a menu ID in the Fast Path field, the corresponding menu appears in 
the Navigator drop-down menu. Also, the label Back to Navigation by Role is 
displayed in the top menu bar. Click Back to Navigation by Role label to display the 
default JD Edwards EnterpriseOne menu in the Navigator drop-down menu.

You can find a Navigating in EnterpriseOne menu's ID by hovering over it. To launch 
an application, enter the application's program number. To specify a form in the 
application, enter the application's program number followed by a |, and then enter 
the form ID. For example, when you enter P01012|W01012B, the system displays the 
Work with Addresses form in the Address Book application. You can specify a version 
of a form by adding a | and the version number after the form name; for example, 
P01012|W01012B|ZJDE0003.

Contact your system administrator for specific internal task, menu, and application 
IDs. Not all objects have Fast Path commands.

3.3.2.6 Favorites
If you frequently run a task or access a folder, you can save it as a favorite for quick 
access. The favorites that you add are displayed under the Favorites menu. You can 
access that task or folder directly from the Favorites menu. 

You can customize the list of favorites displayed in the Favorites menu. Depending on 
how your system administrator configured your account, you might not be able to see 
or change your Favorites menu options.
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See Section 3.4, "Working with Favorites"

Note: When a customer upgrades to the latest JD Edwards 
EnterpriseOne Tools release, the existing Favorites for the user appear 
in the Favorites menu. 

3.3.2.7 Roles — Role Chooser
The tasks you see in the Navigator menu are filtered by role. Your system 
administrator decides the tasks that are available for each role and then assigns the 
role to you. You can have one or many roles assigned to you. You choose which role 
you want to use at the time you sign into EnterpriseOne. The role you choose 
determines the tasks that are available to you. Your ability to choose roles at sign in 
and to choose roles from the Navigator menu depends on if your system administrator 
has given you permissions to do so. If she/he has not, then you can only sign in using 
the *ALL (All My Roles) role. When signed in as *ALL, the EnterpriseOne Menu 
displays a concatenated list of all the tasks enabled for each role that is included in 
*ALL.

Note: Your system administration determines the roles that are 
included in *ALL role. 

If enabled by your system administrator, the JD Edwards EnterpriseOne Menu bar 
displays the Role drop-down menu. This menu enables you to display different sets of 
tasks by role. You can either select *ALL – ALL My Roles to view a concatenated view 
of all of the tasks assigned to all of the roles in the *ALL role. Or you can select an 
individual role and view only the tasks for that role. Only the roles that are included in 
the *ALL role appear in the drop-down menu. If your system administrator has not 
enabled you to choose roles, the Roles drop-down menu will not appear. Instead, you 
only see the *ALL role and the tasks enabled within that role. This feature is only 
available if your system administrator has enabled viewing tasks by role. You sign in 
using *ALL. 

3.3.2.8 Personalization
The Personalization drop-down menu has the following sub-menus:

■ My System Options

■ My System Profile

■ Preferences

See Chapter 5.4.3, "Working with User Options"

Click My System Profile to view the details of your system such as the release number, 
environment, and role. 

Select or deselect the check boxes in Preferences window to select or deselect the 
following user interface preferences in JD Edwards EnterpriseOne. Click the Save & 
Close button to save the changes and to close the Preferences window.



Table 3–2  

Preferences Default Value Details

Show Related Information Checked Select this option to activate the Composite 
Application Framework for a User ID or Role.

Deselect this option to disable the Composite 
Application Framework for a User ID or Role.

Enable Hover Forms Checked Use this option to enable/disable informational 
hover windows when the mouse cursor hovers 
over selected controls.

Enable Row/Form Exit 
Menu on right click

Checked Use this option to enable/disable right-click 
option on Form/Grid cell to access Form / Row 
Exit menu.

Show Add Favorites 
Window

Checked Use this option to enable/disable Add Favorites 
pop-up window

Auto Suggest Enabled Checked Use this option to enable/disable auto-suggest 
feature.

Zoom in Checked This option is available only when you are 
accessing JD Edwards EnterpriseOne using an 
Apple iPad. 

See “User Interface” in JD Edwards 
EnterpriseOne Web Client for iPad Quick Start 
Guide.

Use Large Icons in Carousel Checked Select this option to change the size of the 
carousel tile to large. De-select this option to 
change the size of the carousel tile to small.
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3.3.3 Navigating in Navigator Menu
Access Navigator.

1. In Navigator Menu, click a task (that is, a folder).

The drop-down menu displays the child tasks as sub-menu.

2. Continue to navigate through the sub-menu until you reach the object you want to 
launch.

Hover over a task to see more information about it. The system tells you what 
kind of object the task is (for example, application, report, and so on) and other 
information, such as its number and version.

3. To launch the object, click it.

You can launch multiple applications. Depending on how your system 
administrator has configured your system, additional applications launch in the 
same window or in a different window. If the system is configured for multiple 
browser windows, you can hold down the CTRL key when you press Enter to 
launch the application in a new window. Either way, the applications you have 
running appear at the top of the tree under Open Applications.

4. If you have multiple applications open, click the application name under the Open 
Applications drop-down menu to bring a specific application to the forefront. You 
can also click the application tile in the Open Applications tab of the carousel 
container to bring a specific application to the forefront.
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Depending on the object type, you might be able to select a version or to set data 
selection or processing options. Right-click the task to make a choice from the 
context menu.

3.3.3.1 Hot Keys
Click the ‘i’ button on any open JD Edwards EnterpriseOne form to open the 
information dialog. Then, click on Display list of all hot keys to obtain the list of hot 
keys supported by the JD Edward EnterpriseOne software. You can also use Ctrl+ 
Shift+K to open the hot keys information window.

3.3.4 (Release 9.1 Update 5) Understanding Standard and Simplified Modes
EnterpriseOne has two modes: Standard and Simplified. Your system administrator 
determines the mode assigned to you. Standard mode is for users who need access to 
the full range of EnterpriseOne actions. If you are using Standard mode, you are able 
to view the Navigation bar, the Carousel, the Fast Path (if you have the appropriate 
permissions), and Breadcrumbs. 

In Standard mode, your Personal Preferences dialog box contains the following 
options:

Figure 3–4 Personal Preferences Dialog Box, Standard Mode
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The Simplified mode is a scaled-down interface that provides you with only the 
limited actions you might need to use in EnterpriseOne. In Simplified mode, you see 
the Banner Bar, Personalization, Help, Username, Environment, and Sign Out options.

 Simplified mode enables you to access applications by clicking the EnterpriseOne 
Page tabs located across the top of the screen. Some EnterpriseOne Pages contain links 
and buttons that you click to access applications, URLs, etc. 

In Simplified mode, your Personal Preferences dialog box contains the following 
options:

Figure 3–5 Personal Preferences Dialog box, Simplified Mode

3.3.4.1 Selecting Standard or Simplified Modes
If your system administrator has enabled you to do so, you can choose if your 
EnterpriseOne interface displays Simplified or Standard mode.

To choose Simplified or Standard mode:

1. Ensure that you have permissions to change the Standard or Simplified mode by 
clicking Personalization, My System Options, and then User Profile Revisions. 

2. Ensure that the Simplified mode option is set to Yes if you want to view 
EnterpriseOne in Simplified mode, and that the option unchecked if you want to 
view EnterpriseOne in Standard mode.
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3.3.4.2 Closing Applications when too Many are Open
Your system administrator determines the number of applications you can have open 
at one time. If you have reached the maximum number of applications that you can 
have open, you will receive the following error message:

Too many EnterpriseOne Applications are open at this time. Find one or more open 
application(s) with a Close button located in the toolbar and click the Close button to close the 
application.

This message means that you must close one or more EnterpriseOne applications 
before you can open any others.

Some EnterpriseOne Pages, called Embedded Pages, launch an application 
automatically when you click the EnterpriseOne Page tab. You cannot close these 
pages because they do not have a Close button. Therefore, find an application that has 
a close button, save your work if desired, and click Close. You may resume opening 
applications once you have closed enough applications so that you are below the 
maximum number specified by your system administrator. 

Note: If you have opened the maximum number of Embedded 
EnterpriseOne Pages, you might have to log out and log back in to JD 
Edwards EnterpriseOne.

3.4 Working with Favorites
This section discusses how to: 

■ Access the Favorites Menu

■ Add a Favorite

■ Add a Favorite from an Open Application

■ Manage the Favorites Window

■ Rename Favorites

■ Remove Favorites

■ Reorder Favorites

■ Reorganize Favorites

3.4.1 Accessing the Favorites Menu
To access the Favorites menu, click Favorites on the EnterpriseOne menu.

The Favorites menu displays all of the tasks and folders that you added. 

Note: The favorite tasks and folders are also displayed in the 
Favorites tab in the carousel container.

3.4.2 Adding a Favorite
Tasks can be added as favorites. To add a favorite:

1. Right-click the task that you want to add as favorite, and select Add to Favorites 
from the context menu.
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2. In the Add to Favorites dialog box, use the default name or enter the name for 
your favorite.

3. Click Create Favorite.

The task is added to the Favorites menu.

Notes: 

■ Duplication of favorites in the same folder level is not allowed.

■ While adding a favorite, you can hide the Add to Favorites 
window from appearing again by placing a check mark in the Do 
not show this screen again check box. 

To make the Add to Favorites window appear again, access the 
Personalization menu, and from the Preferences option, select the 
Show Add Favorites Window check box. 

3.4.3 Adding a Favorite from an Open Application (Release 9.1 Update 2)
You can add a favorite from any form of an open application instead of from a task 
view. Navigate to an application either through the Navigator menu, or through the 
Fast Path. Your ability to add a favorite from an open application form depends on 
whether or not your system administrator has enabled you to do so.

If you are a system administrator, the Server Manager interface for runtime and metric 
parameters provides details on the usage of each setting applicable to that parameter. 
Access the interface by clicking the “i” (Information) icon for a desired parameter. The 
ability to add a favorite from an open application form is enabled if the Setting name = 
Allow Non-Task Favorites in the JAS.ini file is enabled.

Note: You cannot add a favorite to an application that has form 
interconnects, which is the ability of application forms to pass 
information back and forth between them.   

1. To add a favorite from an open application, launch an application.

2. From the Tools menu, click Add to Favorites.

The Add to Favorites dialog box appears.

3. In the Name field, accept the default name or enter a new name. 

Note: Select the Do not show this screen again check box if you do 
not want the Add to Favorites Dialog box to appear when you add a 
favorite. To make the Add to Favorites window appear again, access 
the Personalization menu, and from the Preferences option, select the 
Show Add Favorites Window check box. 

Also, you can click the Manage Favorites link to launch the Manage 
Favorites window where you can delete, rename, reorder, and create 
user-defined folders to reorganize the favorites. See Manage Favorites 
in the Foundation guide for more information about this topic. 

4. Click Create Favorites.
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You will see your new favorite on the Favorites menu, and the Favorites folder on 
the Carousel. 

3.4.4 Manage Favorites Window
The Manage Favorites window displays the favorites that are added by the user. You 
can delete and edit favorites from this window. The Manage Favorites window allows 
you to delete, rename, and reorder favorites, as well as create user-defined folders to 
reorganize favorites.

You can access the Manage Favorites window in the following ways:

To access Manage Favorites from the Favorites menu:

1. Click Favorites.

2. Click Manage Favorites.

The Manage Favorites window appears.

To access Manage Favorites from the carousel:

1. Click the Favorites tab in the carousel.

2. Click the Manage Favorites icon.

The Manage Favorites window appears.

Note: The Manage Favorites link is also available in the Add to 
Favorites window, and the Favorites Properties option.

3.4.5 Renaming Favorites
You can rename a favorite in the following ways:

To rename a favorite from the Favorite Properties:

1. Right-click a favorite from Favorites menu.

2. Select Favorite Properties.

3. Enter the name for the favorite in the Favorite Properties window.

4. Click Save Changes.

The new name of the favorite appears in the Favorites menu.

To rename a favorite from the Manage Favorites window:

1. Click Favorites.

2. Click Manage Favorites.

3. From the Manage Favorites window, select the favorite you want to edit.

4. Click the edit button next to the selected favorite.

5. Enter a name for the favorite.

6. Click outside the name field or press the Tab key on the keyboard.

The new name of the favorite appears in the Favorites menu.

To rename a favorite from the Add to Favorites Window:

When you add a task or folder as favorite the Add to Favorites window appears. 
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1. Clear the name that is displayed in the Favorites field.

2. Enter the new name.

3. Click Create Favorite.

The new name of the favorite appears in the Favorites menu.

3.4.6 Removing Favorites
You can remove or delete a favorite in the following ways:

To remove a favorite from the Favorites menu:

1. Click Favorites.

2. Right-click the favorite which you want to remove.

3. Select Remove From Favorites.

4. On the Remove Favorite dialog box, click OK.

JD Edwards EnterpriseOne removes the favorite from the Favorites menu.

To remove a favorite from the Manage Favorites window:

1. Access the Manage Favorites window.

2. Select the favorite that you want to remove.

3. Click the Remove Favorite icon next to the selected favorite.

4. On the Remove Favorite dialog box, click OK.

JD Edwards EnterpriseOne removes the favorite from the Favorites menu.

To remove all the favorites:

 From the Manage Favorites window, click Delete All.

All the favorites are removed from the Favorites menu.

3.4.7 Reordering Favorites
You can arrange favorites in the order you prefer them to appear in the Favorites 
menu. To reorder favorites:

1. Access the Manage Favorites window.

2. Drag and drop the favorites in the order you want them to appear.

The Favorites menu displays the favorites in the sequence you arranged.

3.4.8 Reorganizing Favorites
You can create new folders to organize your favorites. To create a folder:

1. Access the Manage Favorite window.

2. From the Manage Favorites window, click New Folder.

3. Use the default folder name or enter the name for the folder.

4. Click outside the folder name field or press the Tab key on keyboard.

A user-created favorite folder is created. 

In the Manage Favorites window, you can drag and drop the favorites into the 
user-created favorite folder to organize your favorites.
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You can view the content of the user-created favorite folder by clicking the Manage 
user-created folder icon, on the left side of the user-created folder’s name.The favorites 
appear in the order you added them in the user-created folder. To navigate back to the 
main view of the Manage Favorites window, click the Back button. 

Note: You cannot drag and drop a user-created folder into another 
folder.

3.5 Accessing Carousel Container
A carousel is a generalized container that holds objects which can be activated. These 
objects are displayed on tiles arranged from left to right, and you can flip through 
these tiles. The carousel container provides quick access to the open applications, batch 
versions, and favorite JD Edwards EnterpriseOne applications and batch jobs. 

Note: The carousel is to JD Edwards EnterpriseOne as the taskbar is 
to Microsoft Windows. 

To access the carousel container, click the bar along the inside edge at the bottom of the 
browser window. Click this bar to toggle between minimized and maximized modes 
of the carousel container.

When the carousel is minimized, only the toggle bar is visible, and the arrow points 
out from the edge towards the center of the page. The carousel tiles are linear and have 
two distinct ends. 

Click the Move icon, next to the Favorites tab, to hide and unhide the tabs of the 
carousel container.

3.5.1 Carousel Tiles
The carousel tile uses a background image to indicate what type of tile it is. For 
example, application tiles have a different icon to distinguish them from UBE's. 

Each carousel tile contains text describing the application or UBE with which it is 
associated. For example, an application tile lists the application name, form name, and 
application title. 

Click the tile in the carousel container to open the task. As shown in the following 
example, the tile that represents the application that is currently open is highlighted. 
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Figure 3–6 Carousel Tiles

You can change the carousel tile size by accessing Preferences dialog from the 
Personalization drop-down menu. Select or deselect the Use Large Icons in Carousel 
checkbox and click the Save and Close button.

The carousel container contains the following three tabs:

1. Open Applications

2. Recent Reports

3. Favorites

3.5.1.1 Open Applications
Each application that is open is represented as a tile in the Open Applications tab of 
the carousel container. Click the tile in the Open Application tab to bring a specific 
application to the forefront.

Note: Open applications are also listed under the Open Applications 
drop-down menu. 

Hover over the tiles in the Open Applications tab to view the details of each 
application.

3.5.1.2 Recent Reports
The Recent Reports tab displays all of the recently submitted reports (batch versions). 
Click the first tile, which represents Submitted Jobs, to open Submitted Job Search 
(P98305W).
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Hover over the report tiles to view report, version, status, submitted date, and last 
activity as shown in the following example.

Figure 3–7 Recent Reports tab in Carousel

The tiles that represent the reports display visual cues to help you identify the status of 
the reports. The status of a report is conveyed by the color of the pencil icon in the tile. 
For example, Green = Done (D), Red = Error (E), Blue = Submitted (S)/Waiting 
(W)/Processing (P), Yellow = Held (H).

Note: Use the Refresh icon to trigger an immediate update.

3.5.1.3 Favorites Tab (Release 9.1 Update 2)
The items that you add as favorites from the JD Edwards EnterpriseOne menu also 
display on the Favorites tab in the Carousel. When the Carousel is docked on the 
bottom of EnterpriseOne, favorite items display on the Favorites tab. When the 
Carousel is docked on the side of EnterpriseOne, favorite items display in the 
Favorites section. In most cases, Favorites performs the same no matter where the 
Carousel is docked. However, there are some instances where functionality differs 
slightly, and these will be noted in this documentation. This documentation describes 
Favorites and its performance while docked at the bottom of EnterpriseOne. 

The Favorites tab can contain three types of tiles: task folder tiles, user-defined folder 
tiles, and task tiles. 

When you open the Favorites tab and click a parent-level task folder or user-defined 
folder located there, EnterpriseOne adds a tab to the tab bar. This new tab displays the 
task folder or user-defined folder name and all the contents of that folder. When you 
double-click a sub-folder, a '^' appears on the left side of the tab.  The '^' indicates that 
there is a higher-level folder. When you click the '^', the higher- level folder and its 
contents appear.
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When you create a user-defined folder, you can include in it tasks and task folders, but 
not additional user-defined folders. However, task-folders can, and often do, contain 
other task-folders as well as tasks, though you cannot add a task-folder or task to any 
existing task-folder. If you click a task folder contained within another task-folder, the 
current tab displays the new task folder name. If you hover above a task folder, a list of 
everything within that folder displays in a box near the cursor. You can change the 
name of the parent-level task folder at the Favorites level but you cannot change the 
names of items in the folder or the structure of its contents. You cannot change the 
name of the task folder, or its contents. If you click a task, the appropriate application 
launches.

Tutorial: Click here to view a recording of this 
feature.This tutorial shows the pre-9.1.5 user interface.

3.5.1.4 Organizing Favorites (Release 9.1 Update 2)
The Favorites tab can contain one or all of the following tiles:

■ User-defined folder

■ Task folder

■ Task

You can move task or task-folder tiles from the Favorites tab to a user-defined-folder 
tab and you can move those tiles back from a user-defined-folder tab to the Favorites 
tab. You cannot move user-defined folder tiles from the Favorites tab.

To move a task folder or task tile, click the tile, hold the mouse button until a red 
border appears, and then drag the tile over the user-defined folder tile to where you 
want the tile moved. The user-defined folder tile displays a grey background and a 
green border when it is activated to receive an acceptable tile. Release the mouse 
button to drop the tile. The tile will be moved to the user-defined folder's content. 

You can also move a task folder or task tile by briefly holding (or hovering) a tile over 
an open user-defined-folder tab or Favorites tab. The tab is activated and enables you 
to view the contents of that tab. It also indicates that you can drop the tile into the 
existing content on the receiving tab. 

Note: When the Carousel is docked on the side of EnterpriseOne, 
you hold the tile over a user-defined section. When the section is 
ready to receive the tile, it will be highlighted in grey and display 
green borders. Releasing the tile when the section is activated will 
drop the tile into the section. The tile is positioned at the end of the 
section.

EnterpriseOne ensures that you drop Favorite task tiles or task-folder tiles to an 
appropriate location. An appropriate location is one where the tab is activated to 
receive a tile, and the tile meets the criteria to be moved and dropped. If the location in 
which you are trying to drop is not appropriate, it will either move out from 
underneath the tile you are dragging or change the mouse icon to “not-allowed,” 
indicating that either the location to which you are trying to drop is not activated or 
the tile you are dragging does not meet the criteria to be moved and dropped.

https://apex.oracle.com/pls/apex/f?p=44785:24:0::::P24_CONTENT_ID,P24_PREV_PAGE:6109,1 
https://apex.oracle.com/pls/apex/f?p=44785:24:0::::P24_CONTENT_ID,P24_PREV_PAGE:6109,1 
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3.5.1.5 Ordering Tabs
You can change the order in which the tabs display by dragging and dropping them to 
a different location on the Carousel tab bar. The tab order will be the same if the 
Carousel is docked in the horizontal or vertical position. When you log out and login 
back into EnterpriseOne, your latest changes to the tab order are retained.

3.5.1.6 Hiding and Showing Recent Reports, Open Applications, Favorites Tabs 
and Sections (Release 9.1 Update 3)
You might want to hide the Recent Reports, Open Applications, and Favorites default 
tabs if you never use them, use them infrequently, or just want more space on the 
screen. The changes you make to the Carousel are saved and remain when you log off 
and log back into EnterpriseOne.

Note: This document refers to “tabs” if you have docked the 
Carousel on the top or bottom of the screen, and “sections” if you 
have docked the Carousel on either side of the screen. 

If you hide any of these tabs or sections, you can show them again at any time.

You can hide only two of the default tabs or sections. You must have at least one tab or 
section visible at all times. 

To hide a default tab when the Carousel is docked on the top or bottom of the screen, 
right-click the tab, then click the tab name in the Hide pop-up window that displays, 
as shown in the following graphic: 

Figure 3–8 Hide Pop-Up Window Bottom

To hide a default tab when the Carousel is docked on the side of the screen, right-click 
the tab, then click the tab name in the Hide pop-up window that displays, as shown in 
the following graphic: 
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Figure 3–9 Hide Pop-Up Window Side

In the following graphics, the Favorites tab and section are hidden:

Figure 3–10 Favorites Tab Hidden on Bottom

Figure 3–11 Favorites Tab Hidden on Left

When you hide a default tab, the change is reflected wherever the Carousal is docked. 
For example, if you make the change when the Carousal is docked at the bottom of the 
screen, then move it to the side, the changes remain. 
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To show the tab or section again, right-click the remaining tabs or sections, and select 
the tab or section name under Show, as shown in the following graphics:

Figure 3–12 Favorites Show Pop-Up Window Bottom

Figure 3–13 Favorites Show Pop-Up Window Side

EnterpriseOne does not enable you to hide all three default tabs or sections at once; 
instead, you can only hide two at a time. Therefore, since you must have one tab or 
section shown at all times, EnterpriseOne gives you only the option to Show if you 
have already hidden two tabs, as shown in the graphics below:
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Figure 3–14 Show Pop-Up Window Bottom

Figure 3–15 Show Pop-Up Window Side

3.5.2 Carousel Position 
The carousel can be docked along any of the four edges of the browser window. 

By default, the carousel is docked along the bottom of the browser page. 

You can change the carousel position by dragging and dropping the carousel to a new 
position. When docked along the top or bottom of the browser window, the tiles are 
displayed horizontally. When docked along the right or left, the tiles are displayed 
vertically.

When the carousel is docked along the top or bottom of the browser window, you can 
click on the caption text of the tile to cycle through the different options.

JD Edwards EnterpriseOne saves the carousel position. Next time you log into the JD 
Edwards EnterpriseOne application, the carousel appears at the bottom, top, left, or 
right position depending on the setting during your last session. 
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3.6 Using the Grid
This section provides an overview of the grid and discusses how to:

■ Create a Grid Format.

■ Create a Grid Format for Pervasive Devices.

■ Apply a Grid Format.

■ Change a Grid Format.

■ Delete a Grid Format.

■ Hide and Show Grid Columns.

■ Freeze and UnFreeze Grid Columns.

■ Rearrange Grid Columns.

■ Set Grid Color and Font.

■ Change Grid Column Width.

■ Change the Sort Sequence of a Grid.

■ Export All Records from a Grid.

■ Export Detail Area Content to Microsoft Excel, Word or to a Comma Separated 
Values File.

■ Import Data from an External Spreadsheet to a Grid.

■ Customize the Grid Dynamically.

■ Copy and Paste Grid Data.

3.6.1 Understanding the Grid
Similar to find/browse forms, hierarchical grids, or parent/child browse forms, are 
used to query business views (BVs) and select records from BVs for operations. 
However, instead of a default grid control, hierarchical grids contain a default parent 
child control. Whether or not you have hierarchical grids depends on if your system 
administrator incorporated them into the applications you use. 

The following table describes the features of the hierarchical grid:

Feature Description

Cut, Copy, and Paste You can cut, copy, and paste a node in the tree. Cutting 
a node copies the data of a node and marks the node as 
being cut. Copying a node copies the data of a node. 
Pasting a node pastes the node as the last child of the 
new node. If the node is copied, the original node stays. 
If a node has been cut, the original node is removed. 
Cancel Cut will cancel the operation. Use the copy, cut, 
and paste buttons located on the toolbar of the grid to 
perform these functions.

Indent/Outdent You can change the indentation of a tree node. Use the 
Indent and Outdent buttons located on the toolbar of 
the grid to perform these functions.

Expand All You can expand all the nodes in the tree. Use the 
Expand All button located on the toolbar of the grid to 
perform this function.
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3.6.2 Understanding Grid Icons and Buttons
This table shows the icons and buttons that might display on the grid. Whether or not 
you see any of these icons or buttons depends on if the application you are using was 
designed to display them. You might see a variation of these icons and buttons, 
depending on the application in which you are working.

Collapse All You can collapse all the nodes in the tree. Use the 
Collapse All button located on the toolbar of the grid to 
perform this function.

Fully Expand One Tree Node You can fully expand a selected tree node. When this 
happens, all cascading children of the selected tree 
node will be displayed. Use the Expand All button to 
perform this function.

View Location Number If your system administrator has turned on the View 
Location Number option, you see a number beside each 
tree node. Use this number to determine the location of 
the tree node within the tree. 

Flat Display Tree You can make all tree nodes display on one vertical 
level. Child nodes are not indented.

Select All Children You can select all of the children in a node. Use the 
Select All button located on the toolbar of the grid to 
perform this function.

Editable Parent Child You can edit the tree column and all the grid columns 
in the hierarchical grid.

Change Data Dictionary Item on the 
Fly

You can display custom selected columns in a user 
defined sequence. 

Vertical Scrolling Keeps Column 
Header

When scrolling down grid data, the grid column header 
remains visible.

Icon Description

Delete

Edit

Lock

Unlock

Move Up

Move Down

Price

Print

Attach

Feature Description
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3.6.3 Creating a Grid Format
Your ability to create a grid format depends on whether or not your system 
administrator has enabled the Customize Grid option. If you do not see the Customize 
Grid option in the blue bar located at the top of the grid, you do not have permissions 
to customize the grid.

If you want to recall the default format, save the original grid format before you save a 
new format. Otherwise, you must remove the new format, exit the application, and 
then access the application again to view the default grid format.

Note: Columns that you are required to use have an asterisk beside 
the column name. You cannot remove these required columns from 
your grid format.

Access the application for which you want to create a new grid.

1. Launch the application for which you want to create a new grid format and click 
the Customize Grid link

2. On Select Grid Format, click the Create button.

3. Enter a name for the format in the Grid Format Name field.

4. Complete the rest of the options as desired, and click the OK button.

5. Click the Close button.

3.6.4 Creating a Grid Format for Pervasive Devices
Access the JD Edwards EnterpriseOne web client.

1. Using the JD Edwards EnterpriseOne web client, launch the application for which 
you want to create a grid format for pervasive devices.

2. Click Customize Grid and select the format that you want to use for pervasive 
devices.

If you have not created the format, do so now. Follow the same steps for creating 
the format that you use for creating a web-based format. However, keep in mind 
the limited space and color options offered by most pervasive devices when you 
decide about columns to display, column widths, column and text colors, and so 
forth.

3. Click Default for Mobile Device and click Close.

Copy

View

Toggle Off

Toggle On

Weigh

Icon Description
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3.6.5 Applying a Grid Format
Access a form with a grid.

On any form with a grid, select a grid format from the drop-down list next to 
Customize Grid.

You must create one or more grid formats before you can apply a grid format.

3.6.6 Changing a Grid Format
Your ability to change a grid format depends on whether or not your system 
administrator has enabled the Customize Grid option. If you do not see the Customize 
Grid option in the blue bar located at the top of the grid, you do not have permissions 
to customize the grid.

Note: Columns that you are required to use have an asterisk beside 
the column name. You cannot remove these required columns from 
your grid format.

Access the application containing the grid format that you want to change.

1. Click the Customize Grid link.

2. On Select Grid Format, select the grid format that you want to change and click 
the Modify button.

3. To change the name of the grid format, enter a new name in the Grid Format 
Name field.

4. Change other elements of the grid as desired and click the OK button.

5. Click the Close button.

3.6.7 Deleting a Grid Format
Your ability to delete a grid format depends on whether or not your system 
administrator has enabled the Customize Grid option. If you do not see the Customize 
Grid option in the blue bar located at the top of the grid, you do not have permissions 
to delete the grid format.

Access a form with a grid.

1. On any form with a grid, click the Customize Grid link.

2. On Select Grid Format, select the grid format that you want to delete and click the 
Delete button.

The grid format disappears from the list.

3. Click the Close button.

3.6.8 Hiding and Showing Grid Columns
When you work with forms that have grid columns, you can hide one or more 
columns that you might not need. You can show the hidden columns when you need 
them. 

You can use one of these methods to hide and show grid columns. 

■ Customize grid link.
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■ Right-click in column header.

Note: Columns that you are required to use have an asterisk beside 
the column name. You cannot remove these required columns from 
your grid format.

3.6.8.1 Customize Grid Link 
Access the application containing the grid you want to change.

1. Click the Customize Grid link and either create a new format or select an existing 
one to modify.

2. On Customize Grid, scroll to the Display and Order section.

3. To prevent a column from showing on the grid, select it in the Display and Order 
list, and then click the left arrow.

4. To make a column appear on the grid, select it in the Available Columns list, and 
then click the right arrow.

5. Use the up and down arrows to change the order in which the system displays the 
columns on the grid.

6. When finished, click the OK button, and then click the Close button.

3.6.8.2 Right-Click in Column Header 
Access the application containing the grid you want to change. 

1. Click the drop-down menu next to the Customize Grid link and either select Show 
All Columns to create a new grid format or select an existing grid format to 
modify. 

2. Right-click the header of the column that you want to hide. 

3. Select the Hide option from the context menu

4. Click the Save icon to save the grid format.  

If you are creating a new grid format, the Enter Format Name window appears. 
Enter a new grid format name and click the OK button. 

5. To make a hidden column appear on the grid, right-click in any column header. 

Note: If you do not save the grid format, the column is hidden until 
you exit the application. The hidden column will be visible when you 
log into the JD Edwards EnterpriseOne application again

6. On the context menu, select Unhide, then select the hidden columns that you want 
to appear on the grid, and then click OK. 

3.6.8.3 Maximizing and Restoring the Grid
Access the application containing the grid you want to change. 

The Maximize Grid and the Restore Grid icons in the grid enable you to toggle 
between maximized and restored modes of the grid.

Click the Maximize Grid icon, to display only the grid, and to hide all of the other 
fields in the form. 
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Click the Restore Grid icon in the grid to restore the grid as well as all of the other 
fields in the form.

3.6.9 Freezing and Unfreezing Grid Columns
You can freeze grid columns on JD Edwards EnterpriseOne form grids that have a 
horizontal scroll bar. This is helpful when you want to enter data into a selected 
number of columns in an editable grid. Also, this helps you to view and compare the 
data in different columns. 

You can view two areas of a grid by freezing columns in the left side of the grid. 

Only the left side of the grid can be frozen. The columns that are to the right side of the 
frozen grid can be scrolled. You can scroll through all of the rows by using the vertical 
scroll bar. 

The functionalities in Row Selector, Media Object Attachments Column, Row Exit 
context menu and QBE fields are supported in the frozen area. Other functionalities 
such as Resize Column, Reorder Column and so on are not supported in the frozen 
area but are supported in the non-frozen columns. 

Note: The Freeze functionality is available only in the grids that have 
a horizontal scroll bar. 

Hide and Freeze functionalities are not supported for Accessibility 
users. 

You cannot Freeze the right-most part of the grid. If you right-click the right-most 
column's header and select the Freeze option, a pop-up message saying 'Cannot Freeze 
at the right part of the grid' is displayed.

Freeze and unfreeze functionality is supported for both editable and non-editable 
grids. 

3.6.9.1 Non-Editable Grids 
If you select Freeze option in non-editable browse grids when the horizontal scroll bar 
is not set to the left-most position, the columns that are visible to the left side of the 
selected column header, including the selected column, will be frozen. 

As shown in the following example, if you select the Freeze option, the columns from 
Description 1 to Unit Price are frozen. 
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Figure 3–16 Freeze functionality in Non-Editable Grids

The columns before the Description 1 column are frozen and hidden; that is, you 
cannot see or scroll the columns before the Description 1 column as shown in the 
following example. 

Figure 3–17 Freeze functionality in Non-Editable Grids

3.6.9.2 Editable Grids 
In editable grids, you must set the horizontal scroll to the left-most position of the grid 
to use the Freeze functionality. If you right-click the column header and select the 
Freeze option when the horizontal scroll bar is not set to the left-most position, a 
pop-up message saying 'Please set the horizontal scroll bar to the left-most position of 
the edit grid to use Freeze functionality.' is displayed. 

The frozen column in an editable grid acts as an Auto Return column. If you press the 
TAB key when the focus is in the last cell in the frozen column, the focus is set to the 
first editable cell of the next row (instead of setting the focus to the next editable cell in 
the unfrozen column.) 

3.6.9.3 Freezing and UnFreezing Grid Columns 
Access the application containing the grid you want to change. 

1. Right-click the column header of the grid you want to freeze. 



Using the Grid

3-34 JD Edwards EnterpriseOne Tools Foundation Guide

2. Select the Freeze option from the context menu. 

The columns that are visible to the left side of the selected column header, 
including the selected column will be frozen.

A blue vertical line separates the frozen columns on the left side and the other 
columns in the unfrozen area. 

3. To unfreeze the columns, right-click in any column header and select the Unfreeze 
option from the context menu. 

Note: The column header context menu closes automatically if you 
click anywhere else in the form or grid. 

Tutorial: Click here to view a recording of this 
feature.This tutorial shows the pre-9.1.5 user interface.

3.6.10 Rearranging Grid Columns
Access the application containing the grid you want to change.

1. Click the Customize Grid link and either create a new format or select an existing 
one to modify.

2. On Customize Grid, scroll to the Display and Order section.

3. In the Display and Order list, click a column name and use the up and down 
arrows to move it up or down in the list.

The system displays the columns in the list in the order in which they appear from 
top to bottom. In other words, the column at the top of the list appears first on the 
grid, the column second from the top appears second on the grid, and so forth.

4. Repeat step 4 for any other columns that you want to move.

5. When finished, click the OK button, and then click Close.

3.6.11 Setting Grid Color and Font
Access the application containing the grid that you want to change.

1. Click the Customize Grid link and either create a new format or select an existing 
one to modify.

2. On Customize Grid, scroll to the Display and Order section.

3. Click a column name in the Display and Order list.

The column name appears in the Selected Column field.

4. To apply a background color to the column, click a color in the pallet under 
Column Color.

The hexadecimal value for the color that you chose appears in the Column Color 
field.

5. To apply a color to the text in the column, click a color in the pallet under Text 
Color.

The hexadecimal value for the color that you chose appears in the Text Color field.

https://apex.oracle.com/pls/apex/f?p=44785:24:0::::P24_CONTENT_ID,P24_PREV_PAGE:6094,1
https://apex.oracle.com/pls/apex/f?p=44785:24:0::::P24_CONTENT_ID,P24_PREV_PAGE:6094,1
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6. To apply a font style such as bold or italics to the text in the column, click the 
styles that you want to apply in the Text Options list.

7. Click the Update Style button.

The system updates the Selected Column field to show you how your choices will 
look. The system also places a plus sign next to the column name in the Display 
and Order list. This symbol indicates that user-defined formatting will be applied 
to the column.

8. Repeat steps 4-8 to apply formatting to additional columns in the grid.

9. When finished, click the OK button, and then click the Close button.

3.6.12 Changing Grid Column Width
Access the application containing the grid that you want to change.

1. Click the Customize Grid link and either create a new format or select an existing 
one to modify.

2. On Customize Grid, scroll to the Display and Order section.

3. Click a column name in the Display and Order list.

The column name appears in the Selected Column field.

4. Enter a percentage value in the % Column Width field.

This value is the percentage of the space that you want the system to allot to the 
column based on the width defined for the data item on which the column is 
based. You can enter a value between 25 and 400.

5. When finished, click the OK button, and then click the Close button.

3.6.13 Changing the Sort Sequence of a Grid
Access the application containing the grid that you want to change.

1. Click the Customize Grid link and either create a new format or select an existing 
one to modify.

2. On Customize Grid, scroll to the Data Sequencing section.

3. If you want to sort on a column, click the column name in the Available Columns 
list, and then click the right arrow.

The system moves the column name from the Available Columns list to the 
Sequenced Columns list.

A column must be included in the grid-that is, its name must appear in the 
Display and Order list-before you can sort on it.

4. If you do not want to sort on a column, click the column name in the Sequenced 
Columns list, and then click the left arrow.

The system moves the column name from the Sequenced Columns list to the 
Available Columns list.

5. To rearrange the order of sort precedence, use the up and down arrows under the 
Sequenced Columns list to rearrange the column names.

The system first sorts by the column at the top of the list, then by the column 
second from the top, and so forth.
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6. To sort column values in ascending order, click the column name in the Sequenced 
Columns list and select the Ascending check box.

If you leave the Ascending box blank, the system sorts the column in descending 
order.

An A appears next to the column names to be sorted in ascending order, and a D 
appears next to the column names to be sorted in descending order.

7. When finished, click the OK button, and then click the Close button.

3.6.14 Exporting All Records from a Grid
You can export all records from a grid, rather than choosing a range of records to 
export.

1. Launch an application with a detail area, and then click the Find button to load the 
detail area with records.

2. Click the Tools icon, and then click the Export Grid Data menu. You can also click 
the Export Grid Data icon in the grid.

3. On Export Assistant, select one of these options:

– Export To Excel

Note: If you select this option, also select whether you want to 
export to a new workbook or an existing workbook.

– Export To Word

– Export To Comma Separated Values (CSV) File character encoding

4. Select the Export All option.

5. Click Continue.

3.6.15 Exporting Detail Area Content to Microsoft Excel, Word, or to a Comma 
Separated Values File

Access an application with a grid.

1. Launch an application with a grid, and then use Find to load the detail area with 
records.

2. From the Tools menu, click Export Grid Data. You can also click the Export Grid 
Data icon in the grid.

3. On Export Assistant, select one of these options:

– Export to Excel

If you select this option, select if you want to export the data to a new 
workbook, or an existing workbook.

– Export to Word

– Export to Comma Separated Values

4. Select Export All to export all the data in the grid, or clear the Export All check box 
to export a range cells within the grid containing data that you want to export.
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If you clear the Export All check box, then you must select on the grid the range of 
cells you want to export. First, click the cell where you want the range to begin, 
then click the cell where you want the range to end. 

If you click the wrong cell, click Reset Selection.

5. Click Continue.

The system exports the detail area contents that you selected to the appropriate file 
type and displays it.

3.6.16 Importing Data from an External Spreadsheet to a Grid
You can import data from an external spreadsheet into a grid in EnterpriseOne. The 
external grid must be in CSV or Excel format. EnterpriseOne enables you to choose a 
range of data by entering the beginning and ending row and column where the data 
resides in the spreadsheet. 

Access an application with a grid.

1. From the Tools menu, choose Import. 

2. Click the Import from Excel or the Import From Comma Separated Values (CSV) 
option. 

If you choose the CSV option, the Excel file and Worksheet name options are 
hidden.

3. In the Excel file field, enter the location where the external spreadsheet from which 
you want to import data resides. You can also click the Browse button located 
beside the field and navigate to the file.

4. In the Starting Cell fields, in the Col and Row fields, enter the co-ordinates of the 
first cell in the range of cells you want to import from the external file. 

5. In the Ending Cell fields, in the Col and Row fields, enter the co-ordinates of the 
last cell in the range of cells you want to import from the external file. 

6. Click one of the following options:

– Insert (Import new rows at column A, row 0 of the grid): click this option if 
you want to add the rows you identified to the beginning of the grid. This 
option does not overwrite the existing data that resides in the grid; rather, it 
adds the rows to the existing data.

– Paste: click this option if you want to overwrite the existing data that resides 
in the grid. With this option, you can paste the new rows anywhere in the 
existing grid. If you paste a range of data that exceeds the existing range of 
data in the grid, EnterpriseOne appends the new data after the last row of the 
grid data. These new rows are new, not overridden.

If you choose Paste, the Select Paste Location in Grid fields become active. 
Enter the first cell location where you want to paste the data.

You can click Reset to undo your changes and to return the initial data that 
was in the grid when you first entered the Import Assistant. 

7. Click Apply.

Importing and Exporting to the Clipboard
Exporting/importing to the Clipboard is available in ActiveX mode and HTML mode. 
When HTML mode is enabled the following options are removed:



Using the Grid

3-38 JD Edwards EnterpriseOne Tools Foundation Guide

■ Export to Word

■ Import from Excel

The clipboard functionality replaces these options when in HTML mode.

 

To export data to the clipboard:

1. Navigate to the Export Assistant

2. Select Export to Clipboard.

3. Define the cell range in the Export Assistant.

4. Click the Apply button.

5. Press Ctrl+C to copy the data to the clipboard.

To Import Data from the Clipboard:

1. Navigate to the source data.

2. Copy the desired data.

3. Navigate to the Import Assistant from the target application.

4. Select Import From Clipboard.

5. Define an import location.

6. Press Ctrl+V in the Import Assistant to view the data in the preview grid.

7. Click the Continue button to complete the import. 

3.6.17 Customizing the Grid Dynamically
JD Edwards EnterpriseOne enables you to dynamically customize a grid. 
“Dynamically” means that you are able to make changes directly to a grid on which 
you are working. You can change column widths, arrangement. You can save these 
changes and use them in any application where dynamic grid formatting is enabled.

To change column width:

1. Navigate to an application grid that you want to modify.

2. Click the right side of the column and, while holding down the left mouse button, 
drag it to the desired width.

To rearrange columns:

1. Navigate to an application grid that you want to modify.

2. Click the top of the column and, while holding down the left mouse button, drag it 
to the desired location and release the mouse button.

To save the changes you have made to the grid:

1. Navigate to an application grid that you want to modify. 

When you customize a grid, the page refreshes and a Save icon displays in the 
upper-right corner of the grid, beside the grid format name.

2. Click the Save icon on the grid. If prompted, type a name in the field that is 
located beside it.

When you log into the application again, your saved grid format is available.
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3.6.18 Copying and Pasting Grid Data
In JD Edwards EnterpriseOne, you can select a single cell or a range of cells that 
contains grid data to copy and paste into any EnterpriseOne editable grid. An editable 
grid is one in which you can enter or delete data. You can also paste grid data into a 
tab delimited spreadsheet, like Microsoft Excel. You deselect cells by pressing the F5 
button on your keyboard, or by clicking outside of the grid.

The “start cell” is the first grid cell you click to begin selecting a range of cells. The 
“end cell” is the last grid cell you click to end selecting a range of cells. The cells you 
select to copy can be editable or non-editable.

To copy and paste grid data:

Navigate to an application grid that contains the data that you want to copy.

1. Select a range of cells to copy by completing one of the following actions:

■ Click the start cell and, while holding down the left button, drag the mouse to 
the end cell. If the start cell is editable, you cannot use this action to select a 
range of cells. Instead, use the action described below.

■ Click on the start cell and while pressing the Shift key on your keyboard, click 
on the end cell. You can expand the range of cells you have already selected by 
pressing the Shift key and clicking on a different end cell.

As you move your cursor toward the scroll bar, the grid will automatically 
begin scrolling so that you can select a cell outside of those that are currently 
visible on the grid.

■ Click the check box located beside a record. Press the Ctrl+C keys on your 
keyboard.

This option only works if you have not selected a range of cells as described in 
option A or B.

2. Press the Ctrl+C keys on the keyboard.

The grid data that you selected is copied to the EnterpriseOne clipboard, which is 
located at the following location: \WINDOWS\system32\clipbrd.exe

3. Navigate to an editable grid, and place your cursor in an editable cell.

It is important that you notice in which columns you are pasting the grid data. 
EnterpriseOne enables you to paste the grid data in any field on an editable grid, 
regardless of whether or not the columns match up. Therefore, you can paste grid 
date from an Alias Name column into an Address column, and EnterpriseOne will 
not correct the action.

4. Press the Ctrl+V keys on the keyboard.

EnterpriseOne pastes the data into the grid.

3.7 Working with Records
The section provides an overview of records and discusses how to:

■ Locate Records Using Specific Selection Criteria

■ Use the Query-by-Example Line

■ Locate Records Using Wildcard and Operators

■ Work with Search Criteria
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■ Choose a Record

■ Add a Record

■ Change a Record

■ Delete a Record

3.7.1 Understanding Records
Databases store information in units called records. Each record might contain more 
than one item of information. For example, Dominique Abbott is an item of 
information in the EnterpriseOne system. When you access Dominique Abbott from 
the Address Book application, the record that appears might also include Dominique's 
phone number, address, and other pertinent information. The system might save all of 
this information as one record, or it might save some of this information as a primary 
record and other information as secondary records. These types of relationships exist 
throughout the system. Database tables store all system records. Each record must 
have at least one key that links the record to a database table. Keys are unique 
identifiers that distinguish one record from another. For example, Address Book uses 
Address Number as the key to distinguish each record. Therefore, each Address 
Number must be unique. When creating new records, you must enter information into 
a key field. If you do not enter information into a key field, the system displays an 
error message. Once you have entered information into a key field, you cannot edit 
that key field later. To change the key field information, you need to create a new 
record. The Media Objects feature allows you to add notes, graphics, and other objects 
to records.

3.7.2 Locating Records Using Specific Selection Criteria
Selection criteria defines your search by specific types of records. For example, you can 
include information in filter fields such as Name Search and Search Type to search 
only for employees whose names begin with the letter A.

1. On Work With Addresses, complete the Search Type field.

If you do not know the Search Type, use the Search button to view a list of user 
defined codes.

2. Click the Find button.

A list of matching records appears.

3.7.3 Using the Query-by-Example Line
You can use the query-by-example line to search for records by a grid column. For 
example, if you are searching for a person by name, enter all or part of the name in the 
query-by-example line directly above the Alpha Name column in the grid. The 
information that you enter in the query-by-example line must be a valid value for the 
column. If it is not, the system does not find a match. You cannot enter values in the 
disabled (grayed-out) columns because these columns do not allow searches. Some 
query-by-example lines work differently. On some forms in the Tools setup 
applications, tabbing to the end of a line after filling in one or more fields achieves the 
same result as clicking the Find button.

On any Find/Browse form, type the characters on which you want to search in the 
corresponding column of the query-by-example line, and then click Find. For example, 
on Address Book Revisions (P01012), type all or part of the name of the individual you 
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are searching for in the Alpha Name column of the query-by-example line, and then 
click Find. The record that matches the query criteria appears in the grid.

3.7.4 Locating Records Using Wildcards and Operators
You can use the asterisk (*) as a wildcard character in place of one or more letters. 
Using the asterisk widens your search. For example, you can type abb* in the Alpha 
Name column of the query-by-example line to view all records that begin with the 
letters abb. Or you can type *bb* in the query-by-example line to retrieve those records 
that contain the letters bb in the middle of the name. In addition, you can search for 
values in a set using operators. For example, in the Address Number column of the 
query-by-example line, type <87 to specify address numbers that are less than 87. Type 
<b in the Alpha Name column of the query-by-example line to specify names that 
begin with a. The following operators are valid in the query-by-example line:

< Less than

< = Less than or equal to

> Greater than

> = Greater than or equal to

! Not equal to

Each time that you enter values in a search, click the Find button to retrieve matching 
records.

3.7.5 Working with Search Criteria
This section discusses:

■ Understanding the Query control

■ Managing queries

■ Creating queries to search for data

■ Using existing queries to search for data

■ Modifying queries

■ Copying queries

■ Deleting queries

3.7.5.1 Understanding the Query Control
In addition to using QBE and wildcards to search for records, you can define 
additional search criteria by creating a query. The Query control appears on Find 
Browse, Search/Select, and Power Browse forms that have a Find button, unless the 
form appears in a popup window (such as when using the visual assist). Additionally, 
the Query control appears in the Data Browser, which enables you to view the data in 
tables and business views and save the search criteria as a query.

 See Viewing the Data in Tables and Business Views .



Note: The queries created using the Query control are Enhanced 
Queries, which differ from the Saved Queries that users might have 
created in previous releases. You can convert the format of the old 
Saved Queries to Enhanced Queries by using a conversion process.

See “Converting Saved Queries to Enhanced Queries” in the JD 
Edwards EnterpriseOne Tools System Administration Guide 
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The query feature enables you to select additional fields from a form and add 
conditions to narrow the search results. Queries enable you to create searches that are 
more specific than the search results from wildcards and QBE columns alone. The 
system combines the conditions defined in the form filter fields, the QBE line, and the 
query to retrieve records from the database.

Security options are available to prevent users from performing searches if they have 
not entered search criteria in the form filters or QBE columns. If application query 
security has been implemented, you receive an error or warning message that informs 
you that your search has been suppressed.

 See “Managing Application Query Security” in the JD Edwards EnterpriseOne Tools 
Security Administration Guide

You can design and save queries for search criteria that you use often to find records. 
Queries can be designated to run automatically by selecting the “Run query when 
selected” option, which enables the query to search without having to click the Find 
button.

Additionally, you can designate a saved query as the default query for a form. A 
default query with the “Run query when selected” option will run whenever you enter 
the form, as well as any time you select the query from the drop-down query list. If a 
default query has not been defined, the Query field displays “All Records” when the 
form appears.

Note: A default query will not run automatically if values are passed 
into the form by a form interconnection, or if the "Run query when 
selected" option is not selected.

If you want to search for records without using a query, set the Query field to All 
Records.

Any queries that you save are listed alphabetically under the My Queries label in the 
query drop-down list. The My Queries subgroup also includes an All Records 
selection, which enables you to search without queries. Any queries that you save are 
available to you only; no other user can access them unless they are copied and 
designated as public queries. If public queries are available, they are listed 
alphabetically under the Public Query subgroup in the query drop-down list. 

See “Making Private Queries Public” in the JD Edwards EnterpriseOne Tools System 
Administration Guide

3.7.5.2 Managing Queries
You use Query Management mode to create, modify, and save queries. Click the icon 
to the right of the Query field to enter Query Management mode. You can also use the 
Ctrl+E hot key combination to toggle between normal mode and Query Management 
mode. Depending on the value in the Query field when you enter Query Management, 
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the options for a new query or an existing query appear in the Query Management 
side panel. You can change the width of the Query Management side panel, which 
causes a corresponding adjustment in the JD Edwards EnterpriseOne form until the 
minimal width is reached.

When you enter Query Management mode, a plus sign on the form designates each 
field and QBE column that you can select for a query. When you click a field or QBE 
column, the item appears in the Query Management side panel with the appropriate 
comparison selections for the item's data type. Any items that you select display an X 
in the Query Management side panel, which indicates that they have been selected. 
You can remove an item from the Query Management side panel by clicking it.

When you edit the criteria in a query, both the query item and its corresponding field 
or QBE column on the form are highlighted. 

The Populate Query icon enables you to enter values in fields and QBE columns on the 
form, and then click the Populate Query button to automatically create the query for 
you. The system populates the comparison selections for each item according to its 
data type.

The following table describes the fields in the Query Management panel:

Query Management Options

Field Description

Query Select either (add new query) or an existing query from the 
drop-down list. The default value for the Query field is (add new 
query), unless an existing query was selected before entering 
Query Management mode. The (add new query) selection enables 
you to create a new query. Select an existing query to run it or 
modify it. 

Set As Default Select this option to designate a query as the default. Only one 
query can be the default query for a form. The default query is 
used whenever the form opens, until the user selects another query 
or the All Records selection.

Run query when selected By selecting this option, you do not have to click the Find button to 
run the query. The query will run automatically whenever you 
select it. If you select this option for a default query, the query will 
run automatically when the form opens, unless it opens in a 
pop-up window (such as when using the visual assist) or when 
values are passed into the form by a form interconnection.

Match All Select this option if you want the query results to include all of the 
criteria specified in the query.

Match Any Select this option if you want the query results to include any (not 
all) of the criteria specified in the query.

Fields and QBE Columns Form fields and QBE columns that display a plus sign can be 
included in a query. Click the plus sign of the field or QBE column 
to include it in a query.

Comparison List When you select a field or QBE column to include in a query, fields 
display to the right of the item in the Query Management side 
panel that enable you to customize the search criteria for the item. 
The comparison types that display for each data item (such as 
equal, not equal, starts with, between, is blank, etc.) depend on the 
data type. 
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Comparison Types
The following table describes the comparison types that are supported for each data 
type when it is included in the search criteria.

Data /Type Example Comparison Types

String Order Type (DCTO) Equal, not equal, starts with, ends with, 
contains, between, in list, is blank, is not 
blank 

Character Type Code (TYC) =, !=, <, <=, >, >=, between, in list

Numeric Address Number (AN8) =, !=, <, <=, >, >=, between, in list

Date Order Date (TRDJ) =, !=, <, <=, >, >=, between, in list

JDEUtime Start UTime (TASUTIME) =, !=, <, <=, >, >=, between, in list

The “in list” comparison type enables you to create a list of values for a data item. 
When you select “in list” from the comparison drop-down list, the Add More Value 
icon appears. Click the icon to display another field in which to enter the next value. 
To remove a value from the list, delete the value in the value field. The field is 
removed unless it is the only value field in the list.

Special Values
Fields or QBE columns that are based on string or date data types enable you to 
specify additional search criteria by using the Set Special Value option. Click the down 
arrow to the right of the value field to display the Set Special Value pop-up window. 
The Set Special Value window provides additional search options for the field or QBE 
column. For example, you could specify search criteria for orders that are due 5 days 
from the current date.

To set special values, make the appropriate selections in the Set Special Value window 
and then click OK. To clear special values, click the Reset button. The following table 
describes the special value options that are available for each data type.

Data /Type Special Value Options Description

String Login User ID  Some forms enable you to customize a 
query to return records with data related 
only to the user ID of the person who is 
logged in.

Date Today + or Today -

Value

Days, Months, or Years

Use special values to search for dates that 
are a specified number of days, months or 
years before or after the current date.

In the Set Special Value pop-up window, 
select + or -, enter a number, and then 
select days, months, or years from the 
drop-down list.

Set Special Value Some conditions enable you to set a value for comparison. For 
example, if you select a date field and the "between" comparison 
type, the Set Special Value option enables you to specify the dates 
to be compared.

Field Description
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3.7.5.3 Creating Queries to Search for Data
Access a form with the Query control.

1. To create a new query, select All Records from the Query drop-down list if it does 
not appear as the query selection.

2. Click the Query Management icon.

3. In the Query Management side panel, verify that (add new query) is the value in 
the Query field. If another value appears, select (add new query) from the 
drop-down list.

4. If you want the new query to be the default query for the form, click the Set As 
Default option.

5. If you want the query to run automatically whenever it is selected, click the “Run 
query when selected” option.

6. Select either the Match Any or Match All option.

7. Click the form fields or QBE columns that you want use as search criteria.

Note: You can select only the form fields and QBE columns that have 
a plus sign.

8. Select a comparison type for each field or QBE column.

9. Specify the comparison value for each field or QBE column in the query.

Note: The system displays an error if the value entered is not valid. 
Close the error dialog box and enter a valid value.

10. For date or string data items, enter a value for comparison or select the down 
arrow to specify  values in the Set Special Value pop-up window.

11. Click the Find button in the Query Management side panel or on the form to run 
the query.

12. If you want to save the query, click the Save Query icon in the Query Management 
side panel.

13. Enter a name for the query.

The new query name appears in the Query field.

14. Close the Query Management panel.

The new query name appears in the Query field on the form. To find records 
without using a query, you must reset the Query field to All Records.

3.7.5.4 Using Existing Queries to Search for Data
Access a form with the Query control.

1. From the Query drop-down list, select the query that contains the search criteria 
that you want to apply.

2. Click the Find button to display the search results.

If the query includes the “Run query when selected” option, the Find happens as 
soon as the query is selected.
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3.7.5.5 Modifying Queries
Access a form with the Query control.

1. From the Query field, select the query that you want to edit.

2. Click the Query Management icon to display the search criteria.

3. Edit the information.

You can change the query options and change search values.  You can add or 
remove fields and QBE columns from the query.

4. Click the Save Query icon to save the changes.

Note: You can click the Save As icon if you want to save the edited 
query with a different name.

5. Close the Query Management side panel.

The new query name appears in the Query field on the form. To find records 
without using a query, you must reset the Query field to All Records.

3.7.5.6 Copying Queries
Access a form with the Query control.

1. From the Query field, select the query that you want to copy.

2. Click the Query Management icon to display the search criteria.

3. If desired, change the search criteria.

4. In the Query Management side panel, click the Save As icon.

5. Enter a name for the query.

The new query name appears in the Query field.

6. Close the Query Management side panel.

The new query name appears in the Query field on the form. To find records 
without using a query, you must reset the Query field to All Records.

3.7.5.7 Deleting Queries
Access a form with the Query control.

1. From the Query field, select the query that you want to delete.

Note: You cannot delete Public queries.

2. Click the Query Management icon.

3. In the Query Management side panel, click the Delete Query icon.

The message “Are you sure you want to delete this query?” appears.

4. Click OK to delete the query.

The Query field changes to (add new query).

5. Close the Query Management side panel.
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3.7.5.8 Selecting Additional Fields
See 3.7.5.3 Creating Queries to Search for Data in the JD Edwards EnterpriseOne Tools 
Foundation Guide.

You can select a comparison type in the Query Management panel for each field or 
query-by-example (QBE) column and specify the comparison value in the query. To do 
so, click the form fields or QBE columns that you want use as search criteria. You can 
select only the form fields and QBE columns that have a plus sign.

Alternatively, you can use the Additional Fields Selection section to select the form 
fields or QBE columns. This section displays only the business view (BSVW) columns 
that are included on the form including the hidden columns. For example, if BSVW 
includes the columns A, B and C; A is displayed on the form, B is hidden and C is not 
included, then the Additional Fields Selection section displays A and B columns.

3.7.5.9 Clearing the Form
You can clear the values that you have entered on the form. For example, the values 
entered in the header or QBE column. 

To clear the values on the form: 

1. Access a form with the Query control.

2. Enter any search criteria on the header or the QBE and then, click Find. 

3. Click the Clear Form icon located to the right of the Add, Edit Queries icon. The 
system deletes the values in the header or the QBE.

Alternatively, you can select Clear form when selected option in the Query 
Management panel to clear the values on the form automatically when the query is 
selected.

3.7.6 Choosing a Record
You choose a record for a variety of reasons. For example, you might need to change 
an employee's address and phone number. You can choose a single record or multiple 
records from the Find/Browse form, and then you can change the information on a 
Revision form.

You can choose a record in one of two ways:

■ Click the record and then click the Select button to open the corresponding form.

■ Double-click a record to select it and open the corresponding form.

To choose a record:

1. On any Find/Browse form, locate a record.

2. Double-click the record to display it on a revision form.

3. On the revisions form, revise the record and then click OK.

If you selected more than one record, your second record might appear now. If 
your second record does not appear, click the Next button at the top of the form. 
Continue to revise as needed.

4. After you finish, be sure to click OK to save your latest revision and then click 
Cancel to exit.
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3.7.7 Adding a Record
When adding records to the database, you add the primary record first and then add 
the secondary records. 

To add a record:

1. On a Find/Browse form, click Add to open a blank revision form.

2. Enter the information for the new record.

Note: Some fields enable you to enter any value, and some require 
you to select from a list of values. A user defined code (UDC) is one 
value in a set of values that is assigned as valid for a field. UDCs 
simplify, standardize, and validate the data that is contained in fields.

See “Working with User Defined Codes” in the JD Edwards 
EnterpriseOne Tools System Administration Guide.

3. Click OK.

When you add records, the system uses the Next Numbers feature to 
automatically number Address Book records, journal entries, purchase orders, and 
other documents.

3.7.8 Changing a Record
In EnterpriseOne, a Find/Browse form appears when you open most applications. On 
the Find/Browse form, you choose the action that you want to perform. Choosing a 
button or function that you want to perform displays, for example, a Fix/Inspect form 
on which you can change your record. 

As you move from field to field, you view your changes reflected in the form. If you 
type an invalid value in a field, the field highlights in red and an error appears. You 
must correct the error before you click OK. Clicking OK saves your changes in the 
database.

Note: Some fields enable you to enter any value, and some require 
you to select from a list of values. A user defined code (UDC) is one 
value in a set of values that is assigned as valid for a field. UDCs 
simplify, standardize, and validate the data that is contained in fields.

See “Working with User Defined Codes” in the JD Edwards 
EnterpriseOne Tools System Administration Guide.

You cannot change information on the Find/Browse form itself. The information you 
have changed appears after you choose the appropriate button on the Find/Browse 
form.

To change a record:

1. On a Find/Browse form, select a record.

You can double-click a record, or choose a record and then click the Select button.

2. On the revisions form, revise information as needed.

3. Click OK to accept the revisions.
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3.7.9 Deleting a Record
Occasionally, you might need to remove a record from your database. For example, 
you might no longer use a particular supplier. Depending upon the application, if you 
delete a primary record the system might also delete any secondary records related to 
the primary record, such as phone numbers. See the appropriate application guide for 
information about deleting child records.

To delete a record:

1. On a Find/Browse form, select one or more records.

2. Click Delete.

The system prompts you to confirm the deletion.

3.8 Working with Toolbar Options
This section provides an overview of toolbar options and discusses how to:

■ Work with Row and Form Exits

■ Set Up Favorite Row and Form Menu Selections

3.8.1 Understanding Toolbar Options
Most JD Edwards EnterpriseOne forms include a toolbar with buttons that provide 
access to specific tasks. You must be familiar with toolbar options to use the JD 
Edwards EnterpriseOne system. Toolbar options vary depending on form type. For 
example, a Find/Browse form usually includes a Select button so that you can select a 
record in the grid, whereas a Fix/Inspect form does not have a Select button because it 
displays the values for a specific record.

The following table describes many of the standard toolbar buttons:

Toolbar Button Description

Find The Find button displays records in a grid.

Select The Select button selects one or more records and opens 
corresponding forms.

Search The Search button displays all the entries from your 
database that match the search criteria that you specify.

Add The Add button opens a new form where you can add 
a new record.

OK When you click the OK button, record additions and 
updates are written to the database. 

Copy From a Find/Browse form, the Copy button copies the 
entire record. The system copies all fields into a new 
record, except those fields that are unique to the 
existing record.

From a Fix/Inspect form, the Copy button selects the 
fields for the new form. You must enter data in all other 
fields. You can modify on the new form those fields that 
you copied from the existing record.
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In addition to standard buttons, the toolbar can include other options such as reports 
(which provides a list of reports pertaining to the application), row exits, and form 
exits.

3.8.2 Working with Row and Form Exits (9.1 Update 5)
There are two types of Row and Form Exits: Standard and Simplified.

Standard Row and Form exits display as buttons on the toolbar. When you click the 
Form or Row button on the toolbar, a list appears with options relating to the active 
form. The functions on the form and row exits vary from form to form. For example, a 
form or row exit might open a data entry form or provide access to other forms that 
relate to the record you selected.

You can also use row exit and form exit right-click options to access the selections on 
the row and form toolbar menus. When you right-click a cell in the grid, the grid row 
is selected and the row menu selections display in a context menu. Using this feature, 
you do not need to click the Row button at the top of the form. This feature has been 
enabled for Find/Browse, Search & Select, Parent/Child, Headerless Detail, Header 
Detail, Power Browse, Power Edit, and Subform forms.

The following example shows the context menu that displays on the Customer Service 
Inquiry form after right-clicking a cell in the grid:

Delete From a Find/Browse or Fix/Inspect form, the Delete 
button deletes the entire record.

Depending on the application that you are using, the 
Delete button might also remove related information. 
For example, if you delete an Address Book record, the 
system also deletes the phone numbers for that record. 
See your application user guide for information about 
deleting child records.

Close The Close button closes the form.

Cancel When you click the Cancel button, any changes you 
have made are lost and no database changes are made.

Tools The Tools button can include options such as Refresh, 
Export Grid Data, or Data Browser.

Collaborate The Collaborate submenu under the Tools menu has 
the following options:

■ Send Email

■ Send Meeting Invite

■ Send Shortcut

■ Parameterized URL 

Toolbar Button Description
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Figure 3–18 Row Exit Context Menu

Note: If the JD Edwards EnterpriseOne form does not have any Row 
menu selections available, the default browser's context menu appears 
and the grid row is not selected.

Similarly, when you right-click in the form outside the grid, the form menu selections 
display. The form menu selections are not accessed from a row. Any disabled menu 
selections in the form and row menus do not display in the context menu list.

 The following example shows the form menu selections on the Customer Service 
Inquiry form:

Figure 3–19 Form Exit Context Menu

Note: To hide the form exit context menu, you can click anywhere in 
the form header. To hide the row exit pop-up menu, click anywhere in 
the grid unless the grid is editable. In the case of editable grids, you 
must click on the form header or below the grid area to hide the 
pop-up menu.



Tutorial: Click here to view a recording of this 
feature.This tutorial shows the pre-9.1.5 user interface.
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 Simplified Form and Row exits display as tabs on the side of the screen. If your 
system administrator has enabled you to do so, you can choose if your EnterpriseOne 
interface displays Simplified or Standard mode.You can drag and drop Simplified tabs 
vertically. In Simplified mode, you will see only the tabs. In Standard mode, you can 
choose the type of Row and Form exits you see. The following graphic displays the 
Simplified tabs: 

Figure 3–20 Simplified Form and Row Exit tabs

3.8.2.1 Choosing Standard or Simplified Form and Row Exits
To choose Standard or Simplified Row and Form exits:

1. Ensure that you have permissions to change the Standard or Simplified mode by 
clicking Personalization, My System Options, and then User Profile Revisions. 

2. Select the Enable Simplified Row/Form Exits option to view the Simplified Row 
and Form exit tabs. Deselect the option to view the Standard Row and Form exit 
buttons.Click the Personalization menu, and then click Preferences.

https://apex.oracle.com/pls/apex/f?p=44785:24:34149069851427::NO::P24_CONTENT_ID,P24_PREV_PAGE:6095,2
https://apex.oracle.com/pls/apex/f?p=44785:24:34149069851427::NO::P24_CONTENT_ID,P24_PREV_PAGE:6095,2
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3. Log out and then log in to EnterpriseOne to see your changes.

3.8.2.2 Accessing Row Menu Selections
To access row menu selections:

1. On a form with a Row button on the toolbar, click the Row button.

The row menu selections display in a drop-down list.

2. Click the desired menu selection.

3. Alternatively, click a cell in the grid to display the row menu selections in a context 
menu.

3.8.2.3 Accessing Form Menu Selections
To access form menu selections:

1. On a form with a Form button on the toolbar, click the Form button.

The form menu selections display in a drop-down list.

2. Click the desired menu selection.

3. Alternatively, right-click anywhere in the form (except the grid) to display the 
form menu selections in a context menu.

3.8.3 Setting Up Favorite Row and Form Menu Selections 
To add favorites to a form or row pop-up menu:

1. On a form with a Row button on the toolbar, right-click a cell in the grid to display 
the row context menu.

2. If the form has a Form button on the toolbar, right-click the form to display the 
form context menu.

3. Click a selection in the Form or Row portion of the context menu and drag it to the 
Favorites section.

Note: If there are no menu items in the Favorites section, drag and 
drop the menu selection onto the Favorites label to add the menu item 
to the Favorites menu.

4. If necessary, drag and drop the Favorites selections to reorder them.

5. To remove a selection from Favorites, drag it to the Row or Form section of the 
context menu.

3.9 Using Parameterized URL
The Simplified Parameterized URL is a feature that enables an external system to 
launch a native JD Edwards EnterpriseOne application through the use of a simple 
URL. This feature provides external applications the ability to have a nearly seamless 
user interface integration with any available JD Edwards EnterpriseOne application.

When you select Parameterized URL from the Tools menu on a form, a Java Script 
Alert message shows the parameterized URL for that application. You can copy and 
paste the URL into a new browser page to launch the application.



Note: If you are using Microsoft Internet Explorer, you must select 
the parameterized URL and use the keyboard shortcut Ctrl+C to copy 
it. If you are using the Mozilla Firefox browser, select the 
parameterized URL by using the Right -click and copy option in the 
Alert window to copy it.
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Considerations for Query Control (Release 9.1 Update 2)
If you use the Query control (for advanced queries) to create and save search criteria 
on a form, and your system administrator has made the queries public, then the query 
information is available when someone uses a parameterized URL to launch the 
application. If multiple public queries have been created, they are available when 
using the parameterized URL.

Your system administrator must make the query available to other users. After doing 
so, a public version of the query displays beneath a line in the Query drop-down 
menu. 

Queries located above the line are queries available only to the user who created them. 
If user A sent a parameterized URL to user B, then user B would be unable to access 
the query information for the query when using the parameterized URL. Additionally, 
user B would receive the following error message:

Requested Query Wasn’t Found

If you receive this error, contact your system administrator.

Queries located below the line are the queries that have been made public. Therefore, 
when user A sends a parameterized URL to user B, and user B uses it to log into 
EnterpriseOne, the query information is available.

If you are a system administrator, see the “Changing an Individual User Override to a 
Group User Override” section in the The JD Edwards EnterpriseOne Tools System 
Administration Guide for more information.

 

For more information on query control, see Chapter 3.7.5, "Working with Search 
Criteria" in the Foundation Guide.

3.10 Working with Interface Features
The section provides an overview of interface features and discusses how to:

■ Use Online Documentation.

■ Work with Error Messages and Error Dialog Boxes.

■ Turn Auto Populate On or Off.

3.10.1 Understanding Interface Features
EnterpriseOne contains features that you use to globally impact the EnterpriseOne 
web client interface. 

3.10.1.1 Error Messages and Error Dialog Boxes
When you enter information into a field that is inaccurate or unrecognizable by JD 
Edwards EnterpriseOne, or if you fail to enter data into a required field, the field 
displays a red background to indicate the error, and an error message displays at the 
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top of the form. If there are multiple errors on one form, they display as a list at the top 
of the form. You can view more information about the error by clicking the arrow 
located to the left of the error message. If the error message has a Go To Error link to 
the right of it, you can click the link and JD Edwards EnterpriseOne places your cursor 
in the field that correlates to the error message.

When you place your cursor in a field that contains an error, a dialog box displays that 
further identifies what you must enter into the field to correct the error. You can move 
the dialog box by clicking the top of it and dragging it to another location on the 
screen. You can tab out of the field to validate the information. After the information is 
validated, the error message is removed from the list. To view all the errors on the 
form listed at the top of the form, click Go to Top. To disable the pop-up dialog box, 
clear the Enable Error Pop-Ups check box at the top of the form. 

3.10.1.2 Auto Populate On
AutoPopulate assists you when you are performing repetitive data entry on the grid 
control. It uses content that already exists in the grid column to populate the cell in 
which you are currently typing. If the characters you are typing match those that 
already exist in the same column, AutoPopulate automatically adds the whole string 
of characters from the existing cell to the current cell. For example, you have already 
entered the following number into a cell in the column in which you are currently 
typing: 330456 If you type a 3 in the current cell, AutoPopulate will automatically 
place 330456 in the cell in which you are working. You can opt to accept the number by 
pressing tab, or you can delete the number and enter one of your own. You can turn 
AutoPopulate on or off. The action you select will apply to all applications to which 
you have access within JD Edwards EnterpriseOne. 

The feature is disabled for simplified Chinese, Korean, Japanese, and traditional 
Chinese language environments.

3.10.1.3 Visual Assist Form
When you click on the Visual Assist icon, the Visual Assist form is displayed as a 
modal window along with the parent form. The parent form is displayed in read-only 
mode.

Note: You can drag the Visual Assist form and place it anywhere on 
the parent form.

3.10.1.4 Auto Suggest
Auto Suggest is a user interface feature which progressively searches and filters 
through text. Auto Suggest searches pre-defined tables and returns records that match 
text you type into a field. As you type text into a text field, one or more possible 
matches for the text are found and immediately presented to you in the grid around 
the field. This immediate feedback enables you to stop typing the entire word or 
phrase for which you are looking. Instead, you can choose a record from the list that 
appears. 

Auto Suggest searches for data in multiple tables and returns 10 matching records per 
page. The feature does not require you to remember the code or number for the field. 
Instead, you can type the name or description of the field and the system will search 
the name or description that begins with what you typed. For example, if you type in 
“Bi” in the item number field, the system may return “Bike”, “Bike-Mountain” and 
other items whose name starts with “Bi”. Once the list of suggested values is 
displayed, you can use arrow keys or the mouse to navigate to the correct record, then 
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press the Enter key or click on the record to select the record. When a record is 
selected, the code or item number value (for example, 220) is automatically filled into 
the item number field. The system automatically queries the database based on the 
description you typed, and fills in the field value with the proper code or value. 

Note: Auto Suggest is case sensitive. If the item descriptions stored 
in the database are all lowercase, typing “Bi” may not return any 
suggested values because the first letter typed is uppercase.

Your system administrator determines which fields have Auto Suggest enabled, and 
determines the circumstances for which it is activated. For example, Auto Suggest 
might begin searching after you type two characters into a field or after you pause 
typing for a number of seconds. 

Your system administrator can configure the Auto Suggest feature in the following 
two ways:

1. Automatic 

The system administrator specifies the minimum number of characters you need 
to enter, and also specifies that a manual hot key is not required to trigger Auto 
Suggest. When you type into these fields, you will notice a gray down arrow at the 
bottom right corner of the field. After you type the minimum required number of 
characters, the gray down arrow turns blue, and the suggested values display 
automatically. If the down arrow turns blue but no values are displayed, there are 
no matching records in the system. You need to change or re-type the name or 
description.

2. Manual

The system administrator specifies that you have to manually trigger the Auto 
Suggest process (hot key required). The system administrator also specifies the 
minimum number of characters that you need to enter, before the manual Auto 
Suggest feature is triggered. When you type into these fields, you will notice a 
gray down arrow at the bottom right corner of the field. After you type the 
minimum required number of characters, the gray down arrow becomes a 
clickable blue arrow. Clicking the blue arrow triggers the system's Auto Suggest 
process. The system then starts searching for items based on what you typed. The 
Auto Suggest feature is not triggered automatically. You need to click on the blue 
down arrow to trigger it.

See “Setting Up Auto Suggest” in the JD Edwards EnterpriseOne Tools System 
Administration Guide. 

If Auto Suggest is enabled, you do not need to remember codes in order to search for, 
or enter, data in a field.

If Auto Suggest is enabled, you see a grey color arrow icon in the lower corner of the 
text field, QBE field, or the grid cell when you click into it. The grey arrow turns into 
blue arrow when you start typing in the text box. Type in one or two characters and 
click the blue color arrow icon to display the list of Auto Suggested options.

3.10.1.4.1 Enabling or Disabling Auto Suggest for a Single Form  To enable or disable the 
Auto Suggest feature for a single form, Select Tools menu and select or deselect the 
Auto Suggest option. 

3.10.1.4.2 Enabling or Disabling Auto Suggest Globally  You can select or deselect the auto 
suggest feature globally by selecting the Preferences option from the Personalization 
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drop-down menu. Select or deselect the Auto Suggest Enabled check box from the 
Preferences window to enable or disable the Auto Suggest feature across all forms.

3.10.1.5 UDC Drop-down Menu (Release 9.1 Update 3)
UDC Drop-down is a user interface feature that enables the users to select text on 
fields.

If the drop-down is enabled for a UDC field, you see a Drop-down icon instead of 
Visual Assist and Auto Suggest icons. When you click on the Drop-down icon, a 
window with a list of values is displayed from which you can select the required 
value. You can click on the Next button at the bottom of the window to navigate to the 
next set of records. This drop-down window does not contain a column header.

Figure 3–21 UDC Drop-down Menu

Also, if the drop-down menu is enabled for a UDC, you can progressively search and 
filter through text. You can type in a letter, number or any wildcard entry. The system 
searches the pre-defined tables and returns records that match the text you typed into 
a field. As you type text into a UDC Drop-down enabled field, one or more possible 
matches for the text are found and immediately presented to you in the grid around 
the field.

There is a Search link at the lower right corner of the window. You can click this link to 
open a visual assist window for more advanced search capabilities.

See   Setting Up UDC Dropdown Menu in the JD Edwards EnterpriseOne Tools System 
Administration Guide

3.10.2 Using Online Documentation
You access field-level help by placing the cursor in a field and pressing F1. You can 
also access the field-level help by clicking the Help icon located at the top-right corner 
of a form and then clicking the Item Help option. If the field in which the cursor 
resides is a business view column, the system displays the alias name, business view 
name and description, table name and description, and glossary text. If the field in 
which your cursor resides is a data dictionary column, the system displays the alias 
name, the term Data Dictionary Item, and the glossary text.

You can access the online documentation by the following two ways:

■ Click the Help icon located at the top-right corner of a form and then click the 
Help option.
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■ Click the Down Arrow icon located next to your login name and then click the 
Help option.

Note for Release 9.1 Update 4: ■If you are using an application with 
a product code equal to H20, H79, 98, or beginning with H9:

When you click the Help icon, EnterpriseOne searches the 
EnterpriseOne Tools Documentation Library for topics with 
program IDs that correspond to the application you are using. For 
example, if you are using Vocabulary Overrides, and click the 
Help icon, EnterpriseOne searches for all the documentation 
topics that pertain to P9220 (Vocabulary Overrides Program ID).

■ If you are using an application without one of the above product 
codes:

When you click the Help icon, EnterpriseOne searches the 
EnterpriseOne Applications Documentation Library for topics 
with program IDs that correspond to the application you are 
using. For example, if you are using Address Book, and click the 
Help icon, EnterpriseOne searches for all the documentation 
topics that pertain to P01012 (Address Book Program ID).

■ If you click the Help icon outside of an application, you are taken 
to a list of links to JD Edwards EnterpriseOne libraries.

If you are unable to access the online documentation library, contact your system 
administrator. 

Tutorial: Click here to view a recording of this 
feature.This tutorial shows the pre-9.1.5 user interface.

For information about how to set up online documentation, see  
“Setting Up Help” in the JD Edwards EnterpriseOne System Administration Guide.

3.10.3 Working with Error Messages and Error Dialog Boxes
To view error messages and correct errors:

1. On the application on which you are working, if there are red fields indicating 
errors, scroll to the top of the form and review the error messages that are 
displayed. 

2. If the error messages you are viewing contains a Go to Error link, click the link to 
go to the field that correlates to the error message. 

3. Enter valid information into the field.

4. Tab out of the field, to ensure that the information you entered is correct or 
recognizable. If it is, the dialog box disappears, the field displays a white 
background, and the error message is removed from the list. 

Tutorial: Click here to view a recording of this 
feature.This tutorial shows the pre-9.1.5 user interface.
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3.10.4 Turning Auto Populate On or Off
To turn Auto Populate On or Off, from the Tools menu, click AutoPopulate. If a check 
mark appears beside AutoPopulate, the feature is turned on. If no check mark appears, 
it is turned off.

3.11 Working with Send Email and Meeting Invite Options (Release 9.1 
Update 5)

This section provides an overview of the Send Email and Meeting Invite options, and 
discusses how to:

■ Access Send Email and Meeting Invite options from the Tools menu.

■ Access Send Email and Meeting Invite options from the Data Dictionary items.

3.11.1 Understanding Send Email and Meeting Invite Options 
JD Edwards EnterpriseOne enables users to collaborate with other users by using the 
Send Email and Send Meeting Invite options.

All JD Edwards EnterpriseOne forms except the message forms include a toolbar with 
the Collaborate submenu in the Tools menu. You can use the Collaborate submenu to 
access Send Email and Send Meeting Invite options.

Also, you can send emails and meeting invites to the required recipients using the 
Send Email and Meeting Invite options from the Collaborate tab of the hover forms in 
the Address Book fields.

Note: You can use this feature with Outlook, Thunderbird, and 
Gmail as your default email clients, and, with Outlook and 
Thunderbird as your default calendar clients. You can check or 
uncheck the Use Thunderbird As Calendar Client option in the 
Preferences window from the Personalization drop-down menu to 
enable or disable Thunderbird as your default calendar client.

3.11.2 Accessing Send Email and Send Meeting Invite options from Tools menu
This section discusses how to access Send Email and Send Meeting Invite options from 
the Tools menu. 

Note: The Tools menu is not supported on the embedded form and 
hence, the Send Email and Meeting Invite options are also not 
supported on the embedded forms.

3.11.2.1 Accessing Send Email Option from Tools menu
To access the Send Email option from the Tools menu: 

1. On the form with which you are working, select the Tools menu.

2. Click Collaborate.
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Figure 3–22 Collaborate Menu

3. Select the Send Email option.

4. The system displays the Message window of the default email client. 

The subject of the email contains the title of the form. The body of the email 
contains the title of the form and the parameterized URL of the form. You can 
view the form or application by clicking the parameterized URL, and then 
entering your user ID and password.

5. Enter the recipient's email address in the empty Email Recipient field. 

6. Click Send.

3.11.2.2 Accessing Send Meeting Invite Option from Tools menu 
To access the Send Meeting Invite option from the Tools menu: 

1. On the form with which you are working, select the Tools menu.

2. Click Collaborate.

3. Select the Send Meeting Invite option.

4. The File Download window of the browser appears with an option to open or save 
the .ics (calendar file) file. 

Note: For Outlook, you can choose an option to open or save the .ics 
file. 

For Thunderbird, save the .ics file to a desired location; then, open 
Thunderbird, access the Events and Tasks tab, click Import, and 
navigate to the location where you saved the .ics file. Select the .ics file 
and click Open. The meeting will be added to the Thunderbird 
calendar, and also in the Events and Tasks window.

5. Click Open. 



Note: You can also save the file in a desired location and open it 
later.
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6. The system displays the Appointment window of the default calendar. The subject 
of the meeting invite contains the title of the form. The body of the meeting invite 
contains the title of the form and the parameterized URL of the form. You can 
view the form or application by clicking the parameterized URL, and then 
entering your user ID and password.

7. Schedule a meeting time and add the meeting recipients as required.

8. Click Send.

The meeting will be added in the calendar of your default email client. 

The Send Meeting Invite creates the meeting request by default using the current 
time on the machine from where the E1 HTML server is running. It does not use 
the time on the machine from where the browser with the E1 web client is 
accessed. You can open your default email/calendar client and edit the time of the 
meeting request.

3.11.3 Accessing Send Email and Meeting Invite options from Data Dictionary items
Hover forms contain context-based information. The hover form is displayed when 
you click the hover indicator in the hover-supported JD Edwards EnterpriseOne 
control.

See Section 3.1.6.1, "Message Form as Hover Form"

You can use the Collaborate tab in the hover form to send emails and meeting invites 
to the required recipients. Your system administration can enable the Collaborate tab 
in the following hover forms:
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Figure 3–23 Collaborate Tab

■ Employee Information hover form (P080100)

■ Address book Information hover form (P01700)

■ Customer Information hover form (P03B700)

■ Supplier Information hover form (P04700)

The Collaborate tab in the hover form is enabled by default for the Address Number 
(AN8) type hover forms listed above. You can disable this tab using Work with Feature 
Definitions (P958973) application. 

See Enabling and Disabling Collaborate tab in the Hover Forms in System 
Administration Guide.

3.11.3.1  Accessing Send Email Option 
To access the Send Email option: 

1. Enter a valid Address Book Number in the Address Book field.

2. Hover over the orange dot indicator in the Address Book field. The orange dot 
indicator will turn into a clickable indicator.

3. Click the clickable indicator. The hover form is displayed.

4. Click the Collaborate tab. The Collaborate tab displays a list of email IDs 
associated with the Address Book number. The list of email IDs that appears in the 
Collaborate tab is configured for a particular address number in the Who's Who 
application. If an email ID is not configured for a particular address number, the 
Collaborate tab is empty and the Send Email and Send Meeting invite buttons are 
disabled. If you are using the Chrome browser, the hover form may close when 
you click the disabled Send Email or Send Meeting buttons.
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5. In the Collaborate tab, select the email ID as required. You can select multiple 
email IDs. A maximum of five email IDs are displayed per page in the Collaborate 
tab. You can use the Next and Previous links in the Collaborate tab to navigate 
across the email IDs.

6. Click the Send Email button. 

Note: The Send Email and Send Meeting Invite buttons are disabled 
by default. The buttons are enabled after you select an email ID.

7. The Message window of the default email client is displayed. 

The subject of the email contains the title of the form. The body of the email 
contains the title of the form and the parameterized URL of the form in the case of 
Employee and Address Book hover forms. You can view the form or application 
by clicking the parameterized URL, and then entering your user ID and password. 

The body of the email is empty in the case of Customer and Supplier hover forms.

8. The recipient email address is populated based on your selection.

9. Click Send.

3.11.3.2 Accessing Send Meeting Invite Option
To access the Send Meeting Invite option: 

1. Hover over the orange dot indicator in the address book field. The orange dot 
indicator will turn into a clickable indicator.

2. Click the clickable indicator. The hover form is displayed.

3. Click the Collaborate tab. The Collaborate tab displays a list of email IDs 
associated with the Address Book number. 

The list of email IDs that appears in the Collaborate tab is configured for a 
particular address number in the Who's Who application. If an email ID is not 
configured for a particular address number, the Collaborate tab is empty and the 
Send Email and Send Meeting invite buttons are disabled.

4. In the Collaborate tab, select the email ID as required. You can select multiple 
email IDs. You can use the Next and Previous links in the Collaborate tab to 
navigate across the contacts.

5. Click the Send Meeting button.

6. The File Download window of the default browser is displayed with an option to 
open or save the .ics file.

7. Click Open. 

Note: You can also save the file in a desired location and open it 
later. 

8. The Appointment window of the default calendar client is displayed.

The subject of the meeting invite contains the title of the form. The body of the 
meeting invite contains the title of the form and the parameterized URL of the 
form in the case of Employee Information and Address Book Information hover 



Working with Send Email and Meeting Invite Options (Release 9.1 Update 5)

3-64 JD Edwards EnterpriseOne Tools Foundation Guide

forms. You can view the form or application by clicking the parameterized URL, 
and then entering your user ID and password.

The body of the meeting invite is empty in the case of Customer Information and 
Supplier Information hover forms.

Note: For Outlook, you can choose an option to open or save the .ics 
file. 

For Thunderbird, save the .ics file to a desired location; then, open 
Thunderbird, access the Events and Tasks tab, click Import, and 
navigate to the location where you saved the .ics file. Select the .ics file 
and click Open. The meeting will be added to the Thunderbird 
calendar and also in the Events and Tasks window.

The Send Meeting Invite creates the meeting request by default using 
the current time on the machine from where the E1 HTML server is 
running. It does not use the time on the machine from where the 
browser with the E1 web client is accessed. You can open your default 
email/calendar client and edit the time of the meeting request.

9. The recipient address will be populated based on your selection.

10. Click Send.

If the hover form contains lot of information, for example, if the email address is very 
long then the browser inserts the scroll bar. It is recommended to have concise 
information on the hover forms since the hover forms are intended to provide a small 
snapshot of the data. 

If the parameterized URL is very long, the email clients such as Thunderbird and 
Gmail will not render the complete URL as a hyperlink.

In that case, you have to manually copy the entire link and paste it into the address bar 
of your browser to access the E1 application. This does not happen if you are using 
Microsoft Outlook as your default email client.

3.11.4 INI Settings
This section discusses the server manager settings for Send Email and Send Meeting 
Invite feature. 

3.11.4.1 MailtoInNewWindow
To use Gmail as the email client in Firefox and Chrome browsers: 

1. Access the Server Manager Console.

2. Navigate to the Configuration settings for the HTML Server.

3. Select the Advanced View.

4. In the Web Runtime section, set the value of Enable mail to links in new window 
to True.

When you click the Send Email link, the system will open the Gmail Compose Mail 
window enabling you to compose a new email message if the value of 
MailtoInNewWindow setting is set as True. 

In the case of Employee Information and Address Book Information hover forms, the 
body of the email message is pre-populated with the JD Edwards EnterpriseOne 
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parameterized URL to the EnterpriseOne application from which the Send Email link 
was clicked. The body of the email is empty in the case of Customer Information and 
Supplier Information hover forms.

If you are not signed in to Gmail before you click the Send Email link, when you click 
the Send Email link, the Gmail login page appears. After you log in to Gmail, the 
Gmail Compose Mail window appears.

If you are using Firefox or Chrome browser to access Send Email or Send Meeting 
Invite functionality, and if the MailtoInNewWindow INI setting is set as True then, a 
new browser window/tab is displayed with an informational message before the 
email client is loaded. The informational window/tab closes automatically after the 
email client is loaded.

3.11.4.2 Use Thunderbird 
Add the UseThunderbird setting in the OWWEB section of jas.ini and set the value as 
“true”, to use Thunderbird as the default Calendar client.

To use Thunderbird as the default Calendar client, from the Server Manager Console, 
navigate to the Configuration settings for the HTML Server and then select the 
Advanced View. In the Web Runtime section, set value of Enable Thunderbird as the 
default calendar client as True. 
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4Using JD Edwards EnterpriseOne Accessibility 
with the Screen Reader Software

This chapter contains the following topics:

■ Section 4.1, "JD Edwards EnterpriseOne Web Client Accessibility Compliance"

■ Section 4.2, "JD Edwards EnterpriseOne Application Accessibility"

■ Section 4.3, "JD Edwards EnterpriseOne Drop-down Menu Accessibility (Release 
9.1 Update 2)"

■ Section 4.4, "JD Edwards EnterpriseOne Pages Accessibility (Release 9.1 Update 
2)"

■ Section 4.5, "Data Browser Accessibility"

■ Section 4.6, "One View Report Accessibility (Release 9.1 Update 2)"

■ Section 4.7, "Advanced Query Accessibility (Release 9.1 Update 2)"

■ Chapter 4.8, "Customize Grid Accessibility (Release 9.1 Update 2)"

■ Chapter 4.9, "Watchlists Accessibility (Release 9.1 Update 3.1)"

4.1 JD Edwards EnterpriseOne Web Client Accessibility Compliance
A single HTML server port is used for both standard and visually impaired 
accessibility, as opposed to a separate HTML server set up in LOW interactivity for 
visually impaired users. When the Accessibility mode is set to Yes in the User Profile 
Revisions application (P0092), the web client is rendered in LOW interactivity, 
irrespective of the jas.ini setting. All the extra tags with relevant information are 
rendered so that they can be read by the screen reader software. 

The JD Edwards EnterpriseOne components that are accessible include:

■ JD Edwards EnterpriseOne application accessibility.

■ EnterpriseOne Menu accessibility.

■ Data Browser accessibility.

4.2 JD Edwards EnterpriseOne Application Accessibility
These components of JD Edwards EnterpriseOne applications are accessible through 
the screen reader software:

■ Forms in JD Edwards EnterpriseOne

■ Controls in JD Edwards EnterpriseOne
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■ Hot Keys

■ HTML pages

■ Hyper Exit Menu

■ Processing Indicator

■ EnterpriseOne Pages

■ One View Report

■ Advanced Query

4.2.1 Forms in JD Edwards EnterpriseOne
The screen reader software reads the form title when a form initially loads. 

When the JD Edwards EnterpriseOne application is launched, the mouse cursor is set 
to the User ID field. 

This table lists the details read by the screen reader software when you navigate 
through the log in page of JD Edwards EnterpriseOne: 

Table 4–1  

Navigation Path Details given by the screen reader software

User ID Reads as User ID edit, type in text. 

Password Reads as Password edit, type in text . 

Note: When you enter the password, the screen reader software 
reads each letter as * (Star).

Sign In Reads as Sign In button. You can press Enter to login.

4.2.1.1 Hover forms (Release 9.1 Update 2)
You can use the links list window of the screen reader software to access the hover 
forms. 

If the hover form is enabled for any of the fields in the form or a grid, it is displayed as 
a link in the links list window of the screen reader software. 

For example, if the hover form is enabled for the Item Number field in a form, it will 
be displayed as Item Number Hover in the links list window. Use Up and Down arrow 
keys to select the hover form link of the field that you want to access. Press Enter key 
to access the hover form. 

Press the Tab key to navigate through the tabs in the hover form if any.  The screen 
reader software reads the content on each tab of the hover form. Press Escape key to 
close the hover form.

4.2.2 Controls in JD Edwards EnterpriseOne
The screen reader software reads the names of the controls and the associated details 
when you navigate to the various form controls in the JD Edwards EnterpriseOne 
application. 

This table lists the details read by the screen reader software when you navigate 
through the various form controls: 
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Name of the Form Control Details given by the screen reader software

Edit Reads the following details: 

■ The text description of the associated label, when the 
edit control has an associated label.

■ Required field - when the edit control is a required 
field. 

■ Errors and warnings when an error or warning is set 
on the edit control. The error details include 
information which indicates "Error on Control" or 
"Warning on Control," the error "No," and the cause 
and resolution for the error or warning.

■ Visual assist details when the edit control is associated 
with a visual assist. The visual assist details include 
information which indicates if the visual assist is a 
form interconnect, calendar, calculator or UTime.

■ The text for the associated description, when a value 
entered in the edit control has an associated 
description loaded onto the screen.

■ The value entered in the edit control. 

Push Button Reads the title for the push button control. If a hot key is 
defined for the push button control, the screen reader 
software reads the hot key information within parenthesis.

Check Box Reads the text description of the label associated with the 
check box control.

Radio Button Reads the text description of the label associated with the 
radio button control. When you navigate to a radio button 
that is logically grouped inside a group box, the screen 
reader software reads the title for the Group Box (if any) 
and then the text description of the label associated with 
the radio button.

Combo Box Reads the text description of the label associated with the 
combo box control. When you navigate through the list of 
items in the combo box, the screen reader software reads 
the text description for each item.

Static Text Reads the text description of the associated static text 
control.

Image Reads the text description of the ALT associated with the 
image control.

Text Block Reads the text description for the segment associated with 
the text block control.

Text Search Reads the following details: 

■ Keywords - if you navigate to the Keywords Edit Box.

■ Case sensitive - if you navigate to the Case Sensitive 
check box. 

■ Include Similar Words - if you navigate to the Include 
Similar Words check box. 
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Apart from the controls listed in this table, there are some additional controls in JD 
Edwards EnterpriseOne applications that are accessible through the screen reader 
software. 

The other controls include:

■ Calendar control

■ Grid control

■ Parent Child control

■ Tree control 

Calendar Control

The screen reader software reads the associated details when you navigate to the 
calendar controls in the JD Edwards EnterpriseOne application. 

This table lists the details read by the screen reader software when you navigate to the 
various calendar controls: 

Tab Control Reads the following details:

■ Active Tab and then the name of the tab page if you 
navigate to the currently active Tab page. For example 
if the Versions tab is the currently active tab, the screen 
reader software reads it as Active Tab: Versions. 

■ Tab and then the name of the tab page if you navigate 
to the currently inactive Tab page. For example when 
you navigate to the Process tab that is inactive, the 
screen reader software reads it as Tab: Process.

Note: When the Tab pages are displayed as links, you can 
navigate to the Tab Page links using the screen reader 
software links list window. 

Navigation Path Details given by the screen reader software

Day tab Reads as Active Tab: Day (Ctrl+Alt+D), when the Day 
tab is the currently active tab.

Week tab Reads as Tab: Week (Ctrl+Alt+W).

Month tab Reads as Tab: Month (Ctrl+Alt+M).

Add Activity button Reads as Add Activity (Ctrl+Alt+A).

Previous link/image on the Calendar 
control

Reads as: 

■ Previous Day (Ctrl+Alt+LeftArrow), when the 
Day tab is the currently active tab.

■ Previous Week (Ctrl+Alt+LeftArrow), when the 
Week tab is the currently active tab.

■ Previous Month (Ctrl+Alt+LeftArrow), when the 
Month tab is the currently active tab. 

Name of the Form Control Details given by the screen reader software
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Grid Control

The screen reader software reads the associated details when you navigate through the 
grid in the JD Edwards EnterpriseOne application. 

The grid control is accessible as a table. 

The QBE row and the column header row constitute one table, with the QBE row being 
the first row and the column header row being the second row. When you navigate to 
the table for the QBE row, the screen reader software reads the name for the grid (same 
as the form title) and then QBE Row. For example, for the QBE row table in the Work 
with Addresses Grid in the P01012 application, the screen reader software reads it as 
"Work with Addresses. QBE Row." 

Each data row is rendered as a separate table, with the Column Header row being the 
first row and the actual data row being the second row. When you navigate to the table 
for the data row, the screen reader software reads the name for the Grid (same as the 
Form Title) and then the specific Row Number. For example, for the third data row 
table in the Work with Addresses Grid in the P01012 application, the screen reader 
software reads it as "Work with Addresses Grid. Row 3." 

Next link/image Reads as:

■ Next Day (Ctrl+Alt+RightArrow), when the Day 
tab is the currently active tab.

■ Next Week (Ctrl+Alt+RightArrow), when the 
Week tab is the currently active tab.

■ Next Month (Ctrl+Alt+RightArrow), when the 
Month tab is the currently active tab. 

Link for an activity added Reads the text describing the activity details.

Calendar icon for an activity Reads as Calendar Icon.

Previous image Reads as Previous (Ctrl+Alt+LeftArrow): Month Year. 
For example, for a Previous image on the Reference 
calendar for month of June, 2017, the screen reader 
software reads it as Previous (Ctrl+Alt+LeftArrow): 
June 2017.

Next image Reads as Next (Ctrl+Alt+RightArrow): Month Year. 
For example, for a Next image on the Reference 
calendar for month of June, 2017, the screen reader 
software reads it as Next (Ctrl+Alt+RightArrow): June 
2017.

Calendar Week Drill image Reads as Calendar Week Drill: Week No Month Year. 
For example, for a Calendar Week Drill image 
referring to the first week of month of June, 2017 on 
the Reference calendar, the screen reader software 
reads it as "Calendar Week Drill: Week 1. June 2017."

Note: The Week No can vary from 1 to 5, depending 
on the week the Calendar Week Drill image refers to. 

Day link Reads the date, month, and the year details. For 
example, for the day link for 28 June 2017, the screen 
reader software reads it as 28 June 2017.

Note: For a tab that is currently active, the prefix is set as "Active 
Tab" while for the other tabs the prefix is set as "Tab."

Navigation Path Details given by the screen reader software
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This table lists the details read by the screen reader software when you navigate 
through the grid: 

Navigation Path Details given by the screen reader software

QBE edit field in a QBE 
row

Reads the following details:

■ The text description of the label for the QBE edit field which 
is actually the corresponding column's header and then the 
text QBE. For example, for the Address Number QBE field, 
the screen reader software reads it as Address Number QBE. 

■ The visual assist details, when the QBE edit field is 
associated with a visual assist. The visual assist details 
include information which indicates if the visual assist is a 
form interconnect, calendar, calculator or UTime. 

Cells in a data row Reads the corresponding column header text and then the 
contents of the current cell.

Grid cell set with a special 
color

Reads as Special Setting and then the corresponding color 
information. For example, when you navigate to a grid cell set 
with a color called magenta, the screen reader software reads 
Special Setting: Color is Magenta along with all the other details.

Grid cell set with a special 
font

Reads as Special Setting and then the corresponding font 
information. When you navigate to a grid cell set with a special 
font, the screen reader software reads as Special Setting: Font is 
Broadway. Font Style is Italic. Text Decoration is Underline. Font 
Weight is Bold, where broadway is the font name, italic is the font 
style, underline is the text decoration, and bold is the font weight.

Row selector check box cell 
in a data row

Reads as Checkbox checked or not checked and then reads the 
Row No.

Paper clip image Reads Attachment or No Attachment, when you navigate to a 
paper clip image for Attachment in the Click to search for the 
Attachments cell.

Next image Reads as Next and then the name for the grid (same as the Form 
Title) as a suffix. Hence, if there is more than one grid on the 
form, you can clearly identify the grid to which the Next image 
belongs. For example, the Next image on the Work with 
Addresses grid, the screen reader software reads as Next: Work 
with Addresses.

Previous image Reads as Previous and then reads the name of the grid as a suffix.

Customize Grid link Reads as Customize Grid and then the name of the grid as a 
suffix.

Grid formats combo box Reads as Grid Column Display and then the name of the grid as a 
suffix.

image for Export Grid 
Data

Reads as Export Grid Data (Ctrl+Shift+E) and then the name of 
the grid as a suffix.

image for Import Grid 
Data

Reads as Import Grid Data (Ctrl+Shift+I) and then the name of 
the grid as a suffix.

Restore Grid Reads as Restore Grid (Alt+R) and then the name of the grid as a 
suffix.



Note: The name for the grid is added as a suffix for all the links and 
images on the grid control. This enables you to clearly identify the 
grid to which the link or image belongs if there is more than one grid 
on the form. 

You must install a screen reader software script to enable you to move 
up and down in a column in a grid. You can use the key strokes 
Windows + N to move down the column and Windows + Shift + N to 
move up the column. 
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This table lists the details read by the screen reader software when you navigate to the 
grid cells:

Navigation Path Details given by the screen reader software

Check Box When you navigate to a grid cell that has its display style set to 
check box, the screen reader software reads the corresponding 
Column Header text and then Check Box checked or unchecked.

Combo Box When you navigate to a grid cell that has its display style set to 
combo box, the screen reader software reads the corresponding 
Column Header text and then the text description of the item 
selected in the combo box cell.

Edit Box When you navigate to a grid cell that has its display style set to 
edit box, the screen reader software reads the following 
information:

■ The corresponding column header text.

■ The value of the current cell.

■ The error or warning details when an error or warning is set 
on the editable cell. The error details include information 
which indicates "Error on Cell" or "Warning on Cell", the error 
or warning description, and the cause and resolution for the 
error or warning.

■ The visual assist details when the editable cell is associated 
with a visual assist. The visual assist details include 
information which indicates if the visual assist is a form 
interconnect, calendar, calculator or UTime.

Icon When you navigate to a grid cell that has its display style set to 
icon, the screen reader software reads this information:

■ The corresponding column header text.

■ The value of the current cell.

■ The ALT details of the <IMG> element corresponding to the 
icon. 

Clickable Text When you navigate to a grid cell that has its display style set to 
clickable text, the screen reader software reads the corresponding 
column header text and then the data content of the current cell.

Tree Control

The screen reader software reads the associated details when you navigate to the 
various tree controls in the JD Edwards EnterpriseOne application. 

The tree control is accessible as a table, where the first row in the table is the header 
row consisting of two columns with the headers set as: 

■ Row Selector 



JD Edwards EnterpriseOne Application Accessibility

4-8 JD Edwards EnterpriseOne Tools Foundation Guide

■ Tree Node Text

This table lists the details read by the screen reader software when you navigate to the 
Row Selector radio button in the tree control:

Name of the Node Details given by the the screen reader software

Root Node (collapsed) Reads it as Tree Row Selector for Root Node, the value in 
the cell, and Collapsed.

Root Node (expanded) Reads it as Tree Row Selector for Root Node, the value in 
the cell and Expanded.

Child Node at Level N (sibling 
collapsed)

Reads it as Tree Row Selector for Child Node at Level N 
with Sibling, the value in the cell, and Collapsed.

Child Node at Level N (sibling 
expanded)

Reads it as Tree Row Selector for Child Node at Level N 
with Sibling, the value in the cell, and Expanded.

Child Node at Level N (without 
sibling collapsed)

Reads it as Tree Row Selector for Child Node at Level N 
without Sibling, the value in the cell, and Collapsed.

Child Node at Level N (without 
sibling expanded)

Reads it as Tree Row Selector for Child Node at Level N 
without Sibling, the value in the cell, and Expanded.

Leaf Node (with sibling at Level 
N)

Reads it as Tree Row Selector for Leaf Node with sibling: 
Level N and then the value in the cell.

Leaf Node (without sibling at 
Level N)

Reads it as Tree Row Selector for Leaf Node without sibling: 
Level N and then the value in the cell.

This table lists the details read by the screen reader software when you navigate to 
TreeNodeCell in the tree control:

Name of the Node Details given by the screen reader software

Root Node (collapsed) Reads it as Root Node, the value in the cell, and collapsed.

Root Node (expanded) Reads it as Root Node, the value in the cell and expanded.

Child Node at Level N (sibling 
collapsed)

Reads it as Child Node at Level N with Sibling, the value in 
the cell, and Collapsed. To expand use (Ctrl+Shift+Right 
Arrow).

Child Node at Level N (sibling 
expanded)

Reads it as Child Node at Level N with Sibling, the value in 
the cell, and Expanded. To collapse use (Ctrl+Shift+Left 
Arrow).

Child Node at Level N (without 
sibling collapsed)

Reads it as Child Node at Level N without Sibling, the value 
in the cell, and Collapsed. To expand use (Ctrl+Shift+Right 
Arrow).

Child Node at Level N (without 
sibling expanded)

Reads it as Child Node at Level N without Sibling, the value 
in the cell, and Expanded. To collapse use (Ctrl+Shift+Left 
Arrow).

Leaf Node (with sibling at Level 
N)

Reads it as Leaf Node with sibling: Level N: and then the 
value in the cell.

Leaf Node (without sibling at 
Level N)

Reads it as Leaf Node without sibling: Level N and then the 
value in the cell.

When you navigate to a TreeNodeCell of text type that is set with a special bitmap, 
along with the other details, the screen reader software reads Special Setting for Node 
and the corresponding name of the image. For example, when you navigate to a 
TreeNodeCell that is set with a special bitmap called Group, along with all the other 
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details, the screen reader software reads it as Special Setting For Node:Group.

4.2.3 Hot Keys
When you navigate to a button, image, or icon in the hyper exit menus, EnterpriseOne 
Menu, grid, calendar or the tree controls where an EnterpriseOne hot key is defined, 
the screen reader software reads the hot key information within parenthesis. 

Click the 'i' button on any open JD Edwards EnterpriseOne form to open the 
information dialog. Then click on Display list of all hot keys to obtain the list of hot 
keys supported by the JD Edward EnterpriseOne software. You can also use Cntrl+ 
Shift+K to open the hot keys information window.

4.2.4 Hyper Exit Menus
When you navigate to a hyper exit menu, the screen reader software reads the name of 
the hyper exit menu. If the hyper exit menu has a hot key defined, then the screen 
reader software reads the hot key information within parenthesis. 

When you navigate to a hyper exit menu that has sub-menus or items underneath it 
using the screen reader software links list window, the screen reader software reads 
the name of the hyper exit menu and then the text corresponding to the menu item or 
sub-menu. For example, when you navigate to the Refresh menu item under the Tools 
menu, the screen reader software reads it as Tools: Refresh. 

Navigation between the Hyper Exit Menu Items

You can navigate between the hyper exit menu items using the Up and Down arrow 
keys. 

To navigate between the hyper exit menu items or a hyper exit menu that has 
sub-menus, you must use the Up and Down arrow keys. When you use the Down 
arrow key for the first time, the screen reader software reads it as a hyper exit menu 
that has a sub-menu. When you use the Down arrow key for the second time, the focus 
moves to the graphic item that is used for the layout. You must press the Enter key to 
display the sub-menu. When you use the Down arrow key for the third time, the focus 
moves to the blank graphic that is used for the layout. Now, when you use the Right 
arrow key, the focus moves to the actual hyper exit menu item and the screen reader 
software reads the text corresponding to the menu item. 

4.2.5 Processing Indicator 
When you fast path to an application from the JD Edwards EnterpriseOne Menu, as 
the application is in the process of opening, the Processing Indicator text conveys the 
message "Opening Application. You may continue working while the application 
loads." When you navigate through the Processing Indicator page, the screen reader 
software reads the static text of the page. 

Note: The Processing Indicator text is accessible only until the 
application is loaded onto the screen.

4.3 JD Edwards EnterpriseOne Drop-down Menu Accessibility (Release 
9.1 Update 2)

The screen reader software reads the names of the links and the associated details 
when you navigate through the JD Edwards EnterpriseOne Menu. All the JD Edwards 
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EnterpriseOne menus are accessible as links using the screen reader software’s links 
list window.

The Ctrl+M hot key brings the focus to the drop-down menu Home link. You can use 
the tab key to move to other menus, such as Favorites, Open Applications, and 
Reports.

Use the following navigation options in the main drop-down menu:

■ Up/Down Arrow - For navigating up or down in the drop-down menu.

■ Right Arrow - Displays submenu and the focus is set to the first element.

■ Left Arrow - Collapses the present submenu and the focus is set back to the parent 
drop-down menu.

You can use the CTRL or Shift key along with the right arrow to see the available 
options context menu for the folders or tasks. Then, you can use the up/down arrow 
to navigate within these option. Use the Enter key to open these options.

This table lists the details read by the screen reader software for the corresponding 
controls or links when you navigate through the JD Edwards EnterpriseOne Menu: 

Controls/Navigation Path Details given by the the screen reader software

Home The screen reader software reads as Home link.

Drop-down menu Reads as menu Name of the drop-down menu, to move 
through items press Up or Down arrow key.

Link for the Application task Reads the names of the task, application, form, version 
and then the E1 Menu Application Task.

Link for the Report task Reads the names of the task, application, form, version 
and then E1 Menu Report Task.

Link for the URL task Reads the task name and then URL is followed by the 
URL name. For example, when you navigate to a URL 
task link called "Test URL" that refers to the URL – 
http://www.yahoo.com , the screen reader software 
reads as "Test URL. E1 Menu URL Task. URL Is 
http://www.yahoo.com". 

Link for a Flyout task Reads the task name and then E1 Menu Flyout. For 
example, when you navigate to the Flyout link for the 
Favorites task, the screen reader software reads Favorites. 
E1 Menu Flyout.

Note. You can use the CTRL or Shift key along with the 
right arrow to see the available options dialogue.

Link for an Action task Reads the Action name followed by E1 Menu Action. For 
example, when you navigate to the My System Options 
action link, the screen reader software reads My System 
Options. Application: P0085 Form: W0085N. E1 Menu 
Action.

Link for Roles combo box Reads as E1 Menu Roles.

Link for Preferences Reads as Preferences, to move through items press Up or 
Down arrow.
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4.3.1 Favorites Drop-down Menu Accessibility (Release 9.1 Update 2)
The screen reader software reads the Favorites drop-down menu as Favorites 
sub-menu. To move through items, press the Up or Down arrow key.

When you move through the submenus in the Favorites drop-down menu, the screen 
reader software reads the name of the sub-menu.

When you are in the Manage Favorites window, press the Tab key to move through the 
favorite tasks and folders. Press Enter to select a favorite task or folder. Use the links 
list window of the screen reader software to access the Delete, Rename, Reorganize, 
Move Up and Move Down buttons. Use these buttons  to perform specific functions.

This table lists the details read by the screen reader software for the corresponding 
controls and the function of the controls when you navigate through the Manage 
Favorites window.

Link for an Open Application Reads the Application name, the number "N" which 
indicates that it is the Nth application that has been 
launched and finally E1 Menu Open Application. For 
Example, when you navigate to the "Work with 
Addresses" Open Application link, the screen reader 
software reads Work with Addresses (1). E1 Menu Open 
Application, where (1) indicates that "Work with 
Addresses" was the first application to be launched.

Note: When you activate a Flyout link for a task and then navigate to 
a specific Flyout Item link under the Flyout, the screen reader software 
first reads the name of the Flyout Item and then "E1 Menu Flyout Item 
For" followed by the task name. For example, when you Activate the 
Flyout link for the "Favorites" task and then navigate to the Flyout 
Item "Documentation", the screen reader software reads 
"Documentation. E1 Menu Flyout Item for Favorites."

Table 4–2  

Controls Description

Delete The screen reader software reads the title of the push button 
control. 

Use the Tab key to move through the tasks in the Mange 
Favorites window. Press Enter to select a particular task or 
folder. Access the links list window of the screen reader software 
and then, select Delete and press Enter to delete the Favorite 
task or folder. Select OK and press Enter to confirm. Select 
Cancel and press Enter to cancel the delete operation.

Rename The screen reader software reads the title of the push button 
control. 

You can use the Rename button to edit the name of the user 
defined favorite folder or task. Use the Tab key to move through 
the tasks in the Manage Favorites window. Press Enter to select a 
particular task or folder. Access the links list window of the 
screen reader software and then, select Rename and press Enter 
to enter the required name for your favorite task.

Controls/Navigation Path Details given by the the screen reader software
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4.4 JD Edwards EnterpriseOne Pages Accessibility (Release 9.1 Update 
2)

The screen reader software reads the names of the fields, buttons, and links, and the 
associated details when you navigate through the JD Edwards EnterpriseOne pages.

The EnterpriseOne pages are displayed as links. You can navigate to the 
EnterpriseOne pages links using the screen reader software's links list window.

If there are any links (URLs) in the JD Edwards EnterpriseOne pages, they are 
displayed in the links list window of the screen reader software.

This table lists the details read by the screen reader software when you navigate 
through the various form controls: 

Table 4–3  

Navigation Path Details given by the screen reader software

Frames The screen reader software reads the number of frames/pages 
available after you log in.

EnterpriseOne Pages The screen reader software recognizes the EnterpriseOne pages 
as links. When accessed the screen reader software reads the title 
and content of the EnterpriseOne page.

Move Up and Move Down The screen reader software reads the title of the push button 
control. 

You can use the Move Up and Move Down buttons to reorder 
the favorite tasks and folders. Use the Tab key to move through 
the tasks in the Mange Favorites window. Press Enter to select a 
particular task or folder. Access the links list window of the 
screen reader software and then, select Move Up and press enter. 
The selected task is moved above the previously listed task or 
folder. Similarly, you can use the Move Down option to move 
the task/folder below a particular task/folder.

You cannot use the Move Up option for the first task/folder 
listed in the Manage Favorites window. Also, you cannot use the 
Move Down option for the last task/folder listed in the Manage 
Favorites window. 

Reorganize The screen reader software reads the title of the push button 
control. 

You can use the Reorganize button to reorganize the favorite 
tasks and folders . Use the Tab key to move through the tasks in 
the Mange Favorites window. Press Enter to select a particular 
task/folder. Access the links list window of the screen reader 
software and then, select Reorganize. A drop-down window 
appears listing all the user defined folders. Use Up/Down arrow 
keys to select a user defined folder and then, press Enter. The 
task will be moved into the selected user defined folder.

The Reorganize option is not available for the user defined 
folders. You cannot move a user defined folder into another user 
defined folder and also, you cannot move a favorite task or a 
favorite user defined folder into a favorite folder.

Table 4–2 (Cont.) 

Controls Description
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4.5 Data Browser Accessibility
The screen reader software, reads the names of the fields and the associated details 
when you navigate through the Query Selector page. 

This table lists the details read by the screen reader software for the corresponding 
fields when you navigate through the Query Selector page: 

Navigation Path Details given by the the screen reader software

Personal Queries radio button Reads as personal queries. 

Select a Personal Query combo box Reads the label for the combo box as queries you have 
created and then the text for the selected query.

Public Queries radio button Reads as public queries.

Select a Public Query combo box Reads the label for the combo box as queries you have 
created and then the text for the selected query.

By Table radio button Reads as By Table. The screen reader software also 
helps you to search and select tables.

Name Edit field to enter table name Reads the label for the edit field as Table Name and 
then the visual assist details, the associated 
description details (if any) and the pre – existing 
value (if any).

By Business View radio button Reads as By Business Views. The screen reader 
software also helps you to search and select business 
view.

Name Edit field to enter a business 
view 

Reads the label for the edit field as Business View 
Name and then the visual assist details, the associated 
description details (if any) and the preexisting value 
(if any).

Data Source Edit field to enter the data 
source name

Reads the label for the edit field as Data Source and 
then the visual assist details and the preexisting value 
(if any).

4.6 One View Report Accessibility (Release 9.1 Update 2)
 The One View menu is available as a link in the screen reader software's links list 
window when you access a One View Reporting enabled form. You can click the link 
to access the One View Report menu. Use the Up/Down arrows to open the sub-menu 
items if any. Press the Escape key to close the One View menu.

Note: Accessibility for One View Reporting is available only at 
runtime. There is no design time support.

This table lists the details read by the screen reader software for the corresponding 
menus when you navigate through the One View Report menu.

Table 4–4  

Navigation Path Details given by the screen reader software

One View Menu Available in the links list window of the screen reader software. 
The screen reader software reads it as One View menu.

My Reports The screen reader software reads the "My Reports" section 
containing all the personal reports, if there are any, in 
alphabetical order.



Advanced Query Accessibility (Release 9.1 Update 2)

4-14 JD Edwards EnterpriseOne Tools Foundation Guide

4.7 Advanced Query Accessibility (Release 9.1 Update 2) 
The advanced query option is displayed as a link in the links list window of the screen 
reader software. The link is labeled as Add, Edit Queries. 

This table lists the details read by the screen reader software for the corresponding 
controls when you use the advanced query option.

Table 4–5  

Navigation Path Details given by the screen reader software

Advanced query Displayed as a link in the links list window of the screen reader 
software. The screen reader software reads it as Add, Edit 
Queries. Use Up or Down arrow to select the Add, Edit Queries 
link and then, press Enter to access the Query Management 
window.

Query Management 
window

The screen reader software reads the title of the window; the 
focus is set to the Query field.

Query The screen reader software reads it as Query Edit, to change 
selection use Arrow keys.

Set As Default The screen reader software reads it as Set as Default not checked. 
Note. The screen reader software reads it as Set as Default 
checked, if the check button is selected.

Run query when selected The screen reader software reads it as Run query when selected 
checked.

Add The fields that can be added into the query is displayed as links 
in the links list window. For example, you can use Up and Down 
arrows to select Add Order Number link and press Enter to add 
the Order Number field to the query. 

Note: Use Tab key, Up and Down arrows to select conditions and 
to enter value to your query.

Find Find button is displayed as a link in the links list window of the 
screen reader software. The screen reader software reads it as 
Find.

Remove Query Remove query is displayed as the Delete Query link in the links 
list window of the screen reader software.

Close Select the link Close side panel in the links list window of the 
screen reader software and press Enter to close the Query 
Management window.

4.8 Customize Grid Accessibility (Release 9.1 Update 2)
The Customize Grid link is displayed as a link in the links list window of the screen 
reader software. 

This table lists the details read by the screen reader software for the corresponding 
controls when you use the Customize Grid link to customize the grid.

Add Report The screen reader software reads it as Add Report, if the user 
has edit permission on the form.

Manage Report The screen reader software reads the flyout menu as Manage 
Report, if there is any Personal or Shared Report.

Table 4–4 (Cont.) 

Navigation Path Details given by the screen reader software
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Table 4–6  

Navigation Path/Controls 
Details given by the screen reader 
software

Customize Grid Reads as Customize grid link. Press enter to 
select.

Buttons

Create, Modify, Delete, Update Style and 
Close buttons.

Display and Order Add All

Display and Order Remove All

Display and Order Add

Display and Order Remove

Move Select Column UP

Move Select Column Down

Data Sequencing Add All

Data Sequencing Remove All

Data Sequencing Add

Data Sequencing Remove

Data Sequencing UP

Data Sequencing Down

Move Sequence Column Up

Move Sequence Column Down

Reads the title for the push button control. 

OK and Cancel buttons Reads the title for the push button control. 

Select OK button and press Enter to save the 
grid format. Select Cancel and press Enter 
to cancel.

Data Sequencing Available columns Reads as Data Sequencing Available 
columns list box, to move through items use 
the Arrow keys.

Data Sequencing Available columns is 
displayed as a link in the Form Field dialog 
of the screen reader software.

Sequenced Columns Reads as Sequenced Columns list box, to 
move through items use the Arrow keys.

Sequenced Columns is displayed as a link 
in the Form Field dialog window of the 
screen reader software.

Display and Order Available columns Reads as Display and Order Available 
columns list box, to move through items use 
the Arrow keys.

Display and Order Available columns is 
displayed as a link in the Form Field dialog 
window of the screen reader software.

Display and Order Reads as Display and Order list box ,to 
move through items use the Arrow keys. 

Display and Order is displayed as a link in 
the Form Field dialog window of the screen 
reader software.

Column Color Reads as Column Color Edit, type in text.
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4.9 Watchlists Accessibility (Release 9.1 Update 3.1)
One View Watchlists represent collections of items that match user-defined criteria. 
They enable users to define information to which they would like to be alerted.

See JD Edwards EnterpriseOne Applications One View Watchlists Implementation Guide.

These components of JD Edwards EnterpriseOne Watchlists are accessible through the 
screen reader software:

■ Watchlist Management window

■ Watchlists drop-down menu

4.9.1 Accessibility for Watchlist Management Window
The Watchlist Management window is used to add, edit, share, or delete watchlists.

Note: You must login to the JD Edwards Enterprise One web client 
with a User ID that has the right to create, share and view Watchlists.

 Use the Ctrl+Y hot key to open or close the Watchlist Management window.

You can also use the links list window of the screen reader software to access the Add, 
Edit Watchlists link to open the Watchlist Management window. Ensure that the 
application you use has an Advanced Query created.

Use the Tab key to focus on the required fields in the Watchlists Management window. 
The screen reader software reads the label and value (if there is any) of the fields.

This table lists the details read by the screen reader software when you navigate 
through the Watchlist Management window.

Text Color Reads as Text Color Edit, type in text.

Column Width Reads as Column Width Edit, type in text.

Check boxes - Bold, Italic, Underline, 
StrikeOut.

Reads the title of the check box, and also 
reads if the check box is checked or 
unchecked.

Table 4–7  

Navigation Path/Controls Details 

Watchlist Name The screen reader software reads the title of the field. 

In the Watchlist Name combo box, private watchlists created by 
the user is displayed under My Watchlists section. The 
published watchlists assigned to the user are displayed under a 
Shared Watchlists section and shared watchlists reserved by the 
user is displayed under a Reserved Watchlists section.

My Watchlists section When you navigate to the first or last watchlist in the My 
Watchlists section, the screen reader software reads as Alert My 
Watchlists followed by the watchlist name to specify that it is the 
beginning of the My Watchlists section.

Table 4–6 (Cont.) 

Navigation Path/Controls 
Details given by the screen reader 
software
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Reserved Watchlists section When you navigate to the first watchlist in the Reserved 
Watchlists section, the screen reader software reads as Alert 
Reserved Watchlists (Reserved by the User ID) followed by the 
watchlist name to specify that it is the beginning of the Reserved 
Watchlists section.

Shared Watchlists section When you navigate to the first watchlist in the Shared Watchlists 
section, the screen reader software reads as Alert Shared 
Watchlists followed by the watchlist name to specify that it is the 
beginning of the Shared Watchlists section.

When you navigate to any Reserved Watchlist or a Shared 
Watchlist that has also been reserved, the screen reader software 
reads as Alert Reserved by the User ID followed by the watchlist 
name to identify to the user that the watchlist has been reserved 
by the specific user.

Watchlist Description The screen reader software reads the name of the field. 

Warning Threshold The screen reader software reads the name of the field. 

Critical Threshold The screen reader software reads the name of the field. 

Advanced Options Link Use the tab key to navigate to the Advanced Options link and 
press the Enter key to expand it and display the fields under it.

After expanding the Advanced Options link, use the Tab key to 
access Refresh Interval and Max Records to Return fields.  You 
can also use the links list Window of the screen reader software 
to activate the Advanced Options link and display the fields 
under it. To collapse the Advanced Options link, use the Tab key 
to set the focus on the Advanced Options link and then, press 
Enter.

Query to be used Use this combo box to select the Advanced Query over which 
the watchlist is to be created.

Use Up or Down arrow keys to navigate through the Advanced 
Query values and after selecting a value, the details of the query 
is loaded into the Query Details group box. Use the Tab key to 
set focus on the Query Details group box that has the complete 
details of the Advanced Query.

Use the Tab key to set the focus on Match all of the following or 
Match any of the following text and the screen reader software 
will read the text.

Use the Tab key to set the focus on the first Query condition. The 
screen reader software will read the Query condition. Use the 
Tab key to move to the next query condition.

Save Watchlist Use the links list window of the screen reader software to access 
this link. 

Save Watchlist As Use the links list window of the screen reader software to access 
this link. 

Publish Watchlist Use the links list window of the screen reader software to access 
this link. 

Reserve Watchlist Use the links list window of the screen reader software to access 
this link. 

Delete Watchlist Use the links list window of the screen reader software to access 
this link. 

About Watchlist Use the links list window of the screen reader software to access 
this link. 

Table 4–7 (Cont.) 

Navigation Path/Controls Details 
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4.9.2 Accessibility for Watchlists Drop-down Menu
The screen reader software, reads the names of the links and the associated details 
when you navigate through the Watchlists drop-down menu.

Note: The Watchlists drop-down menu is displayed only if the user 
has created the watchlists or if any published watchlists are assigned 
to the user. 

Use the Alt+W hot key to navigate to the Watchlists drop-down menu. The screen 
reader software reads as Watchlists Sub-menu. You can also use Ctrl+M hot key to first 
navigate to the Home Link and then use the Tab key to navigate to the Watchlists 
drop-down menu. Use the Down Arrow key to expand the Watchlists drop-down 
menu.

In the Watchlists drop-down menu there may be three sections. 

1. Private Watchlists - These are created by the user and are displayed under  My 
Watchlists section heading.

2. Shared Watchlists - These are the published Watchlists that are assigned to the user 
and are displayed under Shared Watchlists section heading. 

3. Reserved Watchlists  - These are the published Watchlists that are reserved by the 
user and are displayed under the Reserved Watchlists section heading.

Use the Down and Up Arrow keys to navigate through the individual Watchlist items 
and section headings such as My Watchlists, Reserved Watchlists and Shared 
Watchlists.

This table lists the details read by the screen reader software when you navigate 
through the Watchlist drop-down menu.

Close Side Panel Use the links list window of the screen reader software to access 
this link. 

Validation errors or errors 
returned from the server

The screen reader software reads these error messages as Alert 
followed by the appropriate error message.

Use the Tab key to navigate through the fields. When the focus is 
set on the field that contains an error, the screen reader software 
reads the name of the field and it’s value as Invalid Entry to 
indicate that it is an error field.

Creating a new watchlist When you are creating a new watchlist using the Save 
Watchlist/Save Watchlist As link or Publishing a Watchlist using 
the Publish Watchlist link, an Enter New Watchlist Name 
window is displayed.

This window has a text field to enter the new watchlist name 
and an OK button to Save/Publish the Watchlist. 

You can use the Tab key to shift focus from the text field to the 
OK button. Press Enter key to select the OK button.

Use the links list window of the screen reader software to select 
Close option to close the Watchlist Name window.

Table 4–7 (Cont.) 

Navigation Path/Controls Details 
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My Watchlists section heading in the 
Watchlists drop-down menu

The screen reader software reads as My Watchlists 
Sub-menu.

Reserved Watchlists section heading 
in the Watchlists drop-down menu.

The screen reader software reads as My Watchlists 
Sub-menu.

Shared Watchlists section heading in 
the Watchlists drop-down menu.

The screen reader software reads as My Watchlists 
Sub-menu.

Refresh Watchlist Control When you are on a section heading, use the Down 
Arrow key to navigate to the Refresh Watchlist 
Control.

The screen reader software reads the appropriate status 
for the Refresh Watchlist Control followed by the 
watchlist name. Status for the Refresh Watchlist 
Control can be any one of the following: 

■ Update in progress for.

■ Update pending, followed by Refresh.

■ Update failed, followed by Refresh.

■ Update interrupted, followed by Refresh.

■ Time since last update, followed by the elapsed 
time, and then Refresh.

Refresh Watchlist Control Use the Enter key to refresh the                                                                       
Watchlist count. After the refresh is completed, the 
focus will be set back to the Refresh Watchlist Control.

Use the Down Arrow key to navigate to a watchlist 
item. The screen reader software reads the watchlist 
name and the count of the records returned by the 
Advanced Query. 

When the focus is set to the watchlist item , if the count 
for that watchlist is greater than or equal to the Critical 
Threshold then, apart from reading the watchlist name 
and count, the screen reader software also reads 'Count 
is greater than or equal to Critical Threshold'.

When the focus is set to the watchlist item, if the count 
for that watchlist is greater than or equal to the 
Warning Threshold then apart from reading the 
watchlist name and count, the screen reader software 
also reads 'Count is greater than or equal to Warning 
Threshold.'

Watchlist item When the focus is set to the watchlist item, use the 
Enter key to launch the Enterprise One application that 
has the Advanced Query and over which the Watchlist 
is created. 

Close Use the Esc key to close the Watchlists drop-down 
menu.

Watchlists Accessibility (Release 9.1 Update 3.1)
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5Using JD Edwards Web Applications and 
Reports

This chapter contains the following topics:

■ Section 5.1, "Launching Applications and Reports"

■ Section 5.2, "Viewing the Data in Tables and Business Views"

■ Section 5.3, "Recovering Data"

■ Section 5.4, "Working with Tasks, User Options, and the Calendar"

Note: If you are not using Internet Explorer as your browser, you 
might not have access to some of the functionality mentioned in this 
chapter.

5.1 Launching Applications and Reports
JD Edwards provides a variety of applications, reports, and other objects. Typically, 
you access these objects from the EnterpriseOne Menu.

5.1.1 Launching an Application or Report
Access EnterpriseOne Menu.

1. In EnterpriseOne Menu, navigate to the application or report you want to launch.

2. To launch the application or report without defining processing options, version, 
and so forth, double-click the report or application.

Applications launch immediately. If you launch a report the system launches Work 
with Batch Versions so you can select which version you want to run.

3. To select processing options or version for an application, right-click and select 
Values or Versions, respectively.

After you select the processing options or version, the system launches the 
application. Depending on how your system administrator configured the system, 
you can launch the application either in the existing window or in a new one. If 
the system is configured for multiple browser windows, you can hold down the 
CTRL key when you press Enter to launch the application in a new window. Either 
way, you can run multiple applications simultaneously. All applications you have 
running are listed in the EnterpriseOne Menu toward the top, under Open 
Applications. You can switch among them by clicking the application you want in 
the list.
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4. To select processing options or version or to designate data selection parameters 
for a report, right-click and select one of these options:

– Values

– Versions

– Data Selection

– Data Selection & Values

After you set the options, the system might launch Work with Batch Versions 
so you can select which version you want to run. Then, the Version Prompting 
form appears. Select the prompting you want and click Submit to select a 
printer and process the report.

5.1.2 Launching Applications in Separate Windows
When you open more than one application, you can select to have the application 
launch in the existing window, or in a new window. If you select to have it launch in 
the existing window, JD Edwards EnterpriseOne replaces the application on which 
you are currently working with the application that you have just launched. If you 
select to launch additional applications in new windows, then each application 
appears and is fully functional in its own window. 

To launch applications in new windows:

1. Navigate to the task from the Navigator drop-down menu.

2. Right click on the task and select Open in New Window from the context menu.

Note: Access Preferences window from the Personalization menu 
and select Open Application In New Window check box to open all 
the application that are launched in a new window.

5.1.3 Viewing Report Output
Access the Personalization menu.

Before you can view the output of your reports online, you must run a report version.

1. From the Personalization drop-down menu, select My System Options.

2. On User Default Revisions, click Submitted Reports.

3. On Work with Servers, select the server on which the report was run.

4. Click Select.

5. On Submitted Job Search, select the report you want to view.

6. From the Row menu, click View PDF.

The report appears in read-only, PDF format.

To view report data on pages other than the one currently displayed, type a page 
number in the field located at the bottom of the PDF viewer. 

JD Edwards EnterpriseOne contains a feature called Page at a Time PDF that 
assists in downloading large files quickly. If your system administrator has 
enabled this feature, you should immediately see the first page of the PDF file. If 
Page at a Time is not enabled, you will see a blank screen in the PDF viewer while 
the file downloads. If this is the case, contact your system administrator. 
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5.1.4 Changing your Password
Access the Personalization menu.

1. From the Personalization drop-down menu, select My System Options.

2. On User Default Revisions, click Change Password.

3. On User Password Revisions, complete the following fields and click OK:

– Old Password

– New Password

– New Password - Verify

5.1.5 Sending a Shortcut to an Application Form
While you are working in the JD Edwards EnterpriseOne web client, you can email 
other users a shortcut to the application and form that you are looking at. The recipient 
double-clicks the shortcut in the email to access your current position in the software.

To send a shortcut to an application form:

1. Launch a JD Edwards EnterpriseOne application and access the form that you 
want to send.

2. Click Tools and select Send Shortcut.

3. On Send Shortcut, complete these fields:

– Address Number / User / Role / Distribution List

Note: If you are sending a shortcut to members of a distribution list, 
you must click the Distribution List option and then select the address 
book number of the distribution list. If you enter the distribution-list 
address-book number without choosing the Distribution List option, 
the shortcut will be sent only to the distribution-list address-book 
number and not to the members of the distribution list.

– Mail Box

Select which mailbox/queue you want the message to be sent to.

– Subject

Type the text that you want to appear in the Subject line of the email message.

4. If you want to include a message with the shortcut, type it in the large field at the 
bottom of the form.

5. Click OK to send the shortcut.

The recipient will receive the shortcut using an email in the Work Center or a 
third-party email system, depending on the recipient's email preferences in JD 
Edwards EnterpriseOne.

5.2 Viewing the Data in Tables and Business Views
If you want to view the data in tables and business views, you can use Data Browser. 
This tool enables you to verify the existence of data in a table or business view, as well 
as to determine the table or business view structure. 
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5.2.1 Accessing Data Browser
Type databrowser in the Fast Path. If you type databrowser in the Fast Path, the Query 
Selector form appears. If you are in an application, you can access the Data Browser by 
clicking the Tools menu, and then clicking Data Browser. If you access the Data 
Browser from an application, the Query Selector and the Data Browser forms appear. 
The Query Selector form enables you to select queries, tables, or business views to 
search for data. The Data Browser form enables you to search for data for a specific 
table or business view. When you access Data Browser from an application, the only 
tables and business views on which you can search are those that correspond to the 
application you are in.

5.2.2 Searching for Data in Tables
Access the Data Browser.

1. Type databrowser in the Fast Path.

2. Select the By Table option.

3. In the Name field located under the By Table option, type the name of the table on 
which you want to search, or use the Search button to locate a table.

4. Press Tab.

The Data Source field automatically displays the name of the data source in which 
the table resides for the environment that you are logged into.

5. In the Data Source field, if the data source that is displayed is different than the 
one from which you want to search, type a new data source, or use the search 
button to locate a data source.

6. Click OK.

The Data Browser search form appears for the table you specified.

7. Use form filter fields, QBE columns, and Query control to locate data; if desired, 
save the query for future use.

See Also Section 3.7.5, "Working with Search Criteria"

5.2.3 Searching for Data in Business Views
Access the Data Browser.

1. Type databrowser in the Fast Path.

2. Select the By Business View option.

3. In the Name field, type the name of the business view on which you want to 
search, or use the search button to locate a business view.

4. Click OK.

The Data Browser search form appears for the business view you specified.

5. Use form filter fields, QBE columns, and the Query control to locate records; if 
desired, save the query for future use.

See Also Chapter 3.7.5, "Working with Search Criteria"

5.2.4 Using Existing Queries to Search for Data in Tables and Business Views
Access the Data Browser.
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1. Select the Personal Queries or Public Queries option.

The Personal Queries option enables you to select queries you have created for 
yourself from a drop-down menu. The Public Queries option enables you to 
choose from a drop-down menu queries that have been made available to you by a 
system administrator. 

2. From the drop-down menu located next to the option you selected, select the 
query on which you want to search.

3. Click OK.

5.2.5 Creating Personal Search Queries to Search for Data in Tables and Business 
Views

Access the Data Browser.

1. Follow the instructions for searching for data in tables or searching for data in 
business views in the previous sections.

2. On Data Browser, use the Query control to design a query.

See Chapter 3.7.5, "Working with Search Criteria".

3. Click the Find button in the Query Management side panel or on the form to run 
the query.

4. If you want to save the query, click the Save Query icon in the Query Management 
side panel.

5. Enter a name for the query.

The new query name appears in the Query field.

6. Close the Query Management side panel.

The new query name appears in the Query field on the form. To find records 
without using a query, you must reset the Query field to All Records.

Note: The queries created using the Query control are Enhanced 
Queries, which differ from the Saved Queries that users might have 
created in previous releases. You can convert the format of the old 
Saved Queries to Enhanced Queries by using a conversion process.

See "Converting Saved Queries to Enhanced Queries" in the JD 
Edwards EnterpriseOne Tools System Administration Guide.

5.3 Recovering Data
This section provides an overview of how to recover data and discusses how to:

■ Retrieve all records from the database.

■ Voluntarily save data.

■ Retrieve data.

■ View data.
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5.3.1 Understanding how to Recover Data
You use JD Edwards EnterpriseOne web client to recover data from applications that 
have erred or timed out due to:

■ Catastrophic errors 

■ Transaction failures

■ Session time outs

■ Voluntary save

Data saved from system failures is saved at the moment when the system errors, 
failures, or time outs occur. The Application Failure Recovery Applications program 
(P95400) enables you to access and recover data from any transaction from which you 
have saved data. Using P95400, you can view the data from failed transactions. You 
must be granted permission by an administrator to view data from applications that 
are not your own. For example, an administrator might give a sales department 
supervisor the permission to recover data from transactions performed by other users 
in the department. If you are unable to save data, check with your system 
administrator.

5.3.2 Retrieving All Records from the Database
Fetch All Records enables you to retrieve all records from the database that match your 
search criteria. JD Edwards EnterpriseOne then categorizes the records into larger 
groups so that you are able to view several records by scrolling through the grid, 
rather than having to view only ten at a time. The default number of records in a 
group is 200.

To fetch all records, click the Go to End button located on the blue bar on the grid. 

5.3.3 Voluntarily Saving Data
Your ability to save data voluntarily depends on whether or not your system 
administrator has this feature enabled or disabled. Access an application in which you 
have entered data.

1. Click Tools, then select one of these options:

Save

Save As

2. On Select Application Failure Header Label, select the check box if you want the 
JD Edwards EnterpriseOne to assign a label to the data you are saving. To 
manually enter a label and description, clear the box and enter a label and 
description in the respective fields.

Note: The label is a name you assign the data, like a filename. The 
description is a brief explanation that helps you identify what the data 
is.

3. Click OK.

JD Edwards EnterpriseOne saves the data you have entered in the application.
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5.3.4 Retrieving Data
The Failure Recovery Data and Application Saved Data links on the JD Edwards 
EnterpriseOne Menu opens the P95400 application.

Access the P95400 application.

1. On Work with Application Failure Records, search for data using these criteria:

From Saved Date and To Saved Date 

Type the dates between which the data for which you are searching was saved.

If you select one of the following options in addition to the dates you have entered 
in these fields, JD Edwards EnterpriseOne retrieves the data saved within the 
dates, and that matches the search criteria you specify.

View All

Click this option to view all of the data that was saved, including system failures, 
time outs, or voluntary saves.

View Failures

Click this option to view only that data that was saved due to system failure. 

View Saves 

Click this option to view only that data that was saved voluntarily. 

View Timeouts

Click this option to view only that data that was saved because the system timed 
out. 

2. Click Find. 

JD Edwards EnterpriseOne retrieves the data that matches the search criteria you 
entered. 

3. Click the record that contains the data you want to save.

On Saved Application Data, click the record or records containing the data you 
want to view. 

Note: Each record is a form within the application where data was 
saved. If no data was saved on the form, either because it was not 
saved voluntarily or because there was no data added to it (for 
example, Search/Browse form), you will see an N in the Data Saved 
(Y/N) column.

5.3.5 Viewing Data
After you have retrieved data, you view the information contained in the records.

1. Retrieve the data you want to view.

2. Select a record from the bottom grid, and then click View Data.

The information contained in the record displays in a read-only format.

5.4 Working with Tasks, User Options, and the Calendar
The section discusses how to:
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■ Filter tasks by role.

■ Use task profiles.

■ Work with user options.

■ Access the calendar.

5.4.1 Filtering Tasks by Role
You filter the tasks that you see by selecting a role. Each role contains its own set of 
tasks. When you log into JD Edwards EnterpriseOne using the *ALL role, you see only 
those tasks associated with a single role rather than a concatenation of all tasks 
associated with all roles.

In the web client, you view the other roles assigned to you by choosing the role from 
the Role drop-down menu located on EnterpriseOne Menu, and then clicking the 
button to the right of the field.

The tree view changes to show the tasks that are available to the role that you chose.

5.4.2 Using Task Profiles
For each task, you can view profile information about the task itself. To display the 
profile for a task, click the triangle to the right of the task and select Task Profile.

The Task Profiles window has three tabs: Basic, Intermediate, and Advanced. The 
information in the window varies based on the item currently selected. Some of the 
information on the tabs is described below:

■ Version resides on the Intermediate tab.

■ Object Name resides on the Intermediate tab.

■ Task ID resides on the Advanced tab. If you know an object's task ID, you can 
launch it directly from the Fast Path toolbar.

5.4.3 Working with User Options
When you click My System Options, the User Default Revisions form appears. The 
following list describes the associated action for each button on the User Default 
Revisions form:

Button Description

User Profile Revisions Launches the User Profile Revisions program (P0092). Only 
system administrators should change user profiles.

Change Password Launches the JD Edwards EnterpriseOne Security program 
(P98OWSEC), which you use to change your password.

Submitted Reports Launches the Work With Servers program (P986116), which 
you can use to review the status of a submitted report or 
job, change your report or job priority, work with the 
report output, and review errors.

Set Default Printer Launches the Printer Application program (P98616). Only 
system administrators should change default printer 
settings.
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5.4.4 Accessing the Calendar
The calendar enables you to enter and view time sensitive information, such has 
meetings and appointments. Depending on the permissions your system 
administrator has assigned you, you can view, add, delete, and modify activities listed 
in the calendar. You can view the calendar one day at a time, by the week, or by the 
month. Your system administrator determines the calendar view that you see.

This section discusses the default features and functionality that are available in the 
calendar. You might not see some of these features or might not be able to perform 
some functions due to your permissions. The default view for the calendar consists of 
one large calendar on the left with a Day tab, a Week tab, and a Month tab. Three small 
calendars are located on the right side. The first small calendar shows the month 
previous to the month displayed in the large calendar. The second calendar shows the 
month displayed in the large calendar. The third calendar shows the month following 
the month displayed in the large calendar. Today's date is highlighted in a yellow box 
in the appropriate small calendar. 

The large calendar and the three small calendars are fully interactive. Clicking in any 
calendar automatically adjusts the other calendars. For example, if you select a week in 
the large calendar, the week will be selected in the corresponding small calendar as 
well. 

You can double click in the large calendar to add an activity, if you have appropriate 
permissions. If you are adding an activity on the Day tab, double clicking on a time 
line automatically assigns a 30 minute time slot, which you can change. Clicking on 
the time located at the beginning of the line automatically assigns a 1 hour time slot, 
which you can change as well. If you your calendar displays an activity that exceeds 
24 hours, the activity displays in the All Day row at the top of the large calendar. The 
calendar automatically adjusts across time zones. For example, if someone schedules a 
meeting for 8:00 a.m. Pacific time, the activity will appear at 10:00 a.m. Central time. 

To access the calendar, type P01311 in the Fast Path.
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6Using Messages and Queues

This chapter contains the following topics:

■ Section 6.1, "Messages and Queues Overview"

■ Section 6.2, "Working with Messages"

■ Section 6.3, "Working with Queues"

6.1 Messages and Queues Overview
With JD Edwards EnterpriseOne, you can send and receive electronic mail (email) 
messages through the Work Center program. The JD Edwards EnterpriseOne email 
system includes messages sent by users and messages sent by a workflow process.

You can organize your messages by placing them into queues (storage areas for your 
messages) provided by the software or by setting up your own queues. This section 
explains how to work with your messages and with your queues. In addition, you can 
indicate your work-time location and add remarks to your time log.

6.1.1 Internal and External Messages
JD Edwards EnterpriseOne sends your email messages in different ways, depending 
upon whether the message is internal or external to the system.

Messages Description

Internal Messages Internal messages stay within the JD Edwards EnterpriseOne 
system. They are read using the Work Center.

External Messages External messages are sent to third-party email software 
packages such as Microsoft Outlook or Lotus Notes.

You system administrator configures your JD Edwards EnterpriseOne user account to 
receive either internal or external email. However, certain messages are sent as internal 
email regardless of this preference; for example, notifications of submitted UBE jobs.

6.1.2 Workflow Messages
In addition to sending and receiving internal and external messages, you can receive 
an active message, which is a type of message that a system workflow process 
automatically sends to a recipient.



Messages Description

Active Messages Workflow processes sometimes generate messages that require 
you to take action, such as approving or rejecting a change to a 
customer record. A lightning bolt button identifies an active 
message.

Active messages contain a shortcut button that links directly to 
an application. When you click the shortcut button, the system 
retrieves the most current information from the database, which 
ensures that you get accurate information even if changes are 
made after an active message is sent to you.

You can set up a workflow process to send active messages to 
specific queues.

Tutorial: Click here to view a recording of this 
feature.This tutorial shows the pre-9.1.5 user interface.
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6.1.3 Queues
Queues are storage areas that enable you to organize messages using the Work Center. 
For example, messages can be organized into queues for priority mail or for submitted 
jobs. Through a queue, users can approve or reject specific tasks in a workflow 
process. A queue is actually a UDC, and you set up a queue in the same way that you 
would set up a UDC.

6.1.3.1 Queues Provided with JD Edwards EnterpriseOne
JD Edwards EnterpriseOne provides these queues:

Queues Description

Sent Messages that you have sent to others.

Deleted Messages that you have deleted. After you delete a message, you 
can view it but you cannot move it to another queue.

The system administrator has the authority to purge deleted 
messages from the system, which is typically done periodically 
or on a predetermined schedule. You can also remove a message 
from the system by deleting it from your Deleted queue.

Submitted Jobs Messages generated by the system for jobs that you have 
submitted for batch processing, such as the General Ledger Post.

6.1.3.2 Workflow Queues
Workflow includes several predefined queues, but you might want to set up a custom 
queue for messages generated by processes that you create. For example, you might 
want to set up a queue for messages generated by a credit limit approval process. This 
queue would gather any approval or rejection messages related to credit limits for 
customers. A user could then open that queue and act on the message contained 
within it.

6.2 Working with Messages
This section contains the following topics:

■ Sending Messages

https://apex.oracle.com/pls/apex/f?p=44785:24:0::::P24_CONTENT_ID,P24_PREV_PAGE:6507,1
https://apex.oracle.com/pls/apex/f?p=44785:24:0::::P24_CONTENT_ID,P24_PREV_PAGE:6507,1
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■ Using Shortcuts

■ Using the Work Center

■ Printing Messages

6.2.1 Sending Messages
When you send internal e-mail messages, you send them to other users within JD 
Edwards EnterpriseOne software. You can control the time of delivery for a message 
by assigning a tickler date to the message. A tickler date is a date in the future when 
the system automatically shows the message. Assigning a tickler date is especially 
helpful if you plan to be out of the office on the day that you want others to receive 
your message, or if you want to remind yourself about upcoming meetings or other 
obligations.

When you send internal messages, you can also include an attachment. Attachments 
enable you to include files, images, or links that conform to the OLE standard, such as 
word processing documents and spreadsheets.

You can send messages to one or more recipients. If you are sending a message to 
multiple recipients, you can use a quick list, a predefined distribution list, or a role.

6.2.1.1 Sending an Internal Message to a Single Recipient
1. Open the Navigator drop-down menu, select Actions, and then select Work with 

Work Center.

2. On the Work with Work Center form, select New Message.

3. On Send Internal Mail, click the Search button in the "To: Address Number/ User/ 
Role" field.

4. On Address Number / User / Role, select one of the following options to search 
for a recipient by address number or user ID, and then click OK:

– Address Number

– User

5. Find and select the address number or user to whom you want to send the 
message.

6. Type the subject of the message in the Subject field.

7. Complete the following optional fields, as necessary:

– Keep Copy

– Receipt Notify

– Contact

– Address

– Tickler Date

– Phone Number

8. Type your message in the text area at the bottom of the form.

9. To include an attachment with your message, right-click the panel with the Text 
button.

10. Choose New, and then one of these options:

– Image
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– OLE

– Shortcut

– URL/File

11. Click OK to send the message.

If you opt to keep a copy of a message that you send, you can view it in the same 
queue from which you sent the message.

6.2.1.2 Using a Quick List to Send a Message to Multiple Recipients
1. Open the Navigator drop-down menu, select Actions, and then select Work with 

Work Center.

2. On the Work with Work Center form, select New Message.

3. On Send Internal Mail, select To:Quick List from the Form menu.

4. On Quick List, complete either of the following fields for each person you want on 
the list, and then click OK:

– Alpha Name

– Address Number

5. Follow the steps for sending an internal message to a single recipient.

Note: You cannot save a quick list.

6.2.1.3 Sending a Message to Members of a Role
1. Open the Navigator drop-down menu, select Actions, and then select Work with 

Work Center.

2. On the Work with Work Center form, select New Message.

3. On Send Internal Mail, click the Search button in the "Send To Address Number / 
User / Role" field.

4. On Address Number / User / Role, select the Role option, and then click OK.

5. Highlight the row that contains the role that you want to use and then click Select.

6. Follow the steps for sending an internal message to a single recipient.

6.2.2 Using Shortcuts
With the JD Edwards EnterpriseOne messaging system, you can send messages that 
contain a shortcut to a JD Edwards EnterpriseOne application. When you send a 
shortcut, you can preface it with a message for the recipient to review and approve. 
For example, you might want your manager to approve a change that you made to a 
customer record. After sending a shortcut to your manager, he or she can view the 
record immediately by clicking the shortcut button. When you send a shortcut, the 
system sends the key for that particular record to the recipient. When the recipient 
clicks the shortcut button, the system opens the application and retrieves the record.

The JD Edwards EnterpriseOne system uses workflow to automatically send messages 
with a shortcut to an application. These types of messages, called active messages, 
require that the recipient open the shortcut to verify information or approve a 
transaction.
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Since JD Edwards EnterpriseOne software supports Windows and Web clients, the 
message can contain a shortcut for a Windows application or a Web application. 

6.2.2.1 Sending a Non-Workflow Shortcut
From the application from which you want to create a shortcut, access any records you 
want the recipient to view.

1. Open the Tools drop-down menu and select Send Shortcut.

The Send Shortcut form appears with a shortcut to the application.

2. On Send Shortcut, complete these fields:

– Address Number, User, Role, or Distribution List

– Mail Box (Internal Messages Only)

– Subject

3. Type your message.

4. Click OK to send the message.

6.2.3 Using the Work Center
Use the Work Center to send and receive internal email messages within the JD 
Edwards EnterpriseOne system. Work Center enables you to perform standard email 
functions. 

6.2.3.1 Viewing Messages
You can view your messages in the Work Center. Messages sent from other users will 
appear in either your Personal In Basket queue or, if you set them up, your Priority 
Mail and Secondary queues. You can also view workflow messages, or active 
messages, sent by a workflow process.

Note: If you cannot view messages, make sure that queue security is 
set up to enable you to view the Address Book number and queue that 
you want to view.

To view messages:

1. Open the Navigator drop-down menu, select Actions, and then select Work with 
Work Center.

2. On Work Center, expand a queue that contains a message.

Unless the All Queues check box is selected, only those queues that contain mail 
will display. Any messages in that queue appear. Messages that have not been 
viewed appear in bold.

3. Click the message that you want to view.

The message appears in the view area on the right side of the Work Center form.

Tutorial: Click here to view a recording of this 
feature.This tutorial shows the pre-9.1.5 user interface.
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6.2.3.2 Revising Messages
You can revise the text of messages in any of your queues. This feature opens up the 
actual message and enables you to change the text or add new text.

To revise messages:.

1. Open the Navigator drop-down menu, select Actions, and then select Work with 
Work Center.

2. On Work Center, select the message that you want to revise.

3. From the Row menu, select Message Revisions.

4. On the Message Revisions form, change any of the following fields and then click 
OK:

– From

– Contact

– Subject

– Phone Number

– Tickler Date

– Text area

6.2.3.3 Moving a Message to Another Queue
You can move a message from one queue to another. For example, you might want to 
move a message from your Priority queue to your Personal To Do List queue.

To move a message to another queue:

1. Open the Navigator drop-down menu, select Actions, and then select Work with 
Work Center.

2. On Work Center, click the All Queues option if the target queue to which you want 
to move the message does not appear.

3. Click and drag the message to the target queue.

4. To verify the placement of the message, double-click the target queue and view the 
contents.

6.2.3.4 Redirecting Messages to the Priority or Secondary Queue
You can redirect messages that you receive from an individual to your Priority Mail 
queue. When you do this, the system sends all future messages from that individual 
directly to your Priority Mail queue. Alternatively, you can redirect messages from an 
individual to your Secondary queue.

Note: To redirect messages to the Priority Mail or Secondary queue, 
you must follow these steps and not the ones for moving messages. 
Moving messages only moves individual messages, whereas 
redirecting messages to the Priority Mail or Secondary queue affects 
all messages from that user until you remove the designation.

Although you can move a message to the Archived or Deleted queue, 
the system does not redirect future messages from the sender to that 
queue. You must manually move the sender's message to the 
Archived or Deleted queue each time.
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You can redirect messages from more than one person to your Priority Mail and 
Secondary queues. You can also prevent messages from being delivered to a specific 
queue.

To redirect messages:

1. Open the Navigator drop-down menu, select Actions, and then select Work with 
Work Center.

2. On Work Center, select the message that you want to redirect to your Priority Mail 
or Secondary queue.

3. From the Row menu, select one of these options:

– Priority

– Secondary

4. Expand the target queue to verify the placement of your message.

Any further messages that you receive from this sender will arrive in the queue 
that you selected. Repeat these steps for redirecting other users' messages.

6.2.3.5 Canceling the Delivery of Messages
If you decide that you no longer want the system to automatically redirect messages 
from an individual to a Priority Mail queue, you can cancel the automatic delivery of 
messages to your Priority Mail or Secondary queue.

To cancel the delivery of messages:

1. Open the Navigator drop-down menu, select Actions, and then select Work with 
Work Center.

2. On Work Center, select a message from the user for which you want to cancel 
automatic delivery.

3. From the Row menu, select Remove.

4. Move any other messages from this particular sender out of the Priority Mail or 
Secondary queue.

As long as you keep any messages in your Priority Mail or Secondary queue from 
the sender whom you removed, future messages from that sender will appear in 
that queue.

6.2.3.6 Reassigning Messages
The messaging system enables you to reassign a message to another user after the 
message is sent to the original recipient. This process changes whose queue the 
message appears in. For example, if you originally sent a message to Jim, you can 
reassign that message to Betty. The message will now be in Betty's queue and will not 
be in Jim's queue. You can also reassign messages that you receive.

Note: You can only reassign messages in other users' queues if your 
queue security enables.

To reassign messages:

1. Open the Navigator drop-down menu, select Actions, and then select Work with 
Work Center.
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2. On Work Center, select the message that you want to reassign, and then, from the 
Row menu, select Reassign.

3. On Assign Message, complete these fields and click OK:

– Address Number / User / Role

– Queue Designator

6.2.3.7 Deleting Messages
To delete a message, drag the message to the Deleted queue. Alternatively, select the 
message and click Delete.

You cannot recover a message after you move it to the Deleted queue. It remains in 
your Deleted queue until your system administrator purges messages, which is 
typically done on a periodic or predetermined schedule. Alternatively, you can remove 
a message from the system by deleting it from your Deleted queue.

6.2.4 Printing Messages
You might find that you want a printed copy of a message for your records. You can 
do either of these tasks:

■ Print a message.

You can print a message from any of your queues.

■ Print a report that lists all messages within a queue.

This report includes a summary for each message. The two types of message 
reports are:

– Message Center - Summary

– Message Center - Detail

These reports show the sender and recipient of the message, as well as the subject 
of the message. The detail report shows the content of each message.

6.2.4.1 Printing a Message
To print a message:

1. Open the Navigator drop-down menu, select Actions, and then select Work with 
Work Center.

2. On Work Center, select the message that you want to print.

3. From the Row menu, select Print.

4. On Printer Selection, click OK.

6.2.4.2 Printing a Report that Lists All Messages in a Queue
To print a report that lists all messages in a queue:

1. Open the Navigator drop-down menu, select Actions, and then select Work with 
Work Center.

2. On Work Center, select the message queue that you want to print.

3. From the Form menu, select Print.

4. On Work with Batch Versions - Available Versions, select the version and submit 
the report.
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6.3 Working with Queues
Queues are a way to group related messages together in the Work Center. This topic 
describes how to manage your queues by creating new ones or adding security. As 
with a message, you can also add a shortcut to a queue.

You set up queues in the system as UDCs. The following task describes how to create 
queues or modify existing queues.

6.3.1 Setting Up a Queue
Access the Work With User Defined Codes form.

1. On Work With User Defined Codes, click Add.

2. On User Defined Codes, complete the following fields in an empty row on the grid 
and click OK:

– Codes

Enter a unique number for the queue.

– Description 1

Enter a name for the queue.

– Description 2

– Special Handling

– Hard Coded

Enter N in this field.

Codes
A list of valid codes for a specific user defined code list.

Description 1
A user defined name or remark.

Description 2
Additional text that further describes or clarifies a field in the system.

Special Handling
A code that indicates special processing requirements for certain user defined code 
values. The value that you enter in this field is unique for each user defined code 
type.Programming is required to activate this field.

Hard Coded
A code that indicates whether a user defined code is hard-coded. Values are:

Y

The user defined code is hard-coded

N

The user defined code is not hard-coded

A check mark indicates that the user defined code is hard-coded.
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6.3.1.1 Specifying the Queues that a User Can View
You can change the security status for a user or group of users within a queue. You can 
either give a user authority to monitor every queue within a group, or you can deny 
users access to certain queues.

You can add security by user, distribution list, or role. For example, you might want to 
set up security so that a manager can monitor all messages within certain queues. Or 
you might set up security by distribution list or role so that users within the group 
have authority to monitor certain queues.

If you want to give only a few people within a distribution list or a role access to 
certain queues, you enter the distribution list or the role, and then enter the users' 
address book numbers to define which queues those users in the group can access.

Access the Work With Workflow Message Security form.

1. On Work With Workflow Message Security, click Add.

2. On Workflow Message Security Revisions, complete these fields:

– User

– Group/Role

3. Specify the queues that a user can view by completing the Authority Y/N field 
and clicking OK.

User
A user in the workflow system. This can also be a group.

Group/Role
A group or list of users in the workflow system. The address book number that 
identifies a list of users in the workflow system.

Authority Y/N
Indicates whether the user is authorized to make changes to security information.

--- FORM SPECIFIC ---

For workflow, indicates whether the user can view other queues in the Work Center.

6.3.2 Logging Time and Adding Remarks
The Work Center enables you to inform others of your whereabouts. You can specify 
when you are in or out of the office by using the Check In and Check Out options. You 
can add remarks to your check out to provide detailed information about where you 
are. You can view this information from the Time Log form.

6.3.2.1 Checking In and Out 
Checking in and out informs others of your whereabouts. When you check out, you 
can also enter a remark, return date, and return time. If you do not enter a remark, the 
system supplies the wordhome. If you do not enter a return date, the system enters the 
next business day. The check in and check out information that appears on the Time 
Log form is discussed later in this topic.

Access the Work With Employee Queue Manager form.

1. On Work With Employee Queue Manager, locate and select your record.

2. From the Row menu, select one of these menu options:

– Check In



Working with Queues

Using Messages and Queues 6-11

– Check Out

Each time you select Check In or Check Out, the system updates your status, 
which you can view from the Time Log.

6.3.2.2 Entering Remarks
You can enter a remark to provide more information about your whereabouts, your 
schedule, and so on. For example, you might enter a remark indicating that you are in 
a meeting, on vacation, or can be reached at a particular phone number. You can 
update an existing remark.

Access the Work With Employee Queue Manager form. 

1. On Work With Employee Queue Manager, locate and select your record.

2. From the Row menu, select Remark.

3. On the Check In/Out and Update Remark form, select the Update Remark option.

4. Enter your remark in the Remark field.

5. The following fields in the Return area are optional; complete them if necessary:

– Return Time

– Return Date

6. Click OK.

7. To view your remark, click Find on Work With Employee Queue Manager.

6.3.2.3 Viewing Time Logs
You can view the times when you or other employees check in and out, and you can 
view any remarks.

Access the Work With Employee Queue Manager form.

1. On Work with Employee Queue Manager, select the employee record time log that 
you want to view.

2. From the Row menu, select Time Log.
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7Using Media Object Attachments

This chapter contains the following topics:

■ Section 7.1, "Media Object Attachments Overview"

■ Section 7.2, "Using Media Objects"

■ Section 7.3, "Attaching Media Objects"

■ Section 7.4, "Searching for Media Objects"

■ Section 7.5, "Using Templates"

■ Section 7.6, "Setting Media Object Properties"

■ Section 7.7, "Enabling Metadata for Media Objects"

■ Section 7.8, "Attaching OLE Objects at the Base Form Level"

7.1 Media Object Attachments Overview
JD Edwards EnterpriseOne software media objects and imaging features enable you to 
attach useful information to an application, including information that might currently 
exist as a paper-based document. The media objects feature enables you to attach the 
information to JD Edwards EnterpriseOne software applications, forms and rows, and 
Object Librarian objects. The imaging feature within media objects gives you the 
flexibility to create an efficient method of information storage.

Use media objects to link information to applications, either to individual rows in a 
grid or to a form. The following list discusses the types of information that you can 
attach to a grid row or form:

Information Description

Text The media objects functionality includes a word processor that lets 
you create a text-only attachment. For example, you could use a 
text attachment to provide specific instructions for a form or 
additional information about a record.

Image Images include files such as Windows bitmaps, Graphics 
Interchange Format (GIF) files, and Joint Photographic Experts 
Group (JPG) files. These files might represent electronically created 
files as well as scanned images of paper-based documents.
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System administrators can set up templates that might include their own attachments, 
such as images and shortcuts. For example, you can create a letterhead and a standard 
form for a memo. Also, you might create a shortcut, to be included in the template, 
that provides access to an application that uses data specific to the information that 
you add to the template.

Each time you save a media object, whether it is a new media object, or whether you 
have modified an existing one, EnterpriseOne timestamps the media object with your 
user ID, the date, and time. This information appears in the upper right corner of the 
media object. The information that displays is retrieved from the Enterprise server, so 
if your Enterprise server resides in a different time zone, the time and date that 
displays will be different than the time zone in which you are working. For example, if 
you work in the Eastern time zone, but the Enterprise server you are using resides in 
the Pacific time zone, the date and time that is recorded when you save the media 
object is Pacific time.

Note: If you open a Microsoft Excel OLE media object, place the 
cursor in the spreadsheet, then click Save, EnterpriseOne timestamps 
the media object even if you have not made changes. 

7.2 Using Media Objects
You can use the Media Objects feature to add text, graphics, and other objects to forms 
and records. For example, you can use a text attachment to explain special 
circumstances surrounding a journal entry. Or you can attach drawings, animations, 
and other types of objects to forms and records. A pop-up menu provides access to 
established templates for attachments and an option to set the properties for the Media 
Objects form.

When you attach a media object to a form, the attachment might not be available if you 
access different data on the form. For example, if you attach a media object to a detail 

Object Linking and 
Embedding (OLE)

Media objects can be files that conform to the OLE standard. OLE 
enables you to create links among different programs. Using these 
links, you can create and edit an object from one program through 
a different program. JD Edwards EnterpriseOne software provides 
the links that you need to attach OLE objects.

You attach OLE media objects at the base form level. Media objects 
attached at this level are attached to a form and not to any data that 
might appear in the form. You can attach media objects to a grid 
row or a form, but the files themselves exist in separate directories. 
The only file information included with the application to which 
the OLE links is the path to the supporting file.

You can only use OLE objects that you properly register and install 
as OLE objects through Windows.

JDE shortcuts A JDE shortcut is a link that opens a JD Edwards EnterpriseOne 
software application. Within media objects, you can only attach JD 
Edwards EnterpriseOne software shortcuts; you cannot attach 
shortcuts to third-party applications.

Uniform Resource 
Locators (URL)/files

Media objects can be links to Web page URLs or other related files. 
When a developer attaches a URL media object to a control object 
on a form, the Web page appears as part of the form. When a user 
attaches a URL to a form or Object Librarian object, the media 
object acts as a link to the URL.

Information Description
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form that contains data for Order Number 2002, this attachment does not appear on 
the detail form that appears when you access data for Order Number 3003. The base 
form, which in this case is a detail form, is the same for both Order Numbers, but the 
data associated with the form is specific to each Order Number. The Order Number 
represents the key to the location where an attachment is stored.

JD Edwards EnterpriseOne software supports Object Linking and Embedding (OLE). 
OLE enables you to create links among different programs. Using these links, you can 
save an object from one program into a different program. The system provides the 
links that you need to attach OLE objects. You can attach OLE objects as media objects 
and at the base form level. When you attach an object at the base level of the form, you 
attach the object to the form and not to any data that might appear in the form.

If attachments exist for a form, a paper clip button appears at the right of the status bar 
when you open the form. For an OLE object attached at the base form level, a 
document button appears at the right of the status bar.

When a form first opens, grid rows do not indicate whether attachments exist for the 
corresponding records. You can perform a search on every record that the system loads 
onto your workstation or you can search each record to determine whether 
attachments exist for records.

The Text feature includes a word processor that lets you create, view, edit, and delete 
notes. When you create a text attachment, you can also set up templates. You can use 
templates to create a format for a frequently used media object.

7.2.1 HTML Media Objects
The HTML editor offers eight font faces (Arial, Courier New, Comic Sans, Georgia, 
Helvetica, Impact, Tahoma, Times New Roman) and font size from HTML size 1 to 7. 

Note: The font appearance is dependent on the browser being used. 

Note: : Tab space is not supported in the HTML editor. 

When the HTML mode is enabled and you access an existing ActiveX attachment you 
are presented with two options: 

1. Download File

2. Data conversion

The data conversion option converts the ActiveX text to HTML and is displayed in the 
HTML editor.

Note: : Once the data is converted and saved to the database in 
XHTML it cannot be returned to the ActiveX RTF format. 

The ActiveX rich text editor supports font sizes from 10 to 72 pts, the HTML editor 
supports HTML font size 1 to 7. The font mapping for the data conversion is listed 
below. 

ActiveX Font Size HTML Font Size

10 2
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If a company switched from HTML mode to ActiveX mode after attachments were 
created the attachments will be read-only.

7.2.2 Checking for Attachments
To find out whether an attachment exists for a record, you must first perform a search 
on the record. You can perform this search on one record or on a number of records 
simultaneously. The system only searches for attachments on records that you load 
onto your workstation. For example, when you initially click the Find button to locate 
a number of records, only the records that appear in the grid exist on your 
workstation. Use the page buttons to view more records.

Access a form with the attachments feature available.

To check for all attachments:

On a form with the attachments feature available, click the Search for Attachments 
button to the left of the row of column titles. This button looks like a paper clip 
overlapping a magnifying glass.

A paper clip button appears in the row header for each loaded record with an 
attachment.

7.2.3 Checking for Attachments for a Single Row or a Range of Rows
Access a form with the attachments feature available.

1. On a form with the attachments feature available, hold the cursor over the row 
header for the grid row.

If an attachment exists for the row, a paper clip button appears in the row header.

2. Move the cursor up or down in the row header column to search for attachments 
for adjacent rows.

7.3 Attaching Media Objects
Use the Attachments feature to attach text, photos, drawings, spreadsheets, video 
images, sounds, and application shortcuts to forms and grid rows. For example, you 
might attach the image of an invoice to a data entry record, attach a legal document to 
a record that describes a contractual agreement, or attach text that describes a process 
on a form. The attachments feature is not available on all forms.

Note: You cannot create attachments until an administrator has 
established and mapped media object queues as described in Media 
Objects and Imaging in the System Administration Guide.

11, 12 3

13, 14 4

16, 18 5

20, 22, 24 6

26, 28, 36, 48, 72 7

ActiveX Font Size HTML Font Size
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When you enter text, you can format the paragraphs and run a spell check. JD 
Edwards EnterpriseOne software also supports object linking and embedding (OLE).

7.3.1 Attaching Text
Access a form with the attachments feature available.

1. On a form where attachments are available, do one of these tasks:

– To attach text to a form, from the Form menu, select Attachments.

If attachments exist for the form, click the paper clip button to the right of the 
status bar.

– To attach text to a grid row, select the row and then, from the Row menu, 
select Attachments.

The Media Objects workspace is split into two panels. The left panel is the 
button panel and the right panel is the viewer panel. Icons for any files 
previously attached to the record appear in the button panel.

2. Do one of these tasks:

– From the File menu, select New, and then Text.

– In the button panel, click the right mouse button, select New, and then select 
Text from the pop-up menu.

3. In the viewer panel, type the desired text.

4. When you finish, from the File menu, select Save and Exit.

You can use the formatting tools at the top of the viewer panel to format the text of 
your note.

7.3.2 Spell Checking Text Media Objects
EnterpriseOne enables you to spell check text media objects. When you run spell 
checker, EnterpriseOne displays your text in a read-only field, and highlights each 
word in red that it identifies as a possible error. It displays why it identified the item as 
an error, and provides suggestions to correct it. You can choose a suggestion, manually 
correct the word in Replace With field, or ignore the word.

You can enable or disable the items you want spell checker to identify as possible 
errors. The list below shows which items are enabled or disabled by default:

1. Ignore All-Caps Words Option - Disabled.

2. Ignore Words with Numbers Option - Disabled.

3. Ignore Words with Mixed Case Option - Disabled.

4. Ignore Domain Names Option - Enabled.

5. Report Doubled Words Option - Enabled.

6. Case Sensitive Option - Enabled. 

7. Suggest Split Words Option - Enabled. 

If the language preference setting you are using is not supported by the spell checker, 
you will receive an error when you try to spell check your text media objects. 

To spell check your text media objects:

1. Click the Spell Check icon located on the media object control toolbar.
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2. On Spell Checker, choose one of the following options:

– Change

Click this option if you accept the suggestion displayed in the Replace With 
field. You can also manually change the word in the Replace With field, and 
click Change.

– Change All

Click this option if you want spell checker to automatically replace every 
instance of the word with the suggestion displayed in the Replace With field. 
You can also manually change the word in the Replace With field, and click 
Change All.

– Ignore

Click this option if you want to disregard that the word displayed in the 
Problem field is an error.

– Ignore All

Click this option if you want to disregard that all instances of the word 
displayed in the Problem field is an error.

– Show Options

Click this option to display a list of the items spell checker identifies as 
possible errors. Click the check box to enable or disable any item. 

–

3. Click OK to close the Spell Checker.

7.3.3 Attaching a File
Access a form where attachments are available.

1. On a form where attachments are available, do one of these tasks:

– To attach an image to a form, from the Form menu, select Attachments.

If attachments exist for the form, click the paper clip button to the right of the 
status bar.

– To attach an image to a grid row, select the row and then, from the Row menu, 
select Attachments.

2. On Media Objects, do one of these tasks:

– From the File menu, select New and then Image.

– In the button panel, click the right mouse button, select New, and then select 
Image from the pop-up menu.

3. Complete these options:

– Queue Name

– Files of Type

The Preview option contains a default check mark to display a sample of the 
selected image. Toggle this option to display or hide the preview image.

4. Choose an image, and then click OK.

If the system supports the graphic format, the image appears in the viewer panel.
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5. When you finish, from the File menu, select Save and Exit.

Field Explanation

Queue Name The name of the directory where the image file exists.

Files of Type The list of file extensions that the system supports. For example, 
file types might include .bmp for a Windows bitmap, .gif for a 
graphics interchange format file, and .jpg for a joint 
photographic experts group file.

7.3.4 Attaching an OLE Object
Access a form where attachments are available.

1. On a form where attachments are available, do one of these tasks:

– To attach an OLE object to a form, from the Form menu, select Attachments.

If attachments exist for the form, click the paper clip button to the right of the 
status bar.

– To attach an OLE object to a grid row, select the row and then, from the Row 
menu, select Attachments.

2. On Media Objects, do one of these tasks:

– From the File menu, select New and then OLE.

– In the button panel, click the right mouse button, select New, and then select 
OLE from the pop-up menu.

3. On Insert Object, to create a new object, select an object type and click OK.

Selections vary from system to system depending on what the system 
administrator installs on your workstation and on the network.

4. Create your object.

5. To attach an existing object, select Create from File, locate the object on your 
system, and then click OK.

Depending on whether you create an object or attach an existing object, the 
application associated with the object displays in the viewer panel either a blank 
workspace or the existing object.

The menu bar displays the menus for the application from which you call the 
object. For example, if you select an Excel document, the Excel menus display on 
the menu bar.

6. On Media Objects, edit the object in the viewer panel as necessary.

7. When you finish, from the File menu, select Save and Exit.

7.3.5 Attaching a Shortcut
Access a form where attachments are available.

Include a shortcut to provide access directly from a record to an associated application.

1. On a form where attachments are available, do one of these tasks:

– To attach a shortcut to a form, from the Form menu, select Attachments.

If attachments exist for the form, click the paper clip button to the right of the 
status bar.
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– To attach a shortcut to a grid row, select the row and then, from the Row 
menu, select Attachments.

2. On Media Objects, do one of these options:

– From the File menu, select New and then Shortcut.

– In the button panel, click the right mouse button, select New, and then select 
Shortcut from the pop-up menu.

3. On the Open form, browse through your files, select the appropriate shortcut, and 
click Open.

Your shortcut appears in the viewer panel.

4. When you finish, from the File menu, select Save and Exit.

7.3.6 Attaching a URL or File
Access a form where attachments are available.

Attach a URL to provide access to a Web page or a file on a disk. You can also attach 
file types that cannot be attached as images or OLE files, such as bitmaps.

1. On a form where attachments are available, do one of these tasks:

– To attach a URL or file to a form, from the Form menu, select Attachments.

If attachments exist for the form, click the paper clip button to the right of the 
status bar.

– To attach a URL or file to a grid row, select the row and then, from the Row 
menu, select Attachments.

2. On Media Objects, do one of these tasks:

– From the File menu, select New and then URL/File.

– In the button panel, click the right mouse button, select New, and then select 
URL/File from the pop-up menu.

3. On Add URL/File, browse your files or queues, select the appropriate URL or file, 
and click Open. You can also type a URL in the field.

4. Click OK.

Your URL or file appears in the viewer panel. If you are attaching a URL, a 
download dialog box appears. You can either verify that the URL is active or you 
can click Cancel.

5. When you finish, from the File menu, select Save and Exit.

7.3.7 Attach Media Objects Directly from Applications (Release 9.1 Update 3)
This feature allows you to manage media objects directly from applications. The 
Manage Media Object system function can be invoked from the Event Rule (ER), to 
bring up the Manage Media Object window. This system function can be used on any 
control such as a Link, Button or clickable image.

The following screenshot is an example of the Manage Media Object window. 
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Figure 7–1 Manage File Attachments

 See Media Object System Functions in the JD Edwards EnterpriseOne Tools Form 
Design Aid Guide

7.4 Searching for Media Objects
You can search for a specific media object in the system by using information such as 
creation date, alternate keys, or UDCs.

Note: You can only search for media objects that already have codes 
defined for them and that your system administrator has made 
available to all users in the system.

7.4.1 Searching for a Media Object
Access a form where attachments are available.

1. On a form where attachments are available, do one of these tasks:

– To search for a media object to attach to a form, from the Form menu, select 
Attachments.

If attachments exist for the form, click the paper clip button to the right of the 
status bar.

– To search for a media object to attach to a grid row, select the row, and then 
from the Row menu, select Attachments.

2. On the Media Objects form, do one of these tasks:

– From the File menu, select New and then Search.

– In the button panel, click the right mouse button, select New, and then Search 
from the pop-up menu.

3. On the Media Object Search form, complete the Type field and click Find.

Enter the type of media object attachment for which you are searching. You can 
use the Query by Example line to limit your search.

Only attachments with defined metadata appear.

4. Choose an attachment and click Select.

Your media object appears in the viewer panel.
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5. When you finish, from the File menu, select Save and Exit.

7.4.2 Renaming Attachments
When you add an attachment, the system displays its filename under its button in the 
button panel. You can rename the button to make it more meaningful to other users if 
you want.

Access media objects.

1. On the Media Objects form, select a button and do one of these tasks:

– From the File menu, select Rename.

– In the button panel, click the right mouse button and select Rename from the 
pop-up menu.

2. Type a new name for the button and then click anywhere on the form.

7.4.3 Deleting Media Objects
When you no longer need an attachment, use the Delete feature on Media Objects to 
remove the object. When you delete text, the text is permanently erased. When you 
delete images and OLE objects, you remove the attachment of the file to the record. 
The system continues to store a file for the object.

Access a form where attachments are available.

1. Complete one of these tasks:

– To delete an attachment to a form, from the Form menu, select Attachments.

If attachments exist for the form, click the paper clip button to the right of the 
status bar.

– To delete an attachment to a grid row, select a row with a paper clip button, 
and then, from the Row menu, select Attachments.

2. On the Media Objects form, select the appropriate button in the button panel and 
then select Delete from the File menu.

3. On Confirm Media Object Delete, click Yes to confirm the deletion.

The button disappears from the button panel.

4. When you finish, from the File menu, select Save and Exit.

7.5 Using Templates
This section discusses how to:

■ Create a template

■ Attach a template

■ Modify a template

■ Delete a template

■ Delete a template with media objects
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7.5.1 Creating a Template
On the Media Objects form, you can access the Work With Media Objects Templates 
form. On this form, you can attach, create, modify, and delete templates to help you 
format your text attachments.

Access a form where attachments are available.

1. Select the row from which you want to attach a template, and then select 
Attachments from the Row menu.

2. On the Media Objects form, in the button panel, click the right mouse button and 
select Templates from the pop-up menu.

3. On the Media Objects Template form, click Add.

4. On the Media Object Template Revisions form, complete these fields, and then 
enter your template information into the workspace:

– Template Name

– Description

5. Click Add.

7.5.2 Attaching a Template
Access a form where attachments are available.

1. Select the row to which you want to attach a template, and then select 
Attachments from the Row menu.

2. On the Media Objects form, in the button panel, click the right mouse button and 
select Templates from the pop-up menu.

3. On the Work With Media Object Templates form, click Find.

You can use the query-by-example line to refine your search.

4. To preview the template, double-click the paper clip button in the row header.

5. Choose the grid row for the template that you want to attach, and then click Select.

6. The template appears in the workspace on Media Objects.

7.5.3 Modifying a Template
Access a form where attachments are available.

1. Select the row from which you want to modify a template, and then select 
Attachments from the Row menu.

2. On the Media Objects form, in the button panel, click the right mouse button and 
then select Templates from the pop-up menu.

3. On the Work With Media Object Templates form, click Find.

You can use the Query by Example line to refine your search.

4. Choose the grid row for the template that you want to modify and then click 
Select.

5. On the Media Objects form, modify the template as necessary and then from the 
File menu, select Save and Exit.
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7.5.4 Deleting a Template
Access a form where attachments are available. 

1. Select the row from which you want to delete a template, and then select 
Attachments from the Row menu.

2. On the Media Objects form, in the button panel, click the right mouse button and 
then select Templates from the pop-up menu.

3. On the Work With Media Object Templates form, click Find.

You can use the Query By Example line to refine your search.

4. Choose the grid row for the template that you want to delete, click Delete, and 
then on Confirm Delete, click OK.

7.5.5 Deleting a Template on Media Objects
Access a form where attachments are available.

1. Select the row from which you want to delete a template, and then select 
Attachments from the Row menu.

2. On the Media Objects form, in the button panel, select the text button for the 
template, and then select Delete from the File menu.

3. On the Confirm Media Object Delete form, click Yes.

The template and the text button disappear.

7.6 Setting Media Object Properties
The pop-up menu that appears when you right-click in the button panel on the Media 
Objects form provides you with the option to view and, for some objects, to change the 
properties of an object. Each object has unique properties.

In addition, you can define metadata for an object. Metadata contains information 
about the object, such as a description of the object, who created it, and when it was 
created. Other users can search for the object based on this information.

Access Media Objects.

1. On the Media Objects form, in the button panel, right-click and then select 
Properties.

The form or row must contain an attachment in order to access the Media Objects 
properties.

2. On the Properties form, review the "Technical information about the key for the 
form" on the Key Information tab.

3. Click the Flags tab and review this information:

– Allow Text Items

– Allow Image Item

– Allow OLE Items

– Allow RTF Text

– Show Text Item On Open

– Read Only
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7.6.1 Setting Text Properties
Access Media Objects.

1. On the Media Objects form, in the button panel, right-click a text button, and then 
select Properties from the pop-up menu.

2. On the text properties form, review these fields on User Audit Information:

– Created by

– Date Created

– Time Created

– Updated By

– Date Updated

– Time Updated

3. Click the Printing Information tab and then do the following, if necessary:

– Click the Check to print before report item option

– Complete the Effective From field

– Complete the Effective To field

7.6.2 Setting Image Properties
Access Media Objects.

1. On the Media Objects form, in the button panel, right-click an image button, and 
then select Properties from the pop-up menu.

2. On the Image Properties tab, review these fields:

– File Name

– Queue Name

– Queue Path

3. To give the image a title, complete the Description field.

7.6.3 Viewing OLE Properties
Access a form where attachments are available.

1. On the Media Objects form, in the button panel, right-click an OLE object button, 
and then select Properties from the pop-up menu.

2. On the OLE Object Properties tab, review these fields:

– File Name

– Queue Name

– Queue Path

7.6.4 Setting Shortcut Properties
Access Media Objects.

1. On the Media Objects form, in the button panel, right-click a shortcut button, and 
then select Properties from the pop-up menu.
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2. On the JDEShortcut Control Properties form, review these fields on the General 
tab:

– Menu Name

– Selection

– Icon File

– Icon Index

3. Do these tasks, if necessary:

– Click the Colors tab to set the color for the shortcut hypertext.

– Click the Fonts tab to set font properties such as size, family, bold, italics, 
underline, and strikeout.

7.7 Enabling Metadata for Media Objects
The system enables you to add information to media objects in the form of metadata. 
Metadata can include items such as author, creation date, and language of the media 
object attachment.

Before you can add metadata, you must enable the metadata fields for the media 
object in the Media Object Category Constants program (P00167).

7.7.1 Enabling Metadata Fields
To enable metadata fields for media objects:

From the GH9016 menu, select Media Object Constants (P00167).

1. On the Work With Media Object Category Constants form, find the media object 
that you want to enable.

The system enables the metadata fields for all the media objects that are associated 
with the media object that you select.

2. Highlight the media object and then click Select.

3. On the General tab of the Media Object Category Constants Revisions form, select 
the check boxes next to the available metadata field options to enable those 
metadata fields in the media object.

4. Click OK.

7.7.2 Viewing and Defining Metadata
Access a form with an attachment. 

1. On any form with an attachment, in the Media Objects button panel, right-click an 
object button, and then select Characterize Object from the pop-up menu.

2. On the Media Object Category Revisions form, click the General tab, and then 
complete the available fields for the media object.

3. Click OK.

Description Glossary

Description A short description to describe what the media object is about.

Author This is the author of the media object document or attachment.
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7.8 Attaching OLE Objects at the Base Form Level
At the base level of a standard form, you can attach OLE objects using the OLE Objects 
button on the Links toolbar. Menu bars and toolbars appear on all standard forms. 
When you attach an OLE object at the base level of a form, rather than associating the 
attachment with a record, the OLE object attaches only to the form. No matter what 
record appears on the form, the OLE object that you attach using the OLE Objects 
button will always appear when you open the form.

Access a standard form.

1. Complete one of these tasks:

– From the Links toolbar, select Preferences, and then OLE Objects.

– From the Preferences menu, select OLE Objects.

– If attachments exist for the form, click the document button to the right of the 
status bar.

2. On the Choose Queue form, select the appropriate queue.

Note: If you do not know the queue in which the object you want to 
attach exists, ask your system administrator.

3. On the OLE Objects form, do one of the following:

– From the File menu, select Add Object.

– In the button panel, click the right mouse button and then select Add Object.

4. On Insert Object, to create a new object, select the type of object that you want to 
create and then click OK.

Selections vary from system to system depending on what the system 
administrator installs on your workstation and on the network.

5. Create your object.

6. To attach an existing object, select Create from File, locate the object on your 
system, and then click OK.

Depending on whether you create an object or attach an existing object, the 
application associated with the object displays either a blank workspace or the 
existing object in the viewer panel.

The menu bar displays the menus for the application from which you call the 
object. For example, if you select an Excel document, Excel menus display on the 
menu bar.

7. Edit the object in the viewer panel.

8. To return to the main form, click the Cancel button on the OLE Objects form in the 
application workspace.

Creation Date For World, used in the DDS specifications for IBM's file-field 
reference display.

Status Indicate if this media object is active or obsolete.

Description Glossary
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7.8.1 Deleting OLE Objects at the Base Form Level
Access a standard form.

1. Complete one of these tasks:

– From the Links toolbar, select Preferences and then select OLE Objects.

– From the Preferences menu, select OLE Objects.

– Click the document button to the right of the status bar.

2. On the OLE Objects form, select the object and complete one of these tasks:

– From the File menu, select Delete Object.

– In the button panel, click the right mouse button and select Delete Object.

3. On Confirm Media Object Delete, click Yes.

4. To return to the main form, click the Cancel button on the OLE Objects form in the 
application workspace.
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8Using MailMerge Workbench

This chapter contains the following topics:

■ Section 8.1, "Understanding MailMerge Workbench"

■ Section 8.2, "Creating a Data Set and Attaching Templates"

8.1 Understanding MailMerge Workbench
MailMerge Workbench merges Microsoft Word 6.0 (or higher) word processing 
documents with JD Edwards EnterpriseOne system records to automatically print 
business documents, such as form letters. Some application suites, such as Human 
Resource Management, use these documents within their normal workflow process. 
See your application guides to determine which applications use mail-merge 
documents. In these applications, the system automatically prints the mail-merge 
documents as part of the workflow process, and no user intervention is needed.

You can use the Maintain MailMerge Documents application to add or change text in 
the business documents included with JD Edwards EnterpriseOne software to create 
new documents and to delete documents.

JD Edwards EnterpriseOne software enables you to create HTML versions of 
mail-merge documents to send to web client users. After you add text and fields to the 
mail-merge document, you can copy it to an HTML version so that you can send 
mail-merge letters to web client users. When a mail-merge letter is generated, the 
system displays the letter in the Web Mail Merge program (P980040).

8.2 Creating a Data Set and Attaching Templates
A data set is the way you define the data structure that passes data to the API. After 
you define the data set, you will attach to it a simple template or a composite template. 
A simple template is a single template that you attach to a data set. A composite 
template is a collection of simple templates. Use only templates in the .rtf format. 

After you have created a data set, you must attach either a simple template, or a 
composite template.
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9Working with Processing Options

This chapter contains the following topics:

■ Section 9.1, "Understanding Processing Options"

■ Section 9.2, "Understanding Processing Option Functions"

■ Section 9.3, "Understanding the Types of Processing Options"

■ Section 9.4, "Working with Processing Options"

9.1 Understanding Processing Options
A processing option is a parameter in which you enter a value to control how an 
interactive or batch program runs.

You use processing options to instruct the system to perform functions to meet your 
specific business needs. If a program contains processing options, you set the required 
and optional processing options for the program during setup or before you run or 
submit a program.

You can create different versions of each program if your business needs require 
specific processing for different processes. You can then set these unique processing 
options differently in multiple versions of the same application. Changes to processing 
options immediately affect that version for every user. Anyone who uses that version 
after you make the change uses the new processing option values. You can also use 
processing options to access a version of another program.

Important: XJDE versions are considered owned by JD Edwards. 
During an upgrade, the system might overwrite these versions. You 
should use these versions only as templates for your own versions.

ZJDE versions are used for default purposes, and are typically 
interactive applications or versions called from another application. 
You usually attach these versions to a menu. You can set these 
processing options. When called from a menu, interactive applications 
with a version are called with a blind execution based on 
predetermined processing option values.

9.2 Understanding Processing Option Functions
Use processing options to complete one of these tasks:

■ Set up default values

■ Customize an application for different companies or even different users
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■ Control the format of forms and reports

■ Control page breaks and the location where totaling occurs for reports

Processing options appear in the system as a tabbed form. Tabs organize the 
processing options by purpose and function. Each processing option tab contains these 
items:

■ A standard or unique tab name

■ Processing option titles

■ Lists of values

■ Online help (enhanced processing options)

You access field-level help by placing the cursor in a field and pressing F1, or by 
clicking the Item Help icon located at the top-right corner of a form. If the field in 
which the cursor resides is a business view column, the system displays the alias 
name, business view name and description, table name and description, and 
glossary text. If the field in which your cursor resides is a data dictionary column, 
the system displays the alias name, the term Data Dictionary Item, and the 
glossary text. This information enables you to identify problems in the item help 
functionality, should any occur. 

Note: If your system administrator has not turned on the 
appropriate functionality, you will see only the alias name and 
glossary text.

9.3 Understanding the Types of Processing Options
Processing options can be of two types: enhanced and non-enhanced.

Enhanced processing options provide detailed information. For example, you can look 
at the field name and values on the tab and quickly determine how to use the 
processing option; or you can access online help by pressing F1 on the processing 
option for a detailed explanation. These processing options have been enhanced to JD 
Edwards EnterpriseOne standards. Enhanced processing option forms have a number, 
a brief title, and, if applicable, a concise list of values. These processing options have 
online help attached to them.

Non-enhanced processing options provide only a brief description in paragraph form. 
Sometimes these fields have no title; instead, they are numbered, and each number is 
followed by a brief explanation, in paragraph form, of relevant information (usually 
values). The processing option numbers sometimes span all tabs. The fields typically 
have data items attached but do not follow the same naming conventions as enhanced 
processing options.

9.4 Working with Processing Options
You can work with processing options in these two ways:

■ From a menu

■ From a version list

When working with processing options from a menu, you can access them for an 
object either from the menu bar or by right-clicking the object. In either case, one of the 
options is Prompt For. The Prompt For submenu contains these options, when 
available:



Options Description

Values Choose this option to specify processing option values.

Version Choose this option to select which version of the object to 
run. Depending on how the version was designed, you 
might be prompted to enter processing option values after 
you select the version, or you might be able to modify them 
from the Row menu.

Data Selection Choose this option to specify which data to use.

Data Selection and Values Choose this option to specify which data to use and then to 
specify processing option values.
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If you select to run processing options from a menu, the processing details defined at 
the menu level take precedence. Not all objects enable you to select from all four of 
these options.

9.4.1 Using Interactive Version Processing Options
The processing options that you define in interactive versions are a set of parameters 
that alter how an application runs. They are similar to initialization (.ini) files and 
command-line arguments for a traditional executable. These processing options let 
you specify the options that you want when you open an application. For example, 
you can specify how a form appears, show or hide a field, change the default status for 
order activity rules, and set default information to appear in a field.

Not all JD Edwards EnterpriseOne software applications have processing options. If 
the Prompt For Values option on the Edit menu is grayed out, either no processing 
options are associated with the application or the system administrator has secured a 
version for the application. When you open a secured version from the Interactive 
Versions application, a security message appears to inform you that you do not have 
access to the version.

You must set processing options for an interactive application before you use versions 
with the application.

Using processing options, you set up interactive programs to suit your business 
requirements. For interactive versions, processing options complete these tasks:

■ Change functions. For example, you can set a processing option to turn on or off 
order holds. You can also specify whether you want to automatically print pick 
slips after you enter an order that is based on a processing option value.

■ Change default values. For example, you can set the processing options to set 
defaults for document types (such as quote orders or purchase orders) or line 
types (such as stock or nonstock items).

■ Control the display of forms. For example, you can set the processing options to 
hide or show a cost field, a price field, or a commission field.

Note: (Release 9.1 Update 2) The Versions Compare report 
(RD983051NA) compares the processing options for interactive 
versions and batch versions between two environments or data 
sources. You can use this report as an audit or validation tool to 
determine which versions were added, deleted, or changed.

See "Versions Compare Report" in the JD Edwards EnterpriseOne Tools 
Software Updates Guide.
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To use interactive version processing options:

1. Using the EnterpriseOne Menus, navigate to the application for which you want to 
set processing options. 

2. Right click on the application and select Prompt For Values from the menu.

3. On Processing Options, enter appropriate values where applicable and click OK.

9.4.2 Using Version Processing Options
You can change the processing options for an existing batch version to suit your 
business requirements. For example, you can change processing option values that 
specify a range of dates for a report. However, not all batch versions have processing 
options associated with them. For example, a list of addresses might not require 
special prompting.

For batch versions, processing options complete these tasks:

■ Change functionality. For example, you can set a processing option to move 
records to a history file after a report runs.

■ Change input parameters. For example, you can set a processing option to specify 
which category code to use when processing a report.

■ Define data. For example, you can set a processing option to define the fiscal year 
for which you want to run a report. You can also define the employee information 
included in a report.

Note: (Release 9.1 Update 2) The Versions Compare report 
(RD983051NA) compares the processing options for interactive 
versions and batch versions between two environments or data 
sources. You can use this report as an audit or validation tool to 
determine which versions were added, deleted, or changed. For batch 
versions, the report also shows processing option values that are 
different between the versions in the data sources being compared.

See "Versions Compare Report" in the JD Edwards EnterpriseOne Tools 
Software Updates Guide.

9.4.3 Launching Processing Options for Batch Versions Manually
Access a Solution Explorer task view.

1. From a EnterpriseOne Menu, select the batch version application for which you 
want to set processing options.

2. On Work With Batch Versions - Available Versions, find and select a version of the 
report or other batch application.

3. On Work With Batch Versions - Available Versions, select Processing Options from 
the Row menu.

4. On Processing Options, enter appropriate values where applicable and click OK.

9.4.4 Using Processing Options for Master Business Functions
The purpose of a master business function (MBF) is to provide a central location for 
standard business rules about entering documents such as vouchers, invoices, and 
journal entries.
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The MBF is composed of processing options that are shared by some programs. For 
example, the following journal entry programs use the processing options for the 
journal entry MBF:

■ Journal Entries (P0911)

■ Journal Entries with VAT (P09106)

■ Journal Entry Batch Processor (R09110Z)

■ Store and Forward JE Batch Processor (R09110ZS)

■ Recurring Journal Entry Compute & Print (R09302)

■ Indexed Comp Compute and Print Report(R093021)

■ Variable Numerator Compute and Print (R093022)

Access Work With Interactive Versions from the System Administration Tools menu 
(GH9011).

1. Type the application number in the Interactive Application field and click Find. 
For example, type P0900049.

2. Choose a version.

3. To review the processing option settings for the version, select Processing Options 
from the Row menu.
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10Working with User Defined Codes 

This chapter contains the following topics:

■ Section 10.1, "Understanding User Defined Codes"

■ Section 10.2, "Customizing User Defined Codes"

10.1 Understanding User Defined Codes
Most forms in JD Edwards EnterpriseOne contain fields. Some fields enable you to 
enter any value, and some require you to select from a list of values. A user defined 
code (UDC) is one value in a set of values that is assigned as valid for a field. You can 
use UDCs to categorize your data and make sure that users provide consistent input 
on forms. Because users can select only values from the list, UDCs simplify, 
standardize, and validate the data that is contained in fields.

From any JD Edwards EnterpriseOne application, you can identify fields that have 
UDCs attached to them by using the visual assist button that appears when you tab 
into or click in a field. If you do not know the value to enter in a field with a user 
defined code attached to it, click the visual assist button, which accesses the Select 
User Define Code form. This form displays all values contained in the user defined 
code tables for this field. You can then select the value to use.

JD Edwards EnterpriseOne provides predefined UDCs, but many of the UDCs that 
you use are unique to your enterprise, and your needs are likely to change. Therefore, 
the system lets you change, add, and delete UDCs to meet the needs of your 
enterprise. 

10.1.1 Category Codes
Throughout the system, you will see references to category codes. Category codes are 
UDC types that JD Edwards EnterpriseOne provides for you to customize according to 
your needs. You can change the code type and the description, and you can redefine 
the UDCs as appropriate for your purposes. For example, you might see a UDC type 
called Category Code 01. You can change its description and define the UDCs within it 
to suit your business needs.

10.1.1.1 Example: User Defined Codes in Address Book
JD Edwards EnterpriseOne systems use UDCs. For example, Address Book uses a field 
called Search Type to classify the entries in the address book. When you click the 
visual assist button in the Search Type field on the Work With Addresses form, a list of 
the search types appears. These search types are UDCs. Some of the search types 
include the following:
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■ A - Applicants

■ C - Customers

■ V - Suppliers

■ E - Employees

You can use these UDCs to classify your address book entries, and you can add or 
change UDCs to accommodate your needs. For example, if you need to categorize 
some of your address book entries as students, you can add a UDC to the list, such as S 
- Students.

UDCs are also used to supply values for the following:

■ State and province codes

■ Units of measure

■ Document types

■ Languages

When you click the visual assist for a field and the system displays the Select User 
Defined Code form, you know that you are working with UDCs.

10.2 Customizing User Defined Codes
A UDC is made up of two parts. The first part is the code, which consists of the 
characters that you enter in a field. The second part is the description, which is text 
that describes what the code means. You can change both the code and the description. 
For example, the UDC list of search types contains the code C, which designates 
Customers. A medical facility might change this code and description to P for Patients.

10.2.1 Prerequisite
Every UDC belongs to a UDC type. Verify that a UDC type exists for which you will 
add the UDC. 

For more information on UDC types, see "Customizing UDC Types" in the JD Edwards 
EnterpriseOne Tools System Administration Guide. 

10.2.2 Changing a UDC
Access the Work With User Defined Codes form. On the JD Edwards EnterpriseOne 
web client, from a System Setup menu for your product, access the P0004A program.

1. Complete the Product Code and User Defined Codes fields and click Find.

For example, to display the list of Address Book search types, which is UDC 
01/ST, type 01 in the Product Code field and ST in the User Defined Codes field.

2. Select the code that you want to modify and click Select.

3. On the User Defined Codes form, modify any of these fields and click OK:

Field Description

Codes A list of valid codes for a specific user defined code list.

Description 01 A user defined name or remark.

Description 02 Additional text that further describes or clarifies a field in the system.
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10.2.3 Adding a UDC
Add a UDC to a UDC type when none of the existing codes is appropriate for your 
needs. For example, if you need to identify the entries in the address book that are 
your business partners, you can add a search type B - Business Partners to UDC 01/ST.

Access the Work With User Defined Codes form. On the JD Edwards EnterpriseOne 
web client, select the appropriate program for changing UDCs.

1. Complete the Product Code and User Defined Codes fields and click Find. In the 
User Defined Codes field, enter the UDC type for which you want to add the 
UDC.

2. On the Work With User Defined Codes form, click Add.

3. On the User Defined Codes form, scroll to the last empty row of the detail area.

Important: Be sure to add each new code on the last detail row so 
that you do not inadvertently overwrite a blank code, which might 
appear in the first detail row. A blank code might have only a period 
in the Description field.

4. Enter a code in the Codes field. To allow a blank as a valid value, leave this field 
blank.

5. Enter a description in the Description 1 field. To allow a blank as a valid value, 
type any character (such as a period) in the last space in this field.

6. Complete the Special Handling and Hard Coded fields, and then click OK.

10.2.4 Deleting a UDC
You can delete UDCs from a UDC type, but do so with caution. Only delete UDCs as 
part of a coordinated plan within your enterprise. For example, you might delete the F 
- Facilities UDC from the list of search types if you do not want users to select that 
UDC.

If you delete a UDC, the system deletes only the code from the UDC type. UDC values 
in existing records are not deleted.

Special Handling A code that indicates special processing requirements for certain user 
defined code values. The value that you enter in this field is unique for 
each user defined code type.

Hard Coded A code that indicates whether a user defined code is hard-coded. Valid 
values are:

Y

The user defined code is hard-coded

N

The user defined code is not hard-coded

A check mark indicates that the user defined code is hard-coded.

Field Description



Important: Do not delete hard-coded UDCs because JD Edwards 
EnterpriseOne applications might depend on them. Hard-coded 
UDCs have the value Y in the Hard Coded field on the Work With 
User Defined Codes form.
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Access the Work With User Defined Codes form. On the JD Edwards EnterpriseOne 
web client, from a System Setup menu for your product, access the P0004A program, 
or enter UDC in the Fast Path field.

1. Complete the Product Code and User Defined Codes fields and click Find.

2. On the Work With User Defined Codes form, select the UDC from the detail area 
that you want to delete and click Delete.

Important: Ensure that you want to delete this UDC. The only way 
to replace a deleted UDC is to add it again.

3. Click OK to confirm that you want to delete the UDC.

Tutorial: Click here to view a recording of this 
feature.This tutorial shows the pre-9.1.5 user interface.
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11Working with JD Edwards EnterpriseOne Voice 
Commands on Chrome Browser (9.1 Update 4)

This chapter contains the following topics:

Section 11.1, "Understanding JD Edwards EnterpriseOne Voice Commands" 

Section 11.2, "Working with JD Edwards EnterpriseOne Voice Commands"

11.1 Understanding JD Edwards EnterpriseOne Voice Commands
JD Edwards EnterpriseOne voice commands enable you to interact with JD Edwards 
EnterpriseOne application. The desktop users must launch the JD Edwards Enterprise 
One application using the Google Chrome browser to use the voice commands. 

The JD Edwards EnterpriseOne searches the voice command input from the user 
against the list of available voice commands. If the voice command input is recognized 
by the Google Chrome browser, then it is converted to an equivalent text and is 
displayed in the Voice Commands text box. Subsequently, an appropriate action will 
be executed by the application if the voice command is available. 

An alert voice message 'Unknown Command' is played if the voice command is not 
available.

The ability to access the Voice Commands text box is enabled if the VoiceCommands 
entry in the OWWEB section is turned ON in the JAS.ini file.

Note:  It may not be possible to execute a complete sequence of tasks 
using only the voice commands.

This table lists the voice commands that can be executed for JD Edwards 
EnterpriseOne navigation.

Table 11–1  

Voice Commands for JD Edwards 
EnterpriseOne Navigation

Action Performed by the JD Edwards 
EnterpriseOne Application

new window Opens a new window.

focus <element name> Focus is set on the element. For example, 
Textbox, Checkbox, radio button and so on.
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This table lists the voice commands that can be executed for JD Edwards 
EnterpriseOne menu.

Launch <Fast Path>  Launches the appropriate application.

Note.

This command will work only for the Fast Path 
entries that are made in UDC application 
(P0004A).

manage query Opens the Advanced Query panel.

close query Closes the Advanced Query panel.

manage watch list Opens the Watchlist Creation panel.

close watch list Closes the Watchlist Creation panel.

system information Launches the System Information.

hot keys Launches the Keyboard Information help.

open tab <number> Opens the appropriate tab on the tab control.

Note.

We have to set the Focus on the Tab control 
using Focus command before executing this 
Open tab command.

For example, Once the tab control has the 
focus, "Open tab 2" will open the second tab on 
the tab control.

type <text> Enters the value in the text field.

Note.

We have to set the Focus on a specific Text 
control using Focus command before executing 
this Type command.

For example, the voice commands may be:

 Focus Alpha Name 

Type User1

The value "User1" is entered in the Alpha 
Name text field.

sign out The user is signed out from JD Edwards 
EnterpriseOne application.

Voice Commands for JD Edwards 
EnterpriseOne Menu

Action Performed by the JD Edwards 
EnterpriseOne Application

Home The JD Edwards EnterpriseOne Home 
page will be launched/opened.

Navigator Opens the navigator drop-down menu.

Open applications Opens the Open Application drop-down 
menu.

Recent reports Opens the Recent Reports drop-down 
menu.

Table 11–1 (Cont.) 

Voice Commands for JD Edwards 
EnterpriseOne Navigation

Action Performed by the JD Edwards 
EnterpriseOne Application



Understanding JD Edwards EnterpriseOne Voice Commands

Working with JD Edwards EnterpriseOne Voice Commands on Chrome Browser (9.1 Update 4) 11-3

This table lists the voice commands that can be executed for JD Edwards 
EnterpriseOne grid.

Note: The Grid voice commands will work efficiently if the form 
contains single grid.

Voice Commands for JD Edwards 
EnterpriseOne Grid

Action Performed by the JD Edwards 
EnterpriseOne Application

export (or) xsport Launches the Exports Grid page.

import Launches the Imports Grid page.

next page The Next sets of records are populated in the 
grid.

go to end The Go to End link on the grid is triggered.

stop Activates the "Stop And View Results" button in 
the "Go To End" Screen.

continue Continue option is available on the 
Export/Import screen which either Exports or 
Imports accordingly.

This table lists the voice commands that can be executed for JD Edwards 
EnterpriseOne buttons.

Favorites Opens the Favorites drop-down menu.

Watch list Opens the Watchlists drop-down menu.

Voice Commands for JD Edwards 
EnterpriseOne Buttons

Action Performed by the JD Edwards 
EnterpriseOne Application

Add Clicks the Add button and Add action is executed.

Delete Clicks the Delete button and delete action is 
executed.

Form Exit Opens the Form menu.

Find Clicks the Find button and find action is executed.

Cancel Clicks the Cancel button and cancel action is 
executed.

Close Clicks the Close button and close action is 
executed.

Save Clicks the Save button and save action is executed.

Ok Clicks the Ok button and Ok action is executed.

Submit Clicks the Submit button and submit action is 
executed.

Report Exit Opens the Reports menu.

Row Exit (or) line exit Opens the Row menu.

Voice Commands for JD Edwards 
EnterpriseOne Menu

Action Performed by the JD Edwards 
EnterpriseOne Application
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This table lists the voice commands that can be executed for JD Edwards 
EnterpriseOne media objects.

Voice Commands for JD Edwards 
EnterpriseOne Media Objects

Action Performed by the JD Edwards 
EnterpriseOne Application

Back Back action is executed. 

Add file Add file action is executed.

New template Opens New template window.

Add URL Enters the URL to be previewed.

Save Save action is executed.

11.2 Working with JD Edwards EnterpriseOne Voice Commands
To work with JD Edwards EnterpriseOne Voice Commands:

1. Log in to the JD Edwards EnterpriseOne application using the Google Chrome 
browser.

2. Click the mike icon in the Voice Commands text box. The Speak Now dialogue box 
appears.

Figure 11–1 Voice Commands text box

Select Clicks the Select button and select action is 
executed.

Tools Exit Opens the Tools menu.

ovr Opens One View Reports window.

Copy Copy action is executed.

Next record Opens the next record.

Previous record Opens the previous record.

Click <element name> Clicks the button and clickable images, where 
<element name> is the name of the button or 
image.

Voice Commands for JD Edwards 
EnterpriseOne Buttons

Action Performed by the JD Edwards 
EnterpriseOne Application



Note:  Contact your system administrator if you cannot view the 
Voice Commands text box.
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3. Provide the voice command you want to execute. For example, open applications.

4. The voice command will be converted to text and the text appears in the Voice 
Commands text box. 

5. The voice command gets executed.

Figure 11–2 Open Applications Voice Command
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AJD Edwards EnterpriseOne Software Systems

This appendix contains the following topics:

■ Section A.1, "JD Edwards EnterpriseOne Software Systems"

This appendix provides a list of the JD Edwards EnterpriseOne systems.

A.1 JD Edwards EnterpriseOne Software Systems
The following table identifies the JD Edwards EnterpriseOne systems:

Number System

00 Foundation Environment

01 Address Book

02 Electronic Mail

03 Accounts Receivable

0301 Credit Management

03B Enhanced Accounts Receivable

03C Issue Management System

04 Accounts Payable

05 Time Accounting and HRM Base

05A OW HR & PR Foundation

05C OW HR & PR Foundation Canadian

05T Time Entry

05U OW HR & PR Foundation US

06 Do not use

07 Payroll

07S Payroll SUI

07Y U.S. Payroll Year End

08 Human Resources

08B Benefits Administration

08C OW HR Canadian

08H Health and Safety

08P Position Control
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08R Recruitment Management

08U OW HR US

08W Wage and Salary

09 General Accounting

09E Expense Reimbursement

10 Financial Reporting

10C Multisite Consolidations

11 Multicurrency

11C Cash Basis

12 Fixed Assets

13 Plant/Equipment Management

14 Modeling, Planning & Budgeting

15 Property Management

16 Profit Management (EPS)

17 Customer Service Management

17C Call Management

18 Resource Scheduling

19 Utility CIS

30 Product Data Management

3010 Process Data Management

31 Shop Floor Control

3110 Process Control

32 Configuration Management

32C Custom Works

33 Capacity Planning

34 Requirements Planning

34A Advanced Planning & Scheduling

35 Enterprise Facility Planning

36 Forecasting

37 Quality Management

38 Agreement Management

39 Advanced Stock Valuation

40 Inventory/OP Base

4010 Advanced Price Adjustments

41 Inventory Management

41B Bulk Stock Management

42 Sales Management

42A Sales Force Automation

Number System



JD Edwards EnterpriseOne Software Systems

JD Edwards EnterpriseOne Software Systems A-3

42E ECS Sales Management

43 Procurement

44 Subcontract Management

4401 Homebuilder Management

44H Homebuilder Management

45 Advanced Pricing

46 Warehouse Management

47 Electronic Commerce

48 Work Order Processing

48S Service Billing

49 Transportation Management

50 Job Cost Base

51 Job Costing

52 Contract Billing

53 Change Management

55 - 59 Reserved for Clients

60 - 69 Reserved for JDE Custom

70 Multinational Products

71 Client Server Applications

72 World Vision

73 M & D Complementary Products

74 EMEA Localization

74H Hungary

74I Ireland

74L Portugal

74N Nordics

74P Poland

74R CIS

74S Spain

74T Turkey

74Z Czech Republic

75 ASEAN Localization

75H Thailand

75I India

75K Korea

75T Taiwan

76 Latin American Localization

76A Argentina

Number System
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76B Brazil Localization

76C Colombia

76H Chile

76P Peru

76V Venezuela

77 Payroll (Canadian)

77Y Canada Payroll Year End

79 Translation Tools

80 Business Intelligence

81 DREAM Writer

82 World Writer

83 Management Reporting - FASTR

84 Distributive Data Processing

85 Custom Programming

86 Electronic Doc. Interchange

87 JDE Internal

88 Cautious Purge System

89 Conversion Programs

91 Documentation

92 Computer Assisted Design

93 Computer Assisted Programming

94 Security Officer

95 Sleeper-now in system 96

96 Computer Operations

97 Software Installation

98 Technical Tools

98E Electronic Burst and Bind

98FT Form Type

98SA Sample Application

99 Technical Tools - Internal

99D Technical Tools - DASD Sizer

99M Technical Tools-Masters/Update

B LANGUAGE TRANSLATIONS

B1A Chinese - Simple

B1B Chinese - Complex

B1E English

B1F French

B1G German

Number System
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B1I Italian

B1J Japanese

B1P Portuguese

B1S Spanish

B2A Dutch

B2D Danish

B2F Finnish

B2N Norwegian

B2S Swedish

B3C Czech

B3H Hebrew

B3R Russian

BC1 Chinese - Simple

BC2 Chinese - Complex

BCR Czech

BDN Danish

BDU Dutch

BFI Finnish

BFR French

BGR German

BHE Hebrew

BIT Italian

BJP Japanese

BNO Norwegian

BPO Portuguese

BRU Russian

BSP Spanish

BSW Swedish

D3N dcLINK (data collection)

H01 Address Book (inc. ALL Mail)

H03 Accounts Receivable

H03B New Accounts Receivable

H04 Accounts Payable

H05 Standalone Time Accounting

H07 Payroll

H08 Human Resources

H09 General Accounting

H12 Fixed Assets

Number System
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H13 Equipment/Plant Management

H15 Commercial Property Management

H30 Product Data Management

H301 Process Data Management

H31 Shop Floor Control

H311 Process Control

H32 Configuration Management

H33 Capacity Requirements Planning

H34 DRP/MRP/MPS

H35 Enterprise Facility Planning

H36 Advanced Forecasting

H40 Inventory/OP Base

H41 Inventory Management

H415 Bulk Inventory Management

H42 Sales Order Processing

H43 Purchase Order Processing

H44 Contract Management

H44H Homebuilder Management

H45 Sales Analysis

H46 Warehouse Management

H50 Job Cost Base

H72 Client/Server Base

H73 CS - A/P Voucher Entry

H74 CS - Pay Time Entry

H75 CS - Sales Order Entry

H76 CS - Training & Development

H78 CS - Travel Expense Management

H79 CS - Forecasting

H90 JD Edwards EnterpriseOne TOOLS

H91 Design Tools

H92 Interactive Engine/OL

H93 Data Base and Communications

H94 Batch Engine

H95 Tech Resources/Applications

H96 Deployment

H97 Benchmarking/Performance

H98 internet

H99 Product Version Control

Number System
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H99P Technical Tools-OWPVC Internal

JE42 Sales Order/Pricing

JE44 Distribution Contracts

JE48 Automated Gantry Inter.

KZ1 PC Budget Upload (A3 to A5)

KZ2 PC Data Entry for AP

KZ3 PC Data Entry for Payroll

SY SYSTEM

Z101 MTI Electrical Distribution

Z102 CRES

Z91 System/ Product Codes

Number System
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fast path

A command prompt that enables the user to move quickly among menus and 
applications by using specific commands.

in-your-face error

In JD Edwards EnterpriseOne, a form-level property which, when enabled, causes the 
text of application errors to appear on the form.

MailMerge Workbench

An application that merges Microsoft Word 6.0 (or higher) word-processing 
documents with JD Edwards EnterpriseOne records to automatically print business 
documents. You can use MailMerge Workbench to print documents, such as form 
letters about verification of employment.

media storage object

Files that use one of the following naming conventions that are not organized into 
table format: Gxxx, xxxGT, or GTxxx.

message center

A central location for sending and receiving all JD Edwards EnterpriseOne messages 
(system and user generated), regardless of the originating application or user.

processing option

A data structure that enables users to supply parameters that regulate the running of a 
batch program or report. For example, you can use processing options to specify 
default values for certain fields, to determine how information appears or is printed, 
to specify date ranges, to supply runtime values that regulate program execution, and 
so on.

QBE

An abbreviation for query by example. In JD Edwards EnterpriseOne, the QBE line is 
the top line on a detail area that is used for filtering data.

selection

Found on JD Edwards EnterpriseOne menus, a selection represents functions that you 
can access from a menu. To make a selection, type the associated number in the 
Selection field and press Enter.
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visual assist

Forms that can be invoked from a control via a trigger to assist the user in determining 
what data belongs in the control.
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Index

A
active messages, 6-1
application suite, system integration, 2-2
applications

form types, 3-1
sharing of data and logic, 2-2

attachments
checking for, 7-4
metadata attachmentsstatus, 7-14
renaming a button, 7-10

Auto Populate, 3-55

B
batch version processing options, 9-4
batch versions

Versions Compare Report, 9-3, 9-4

C
calendar, 5-9
carousel, 3-19

D
data and logic, 2-2

E
email, 6-1

canceling delivery to a specific queue, 6-7
deleting messages, 6-8
internal and external messages, 6-1
moving message to another queue, 6-6
printing messages, 6-8
reassigning messages, 6-7
redirecting messages, 6-6
revising messages, 6-6
sending internal messages, 6-3
sending internal messages to a role, 6-4
sending internal messagesquick list, 6-4
workflow messages, 6-1
working with shortcuts, 6-4

EnterpriseOne Menu, 3-7, 3-12
Enterpriseone Page, 3-6
entry points, 2-1

error messages and error dialog boxes, 3-55

F
Find/Browse form, 3-1
Fix/Inspect form, 3-2
form types, 3-1

Find/Browse form, 3-1
Fix/Inspect form, 3-2
Header Detail and Headerless Detail form, 3-2
message box, 3-2
Parent/Child form, 3-2
Search/Select form, 3-2

forms
check in/out and update remark, 6-11
maintaining mailmerge documents, 8-1
working with workflow message security, 6-10

H
Header Detail and Headerless Detail forms, 3-2
hot keys, 4-9

I
imaging, 7-1
interactive version processing options, 9-3, 9-4
interactive versions

Versions Compare Report, 9-3, 9-4
internal and external messages, 6-1
internal messages, 6-3

quick list, 6-4
role, 6-4
send to one person, 6-3

J
JD Edwards EnterpriseOne Software

entry points, 2-1
JD Edwards EnterpriseOne Software Access, 2-1
JD Edwards EnterpriseOne software features, 2-1

adaptability, 2-1
integrated supply chain, 2-1
interoperability, 2-1
multiplatform computing, 2-1
user-friendly, 2-1
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JD Edwards EnterpriseOne systems, A-1
JD Edwards software application suites, 2-2

L
logs, viewing, 6-11

M
mailmerge documents, 8-1
mailmerge templates, 8-1
media objects, 7-2, 7-4

attaching a shortcut, 7-7, 7-8
attaching a template, 7-11
attaching an image object, 7-6
attaching an OLE object, 7-7
attaching media objects, 7-4
attaching OLE objects at the base form level, 7-15
attaching text objects, 7-5
checking for attachments, 7-4
creating a template, 7-11
deleting a template, 7-12
deleting a template on media objects, 7-12
deleting media objects, 7-10
deleting OLE objects at the base form level, 7-16
image files, 7-1
modifying a template, 7-11
object linking and embedding (OLE), 7-1
overview, 7-1
properties of media objects, 7-12
setting image properties, 7-13
setting media object properties, 7-12
setting media object text properties, 7-13
setting shortcut properties, 7-13
templates, 7-10
text files, 7-1
viewing OLE properties, 7-13

message box, 3-2
messages, 6-6

accessing the employee work center, 6-5
cancel delivery to a specific queue, 6-7
deleting messages, 6-8
internal and external messages, 6-1
internal messagesend to one person, 6-3
moving message to another queue, 6-6
moving to another queue, 6-6
print a report of all messages in a queue, 6-8
printing messages, 6-8
reassigning, 6-7
redirecting messages, 6-6
revising, 6-6
send shortcut, 6-5
sending, 6-5
sending internal messages, 6-3
sending internal messagesquick lists, 6-4
understanding queues, 6-2
viewing messages, 6-5
Work Item Manager, 6-1
workflow messages, 6-1
working with shortcuts, 6-4

messages and queues, 6-1
metadata for an attachment, define, 7-14

N
navigating in EnterpriseOne, 3-7

O
OLE objects

as media objects, 7-4
attaching at the base form level, 7-15
deleting at the base form level, 7-16

OLE objects at the base form level, 7-15
OLE objects at the base form level, deleting, 7-16
OLE properties, 7-13

P
Parent/Child form, 3-2
password, changing, 5-3
Preferences, 3-11
priority or secondary queue

canceling delivery to a specific queue, 6-7
redirecting messages, 6-6

processing option functions, 9-1
processing options, 9-1

batch version processing options, 9-4
interactive processing options, 9-3
interactive processing 

optionsmanuallylaunch, 9-4
master business functions, 9-4
processing option functions, 9-1
types of processing options, 9-2
working with processing options, 9-2

programs and IDs
P0112 (Time Log Ledger Update)Check In/Outand 

Update Remark, 6-11

Q
queue manager

logging timecheckingin and out, 6-10
logging timeentering remarks, 6-11
logging timeviewing time logs, 6-11
time entry, 6-10

queue security, 6-10
queues, 6-2, 6-9

canceling delivery to a specific queue, 6-7
moving a message to another queue, 6-6
redirecting messages, 6-6
workflow queues, 6-2

quick list, 6-4

R
records

checking for attachments, 7-4
remarks, 6-11
report

viewing output, 5-2
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reports
print report that lists all messages in a queue, 6-8

role, send a message to a role, 6-4

S
Search/Select form, 3-2
shortcut properties, 7-13
shortcuts, 6-4

media object, 7-1
send shortcut, 6-5

system integration, 2-2

T
tables and business views, viewing data, 5-3
templates, 7-10

attaching a template, 7-11
create a template, 7-11
delete a template, 7-12
deleting a template on media objects, 7-12
modify a template, 7-11

text properties, 7-13
time entry

checking in and out, 6-10
entering remarks, 6-11
logging time and adding remarks, 6-10
viewing time logs, 6-11

types of processing options, 9-2

U
UDC drop-down menu, 3-57
User Defined Codes

queues, 6-2
user defined codes

adding, 10-3
blank as a valid value, 10-3
changing a user defined code, 10-2
deleting, 10-3
example of, 10-1

V
Versions Compare Report, 9-3, 9-4
voice commands, 11-1

W
Work Center, 6-5

accessing the employee work center, 6-5
messages, 6-1
queue, 6-9
sending internal messages, 6-3
sending internal messages to a role, 6-4
sending internal messagesquick list, 6-4
setting up a queue, 6-10
understanding queues, 6-2
viewing messages, 6-5
working with queues, 6-9

Work Item Manager, 6-1

workflow message security, forms, 6-10
workflow messages, 6-1
workflow queues, 6-2
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